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Introduction 

 
With One Stop Order Processing you can import orders and manage your products from various selling platforms or create your 
own orders and products. You can select multiple orders, using your selection criteria, quickly and easily take the orders through 
to completion. 
 
After processing your orders you can export the orders and products to: 
 
Courier systems (e.g. UKMail, RoyalMail Despatch Manager Online or UPS). 
Accounting systems (e.g. Quickbooks and Sage). 
3rd Party systems that can support CSV, TSV, XML or XLS import. 
 
There are 2 versions of the software each tailored to the facilities that you need. 
 

One Stop Order Processing Lite 
Import and create orders, produce consolidated picking lists, invoices and packing lists. 
 

One Stop Order Processing Standard 
Same features as Lite and the ability to provide customer feedback and ability to export the orders to other systems, including 
courier and accounting packages. You can also manage products and suppliers. 
  

Detailed Features Description 

 Lite Standard 

Initial users supplied 1 2 

Max. users 3 5 

Max. orders per site 5,000 500,000 

Email support tickets per year 3 5 

Import orders   
Create and amend manual orders   
Automatic VAT calculation   
Create order views, including automatic calculations   
Print Invoices, packing & picking lists   
Support standard invoices, document enclosed wallets and integrated labels including logos 

and PPIs 
  

Amend and create custom invoices and packing lists   
Automatically assign sequential order numbers   
Change all order details with automatic VAT & shipping calculations   
Show tax exclusive and inclusive, retail invoices   
Setup order views to make daily tasks easier   
Sophisticated order selection   
Find orders quickly using advanced searching   
Perform and display calculations on order information using custom field macros   
Add additional fields to orders (e.g. assign to, batch nos.)   
Backup existing orders   
Automatically archive orders   
Export orders to other systems   
Send emails to customers or 3rd parties   
Product Management including stock control   
Allow customers to track their orders online   
Manage and monitor emails sent to customers   
Print purchase orders   
Process refunds   
Predictive stock reorder level (based on existing sales)   
Drop shipping and order fulfilment tasks using suppliers (purchase orders and emails)   
Suppliers management (including emailing)   
Multichannel stock control   
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Setting up for the first time 
 
Quick Setup Wizard 
 
The first time that you start One Stop Order Processing you are shown the Quick Setup Wizard. This allows you to enter the 
basic information required to get you started. 

The One Stop Order Processing Quick Setup Wizard can be used to quickly set-up a new site ready for processing and printing 
orders. You are prompted to run the wizard whenever a new site is created. You can run the Quick Setup Wizard at any time by 
selecting the Quick Setup Wizard menu option (under the File menu). 
 
You are shown a series of pages providing the current information for the site. You can enter more detailed information at any 
stage time by using the One Stop Order Processing Options. To show the options select the Options menu choice (under the 

Tools menu) or by clicking on the Options button (  )  
 
 

 

 

 

The business details are used on the printed invoice, packing list and purchase order. The default invoices, packing lists and 
purchase orders contain macros for the information. See the Company Details in Options for more information. 
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You can have the same printer for the Invoice and Packing List but if you are using different stationery for each type or the 
Packing List is located in a different location, e.g. the warehouse, you should use different printers. For more information see the 
Printing Options. 
If you are using a PPI Stamp on your invoice you can type in your cost centre and 1st or 2nd class and this will be placed on the 
label. You can also put your logo on the invoice. You can select a graphic file and this will be resized and formatted for the 
invoice.  

 
 
If you are going to send you emails you can enter the email information. You can test the settings but clicking on the Test 
button. You can enter more detailed options in the Email Settings which can be found in the Email options. 
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If you are going to use order tracking on your website you can enter the relevant details here. You can enter more information in 
the Track Online options. 
 

 
 
You can choose to display Assistant Messages when using One Stop Order Processing. You can configure all of the messages 
shown by selecting the Assistant Messages Options by selecting the Manage Assistant Messages options under the Tools 
menu. 
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Importing Orders from different websites 

You can easily import your orders into One Stop Order Processing. Click on the Import Orders button (  ). When you 
import orders you can choose to automatically import the product details into the inventory system. You can then manage your 
stock and produce details reports based on your products (e.g. Total Sales or Profit). 

Orders are imported into One Stop Order Processing using the exported orders file from the relevant internet site (e.g. 
ebay.co.uk). 
 
See further in this section on how to retrieve the orders from the supported websites. If your website is not shown you may still 
be able to import orders using the OSOP format. This allows you to map the different fields in the format to the internal field 
name. This is explained further in this section. 
 

 

You are shown the various import types. If you select the relevant type and either click on Edit or double click on the line you are 
shown the Order Import Information options. This allows you to enter the name of the file containing the order information. You 
can also tick the Prompt for filename on each import option on the options page for each order type (except Actinic). You can 
also tick the option Only show ticked order types to import, to only show the order types that you are interested in. 
 
Each import type shows you the last time and date when orders were imported and the number of orders. You can also give 
each import type a name.  
 
You can amend any of the existing order types, remove them or add or your own. This can be useful if you want to have 
different settings for the same sales channel. For example, you can have 3 Ebay import types, one for each of your ebay shops. 
It is useful to create different One Stop formats. These can be setup to import from custom sales channels or update orders (for 
tracking details).  
 
For some of the import types an Additional Import Options dialog button appears. 
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Selecting orders to import 
 
When you select the file to import order information you are shown how to retrieve the orders from each site. 
 

 
 
You can give each import type any name. This is not used within the orders imported, but is used to make identifying the order 
type easier.  
 
The following pages in this section show how to import orders from different websites. 
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Ebay 

You download your orders from Ebay using Selling Manager Free or Selling Manager Pro. More details at the following website 
link: 
 

http://pages.ebay.co.uk/selling_manager/ 

1. Select the items that you want to download and press the Download button. If using a popup blocker hold down the Ctrl key. 
 

 

 
2. When the File Download dialog appears press the Save button. 

 

 
3. Save the file into a folder of your choice (for example, C:\Downloads). 

You are now ready to import the orders into One Stop Order Processing. 

Additional Import Options 
 
If you click on the Options button you can set additional information specific to this import type. 
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Tax handling based on location 
If your Ebay orders do not have the tax amount split out from the main cost you can tick the Adjust orders to split VAT out option 
on the main Import Orders dialog. This will split the VAT out for all orders. If you use this option you can conditionally split out 
the VAT. This can be very useful if you ship items to the Channel Islands or other Tax zones. 
 
By default, if you tick Split out VAT for the following countries will only split out the VAT for EU countries. 
By default, if you tick Don't split out VAT for the following locations will not split out VAT for the main Channel Islands. 
 
By default, the Ebay Custom Label is used as the SKU for the item. If you don't use this approach untick this box. You can then 
decide to put the custom label value into the orders' custom values (you can decide which custom value to start using).  

If you are importing Ebay orders from more than 1 account where the order numbers may clash you should tick the Add 
Seller'sID to order number. This will make sure that even if the same order number is used (they start at 1) they will still be seen 
as 2 distinct orders. If you are using the Interchange format files that don't contain this information the Buyer's id will be used. 
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Amazon Seller Central 
 

You download your orders from Amazon Seller Central.  

 
1. Login to Amazon Seller Central (at https://sellercentral-europe.amazon.com ) 
 
2. Go to the Orders tab. Select the Order Reports option (just below the tab). 

3. Select New Orders, shown below. 
 
4. Select the required number of days and Click on Request Report, shown below.  
 

 
 
5. When the reports have been created (normally within 10 minutes) click on the Refresh button, shown below. 
 
6. If the report isn't ready Not Ready is shown (in the last column). If it has been created a Download button appears. Click on 
this Download button. 
 

 
 
7 . In the Click on the Save button.  

 

8. Save the file into a folder of your choice (for example, C:\Downloads). 

You are now ready to import the orders into One Stop Order Processing. 
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Additional Import Options 
 
If you click on the Options button you can set additional information specific to this import type. 
 

 
 
Additional Amazon value mappings 
Amazon SellerCentral allows customers to add a gift message to your products. When this information is imported it is put into 
the One Stop Order Processing custom fields. By default this is put into the first custom field. You can change which field this is 
put into in the SellerCentral import options. 

Shipping handling 
If you want your invoices to show a single cost for the item tick this option. This will show a shipping cost of 0 and an increased 
item price. 
 
Tax handling based on location 
If your Amazon orders do not have the tax amount split out from the main cost you can tick the Adjust orders to split VAT out 
option on the main Import Orders dialog. This will split the VAT out for all orders. If you use this option you can conditionally split 
out the VAT. This can be very useful if you ship items to the Channel Islands or other Tax zones. 
 
By default, if you tick Split out VAT for the following Amazon country codes will only split out the VAT for EU countries. 
By default, if you tick Don't split out VAT for the following locations will not split out VAT for the main Channel Islands. 
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Amazon Marketplace 
 
You download your orders from Amazon Marketplace (Pro Merchant subscription required) 
 

1. Login to Amazon Marketplace (at http://www.amazon.co.uk/marketplace) and click on Your Account at the top 
of the screen. Then click on Your Marketplace Seller Account link, shown below: 
 

 

2. Under the Manage Your Orders options you should select Order Reports. If you do not have this option then you do not have 
an Amazon Pro Merchant account. To use this software you will need to sign up for a Pro Merchant account (currently £25 per 
month). Under the Settings options click on Seller Account Information. There is an Upgrade button at the bottom of the Seller 
Account Information page (under the Selling Plan options). 
 

 

3. Under Request an Order Report, select the number of days to retrieve orders for and click on Request Report. The orders 
report will then be generated. This can take from a few seconds to an hour. Click on the Refresh button until your new report 
appears. When this appears click on the Download button to retrieve the order information. 
 
NOTE: You can also setup automatically created reports to pickup each day. To do this click on the Edit button under the 
Scheduled Order Report Settings. 
 

 

4. Click on Save. Save the file into a folder of your choice (for example, C:\Downloads). 

You are now ready to import the orders into One Stop Order Processing.  
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PlayTrade 
 
You download your orders from Play.com. 
 

1. Login into your acccount at www.play.com and click on the Reports option on the left hand side (shown below). 
 

 

2. Select the Orders (choose time period) report, shown above. Click on the Submit report request button. After a few 
minutes the report will have been created and you can click on the Report link in the Downloads column. 
 
3. You are then prompted with the following dialog. You should click Save and save the file 
(DownloadReport_aspx.txt) to a location on your PC, for example, C:\Downloads. 

 

 
 
4. Save the file into a folder of your choice (for example, C:\Downloads).  
 
NOTE: If you have problems saving the file you should click on Open. When the file is displayed in your browser select all the 
text (Control Key and A) and then Copying the text into notepad (Press the Windows key and R and then type Notepad and 
press enter) and save the file to the correct location. 

You are now ready to import the orders into One Stop Order Processing.  
 

Additional Import Options 
 
If you click on the Options button you can set additional information specific to this import type. 
 

 
 
 
If you sell any products in Euros (EUR) you can convert these to £ (GBP) when importing. To do this tick the Convert to Sterling 
box. This uses the exchange rate supplied by Play.com 
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RomanCart 
 
You download your orders from www.romancart.com. 
 

1. Login into your acccount at www.romancart.com and click on the button next to View the sales manager (shown 
below). 
 

 

2. Click on Export Sales Data (shown below). 
 

 
 
 
3. Select the date range for the orders (in Date From: and Date To:). Change the File Type to Summary,Item and Extra field 
files (the last choice in the File Type choices). Change the delimiter to | (the 2nd choice in the Delimited By choices). Make sure 
that Enclose exported fields in double quotes is ticked. Click on Export Data (shown below). Hold down the Ctrl key if you are 
using a popup blocker.  
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4. Click on the Save button.  
 

 
 
 
5. Save the file into a folder of your choice (for example, C:\Downloads).  
 
You are now ready to import the orders into One Stop Order Processing.  

 

Additional Import Options 
 
If you click on the Options button you can set additional information specific to this import type. 
 
RomanCart allows you to specify your own custom fields. When these are imported these are mapped to the One Stop Order 
Processsing custom value fields. The Additional Import Options allow you to specify how they are mapped to the One Stop 
Order Processing fields. You can enter the starting value. 
 

 
 
Once the fields have been found in the imported order information you can amend the exact custom field that the information is 
mapped to (by double clicking on the item or selecting the item and clicking on the Edit button. 
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osCommerce/CRE Loaded 
 
1 Make sure that you have installed the additional software required on your osCommerce/CRE Loaded website. Details on how 
to install the software are shown later in this section. 
 
2 Login into your website in the my_admin folder (e.g. www.mywebsite123.com/my_admin)  
 
3 For osCommerce following the instructions below. For CRE Loaded following the instructions in the CRE Loaded section. 
 
osCommerce  
 
Click on the One Stop Order Processing link at the bottom on the left hand side, shown below: 
 

 
 
 
 
CRE Loaded 
 
Select the One Stop Order Processing menu option (under the Customers/Orders menu option), shown below: 
 

 
 

4 Select the range of orders to retrieve details for and click on the Export button (shown below): 
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5 Select Save (shown below) and save the file to C:\Downloads. 

 

 

You are now ready to import the orders into One Stop Order Processing.  
 

Additional Import Options 
 
If you click on the Options button you can set additional information specific to this import type. 
 

 
 
Order status text that means paid for: 
 
By default all orders that are imported from your website and are paid for have a status of Processing. If this has been changed 
on your site you should put that text in here. This is the text that is checked to see if an order is paid for. 
 
Order Calculation Method 

By default all order totals have their prices as Tax inclusive. The tax can be split out when importing. If your Tax model is Tax 
exclusive (e.g. the shipping value imported does not include tax) then use the Values are Tax exclusive method  
 
Date Format 

If your dates are not in the default date format you can change this to the other supported type(s).  
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Installing the One Stop Order Processing software onto your osCommerce/CRE Loaded website 

1 Copy (upload) the files in the C:\OSOP\Main\osCommerce\admin folder to the administration folder on your web 

server (by default called admin). This will add files to the existing folders (directories) on your server. For example, 

 
C:\OSOP\Main\osCommerce\admin\includes\classes\export.php 

 
will be copied to  
 
/catalog/admin/includes/classes/export.php 

 
on your web server. 
 
If you are using osCommerce use the following approach. For CRE Loaded use the CRE Loaded section 
 
osCommerce  

2 Amend the column_left.php file on your server (by default in 

/catalog/admin/includes/column_left.php). Add the line 

 
require(DIR_WS_BOXES . 'onestop.php'); 

to the end of the menu options. An example, is shown below in red. 

<?php 

/* 

$Id: column_left.php 1739 2007-12-20 00:52:16Z hpdl $ 

osCommerce, Open Source E-Commerce Solutions 

http://www.oscommerce.com 

Copyright (c) 2002 osCommerce 

Released under the GNU General Public License 

*/ 

require(DIR_WS_BOXES . 'configuration.php'); 

require(DIR_WS_BOXES . 'catalog.php'); 

require(DIR_WS_BOXES . 'modules.php'); 

require(DIR_WS_BOXES . 'customers.php'); 

require(DIR_WS_BOXES . 'taxes.php'); 

require(DIR_WS_BOXES . 'localization.php'); 

require(DIR_WS_BOXES . 'reports.php'); 

require(DIR_WS_BOXES . 'tools.php'); 

require(DIR_WS_BOXES . 'onestop.php'); 

?> 

CRE Loaded  
 
3 Amend the customers.php file on your server (by default in /catalog/admin/includes/boxes/customers.php). Add the line 
 
tep_admin_files_boxes('orders_export.php', 'One Stop Order Processing', 'SSL') . 

in the Customers the menu options. An example, is shown below in red. 

tep_admin_files_boxes('','&nbsp;&nbsp;' . BOX_HEADING_CUSTOMERS) . 
tep_admin_files_boxes(FILENAME_ORDERS, BOX_CUSTOMERS_ORDERS, 'SSL') . 
tep_admin_files_boxes(FILENAME_CREATE_ORDER, BOX_MANUAL_ORDER_CREATE_ORDER, 'SSL') . 
tep_admin_files_boxes('orders_export.php', 'One Stop Order Processing', 'SSL') . 
tep_admin_files_boxes(FILENAME_CREATE_ORDERS_ADMIN, BOX_CREATE_ORDERS_ADMIN, 'SSL') . 
tep_admin_files_boxes(FILENAME_PAYPAL, BOX_CUSTOMERS_PAYPAL, 'SSL') . 

 
 
Now when you access the main admin menu a new menu option will appear that will allow you to download order information. 
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osCommerce/CRE Loaded Advanced options 
If you are using discounts on your website and are using a non standard discount module you will need to update the discount 
module being used. To do this use the following procedure: 
 
1 Amend the export.php file (by default in /catalog/admin/includes/classes/export.php). 

2 Amend the line define('MOD_DISCOUNT', ''); to use the module that you are using. The line to amend is shown 

in red below: 
 
<?php 

/** 

* 

* One_Stop_Export - Export Class for 

* One Stop Order Processing 

* 

* @package export 

* @author 1StopOrders.com 

* @copyright 1StopOrders.com 2008 

* 

* $Revision:$ 

* 

*/ 

// Note: Only change these if you have customised your order totals modules 

define('MOD_SUBTOTAL', 'ot_subtotal'); 

define('MOD_TAX', 'ot_tax'); 

define('MOD_SHIPPING', 'ot_shipping'); 

define('MOD_TOTAL', 'ot_total'); 

define('MOD_DISCOUNT', ''); 

 
You could change this to use your module (ot_coupon). So the last line would become: 
 
define('MOD_DISCOUNT', 'ot_coupon');  
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EBid 
 
1 Login into your account at http://uk.ebid.net and click on the sold link on the left hand side (shown below): 
 

 

2 Select the orders to retrieve and click on the Export Sales Data link (shown below): 
 

 

3 Select Save (shown below) and save the file to C:\Downloads. 

 

 

You are now ready to import the orders into One Stop Order Processing.  
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OSOP - One Stop Order Processing Orders (Custom import format) 
 
You can import information that has been exported from One Stop Order Processing (using the OSOPExport view) or another 
application that can export a single CSV order information file (e.g. Excel).  
 
If you tick the Update information in existing orders option on the main page you can import information into existing orders. This 
can be useful for adding order tracking or other information from external systems. See the Advanced Import section for more 
details.  

Import file format 
The import file is a standard CSV (Comma Separated Value) file. The first line contains the field names separated by a comma 
(,). Each subsequent line contains values for those fields, each value being separated by a comma (,). Microsoft Excel can 
export information as a CSV file. You can create a template (example CSV file) by using the One Stop Order Processing 
OSOPExport view and exporting an order. 
 
The order import file can contain any of the fields described below, in any order. If you do not know any of the information for a 
field don't include the field in the file to import. Any information not supplied is defaulted from the other information supplied. This 
is described below.  
 
Minimum requirements for an import file 

You must have at least 1 of the red fields and 1 of the green fields in your import file to create a valid One Stop Order 
Processing order.  
 
Including orders with more than 1 item 
If there is more than 1 item per order you must include a value for Order ID (the first value). Order lines with the same Order ID 
are imported into the same order. The first line in a group of order lines contains the main order details. The subsequent order 
lines contain details for the other order's items (and read from the Item ID, Item title, SKU, Item quantity, Item price, Item tax, 
Item P&P, Item P&P tax, Item total, VAT rate, Item weight fields). 

Field Name 
This should 

appear in the 

first line of the 

file  

Description Default value 
If not included this value is used 

Order ID Unique Order number (e.g. 100006) Invoice number  

Transaction ID Transaction ID (e.g. 72838485) Order number  

Invoice number Invoice number (e.g. INT1001) Automatically allocated from last sequential invoice 
number (setup in the import options), Order ID of not 
allocated. 

Sales source Where the order came from (e.g. MOTO) OSOP 

Listed on Where the sale was listed (e.g. Website)  

Order number Order number (e.g. 1023) Order ID, then Invoice number 

Sub-total Total of all items sold (e.g. £85) Total of all items in order 

Discount Discount applied to Sub-total 0 

SubTotal tax Total tax paid on all items sold (e.g. £15) Total of all items' tax in order 

Total P&P Postage and Packing for all items (e.g. £10) Total of all items' P&P 

Total P&P tax Tax on Postage and Packing (e.g. £1.75) Total of all items' P&P Tax 

Insurance Insurance on whole order (e.g. £2)  

Insurance Tax Insurance tax on whole order (e.g. £0.35) If Tax rate given the required tax is split out from 
Insurance 

Total Tax Total of all Insurance, P&P and Items sold tax (e.g. 
£17.10) 

Total of Insurance, P&P and Items tax 

Grand total Total of all items, Insurance and P&P and Taxes 
(e.g. £114.10) 

Total of all Taxes, Insurance, P&P and Items 

Fees Any fees on sale (e.g. £5.70)  

Payment method Payment type used for order (e.g. Paypal)  

Shipping method Method used to send item (e.g. RoyalMail)  

Payment Status Payment status of order. This can be one of the 
following values: 

Full Payment Received 
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PSP Pending 
Received 
Rejected 
Error 
Preauthorised 
Waiting for card details 
Pending 
PSP Test Mode 
Partial Payment Received 
Full Payment Received 
Excessive Payment Received 
SUCCESS 
 
The values can be upper or lowercase. 

Order date Date order was placed (e.g. 16/09/2007 19:11:44) Checkout Date, then Invoice Date and then Today's 
date  

Invoice date Invoice date. This is the Tax date/ point (e.g. 
16/09/2007 19:11:44) 

Order Date  

Checkout date Date checkout was completed (e.g. 16/09/2007 
19:11:44) 

Order Date  

Payment date Date payment was taken for order (e.g. 16/09/2007 
19:11:44) 

 

Dispatch date Date order was dispatched (e.g. 17/09/2007 
16:00:00) 

 

Currency Currency character used for monetary values (e.g. £) Grand Total currency used 

Paypal ID Paypal transaction ID (e.g. 923849238928)  

PO num Customer's Purchase Order number (e.g. OT412)  

VAT Number Customer's VAT (TAX) code (e.g. 615 323 101)  

Total weight Toal weight of order (e.g 1.02KG) Total of all order items' weights 

Delivery 
Instructions 

Delivery instructions for courier (e.g. Leave in 
garage) 

 

Total items Total number of items in the order (e.g. 2) Total number of orders' items 

Feedback left Any feedback to give to customer (e.g. Good 
shopper) 

 

Notes Notes on order. These can be amended or added to 
in the order's memo tab (e.g. Call customer when 
despatched) 

 

Feedback 
received 

Comments received from customer (e.g. Excellent 
customer service) 

 

Invoice 
Customer 

Customer name (e.g. John Symthe)  

Invoice 
Firstname 

Customer firstname (e.g. John). This and the next 
field are combined to the Invoice Customer  

  

Invoice 
LastName 

Customer lastname (e.g. Smythe)    

Invoice 
Telephone 

Customer Telephone number (e.g. 555 123 456)  

Invoice Fax Customer Fax number (e.g. 555 654 321)  

Invoice Email Customer's email address (e.g. support@tk.co.uk)  

Invoice Address 
line 1 

First line of address (e.g. Sparechton House)  

Invoice Address 
line 2 

Second line of address (e.g. 12 Parchdale Road)  

Invoice Address 
line 3 

Third line of address (e.g Farletontington)  

Invoice Address 
line 4 

Fourth line of address (e.g. Xexton)  

Invoice County County (e.g. Wessex)  
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Invoice 
Postcode 

Postcode / Zip code (e.g. ZX2 5QC)  

Invoice Country Country (e.g. United Kingdom)  

Invoice VAT 
number 

Customer's VAT number (e.g. 615 323 101)  

Invoice Buyer 
ID 

Buyers ID, username, login name or handle (e.g. 
filetpn63743) 

Invoice Email, then Invoice Customer 

Invoice 
Company 

Company name (e.g. Aprelton Spares Ltd)  

Delivery 
Customer 

Delivery customer name (e.g. Amy Smythe) Invoice Customer 

Delivery 
Firstname 

Delivery firstname (e.g. Amy). This and the next field 
are combined to the Delivery Customer 

  

Delivery 
LastName 

Delivery lastname (e.g. Smythe)    

Delivery 
Telephone 

Delivery customer Telephone number (e.g. 555 323 
466) 

Invoice Telephone 

Delivery Fax Delivery customer Fax number (e.g. 555 234 281) Invoice Fax 

Delivery Email Delivery customer's email address (e.g. 
deliveries@tk.co.uk) 

Invoice Email 

Delivery Address 
line 1 

Delivery first line of address (e.g. Sparechton 
Warehouse) 

Invoice Address line 1 

Delivery Address 
line 2 

Delivery second line of address (e.g. 14 Larch 
Close) 

Invoice Address line 2 

Delivery Address 
line 3 

Delivery third line of address (e.g Fox Business 
Park) 

Invoice Address line 3 

Delivery Address 
line 4 

Delivery fourth line of address (e.g. Grosgripe) Invoice Address line 4 

Delivery County Delivery county (e.g. Wessex) Invoice County 

Delivery 
Postcode 

Delivery postcode / Zip code (e.g. ZS5 7IK) Invoice Postcode 

Delivery Country Delivery country (e.g. United Kingdom) Invoice Country 

Delivery VAT 
Number 

Delivery customer's VAT number (e.g. 615 323 101) Invoice VAT Number 

Delivery Buyer 
ID 

Delivery buyers ID, username, login name or handle 
(e.g. filetpn63743) 

Invoice Email, then Invoice Customer 

Delivery 
Company 

Delivery company name (e.g. Aprelton Spares Ltd) Invoice Company 

Item ID Sales ID of item. This is normally unique (e.g. 
832478325) 

SKU 

Item title Description of item (e.g. Fluffy Dog in box) SKU 

SKU Your own part number of item (e.g. IL1) Item ID then Item title 

Item quantity Number of the item ordered (e.g. 1) 1 

Item price Cost of item. This can include tax (if you want to 
automatically split the tax out use the adjust orders 
to split VAT out in the import options) (e.g. £4.50)  

Item total / Item quantity 

Item tax Tax on item (e.g. 0.79) Can be calculated from Item price if you use the adjust 
orders to split VAT out in the import options. The tax 
(VAT) rate is taken from the VAT rate, unless this is 
blank. If it is the VAT rate used in the import options is 
used. 

Item P&P This item's postage and packing. The total P&P is 
the total of all the items' P&P, unless this field is left 
empty and the main P&P field is used (e.g. 0.55) 

 

Item P&P tax This item's postage and packing tax (e.g. 0.10) Can be calculated from Item price if you use the adjust 
orders to split VAT out in the import options. The tax 
(VAT) rate is taken from the VAT rate used in the 
import options is used. 

Item total Total cost of item(s), quantity * Item price (e.g. £50) Item price * Item quantity 
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VAT rate VAT rate specific to this product (e.g. 5%) VAT rate given in Adjust orders to split VAT value in 
main import options. 

Item weight All the item's in this orderline's weight (e.g. 2KG)  

Shipped Qty Number of these item's shipped (e.g. 2) Item quantity (if item has been shipped) 

Email Sent #1 Has the first email setup been sent? (e.g. 1)  

Email Sent #2 Has the second email setup been sent? (e.g. 0)  

Email Sent #3 Has the third email setup been sent? (e.g. 1)  

Email Sent #4 Has the fourth email setup been sent? (e.g. 0)  

Custom:Entered 
val. 1 

These are values that a specific to your business or 
from the another application. These values appear 
on the Custom Value tab on each order. 

 

Custom:Entered 
val. 2 

  

Custom:Entered 
val. 3 

  

Custom:Entered 
val. 4 

  

Custom:Entered 
val. 5 

  

Custom:Entered 
val. 6 

  

Custom:Entered 
val. 7 

  

Custom:Entered 
val. 8 

  

Custom:Entered 
val. 9 

  

Custom:Entered 
val. 10 

  

Custom:Entered 
val. 11 

  

Custom:Entered 
val. 12 

  

Custom:Entered 
val. 13 

  

Custom:Entered 
val. 14 

  

Custom:Entered 
val. 15 

  

Custom:Entered 
val. 16 

  

Custom:Entered 
val. 17 

  

Custom:Entered 
val. 18 

  

Custom:Entered 
val. 19 

  

Custom:Entered 
val. 20 

  

Custom:Entered 
val. 21 

  

Custom:Entered 
val. 22 

  

Custom:Entered 
val. 23 

  

Custom:Entered 
val. 24 
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Custom:Entered 
val. 25 

  

Custom:Entered 
val. 26 

  

Custom:Entered 
val. 27 

  

Custom:Entered 
val. 28 

  

Custom:Entered 
val. 29 

  

Custom:Entered 
val. 30 

  

Custom:Entered 
val. 31 

  

Custom:Entered 
val. 32 

  

Custom:Entered 
val. 33 

  

Custom:Entered 
val. 34 

  

Custom:Entered 
val. 35 

  

Custom:Entered 
val. 36 

  

Custom:Entered 
val. 37 

  

Custom:Entered 
val. 38 

  

Custom:Entered 
val. 39 

  

Custom:Entered 
val. 40 

  

Custom:Entered 
val. 41 

  

Custom:Entered 
val. 42 

  

Custom:Entered 
val. 43 

  

Custom:Entered 
val. 44 

  

Custom:Entered 
val. 45 

  

Custom:Entered 
val. 46 

  

Custom:Entered 
val. 47 

  

Custom:Entered 
val. 48 

  

Custom:Entered 
val. 49 

  

Custom:Entered 
val. 50 
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Additional Import Options 
 
If you click on the Options button you can set additional information specific to this import type. 
 

 
 
When you import orders into One Stop Order Processing from another source the date format can be in different formats. 
Currently 4 different date formats are supported. You should select the nearest date format to that of the order information that 
you are going to import. 
 
If you are using an import format that has a different header you can substitute a different one. This allows you to use your own 
naming convention in your import file and map your names to the required names when importing. 
 
Several standard import formats have been setup., these include Magento and ekmPowershop. When you select a standard 
format this changes the options to allow importing of orders from that platform. Click on the Information link to see how to export 
the orders from the external source.  
 
Tax handling based on location 
If your orders do not have the tax amount split out from the main cost you can tick the Adjust orders to split VAT out option on 
the main Import Orders dialog. This will split the VAT out for all orders. If you use this option you can conditionally split out the 
VAT. This can be very useful if you ship items to the Channel Islands or other Tax zones. 
 
By default, if you tick Split out VAT for the following countries will only split out the VAT for EU countries. 
By default, if you tick Don't split out VAT for the following locations will not split out VAT for the main Channel Islands. 
 
Order totals include VAT (Retail prices)  
If your order values are retail based, where the totals include VAT you should tick this option. 
 
Use different sequential invoice numbers for manually created orders 
If you want to use a different set of invoice numbers for manually created orders and imported orders tick this option. This can 
be used to determine which orders were manually created and which were imported from a sales channel.  
 
All figures are TAX Exclusive (add on Tax when importing) 
If the order information that you are importing does not contain any Tax information and you want it added tick this option.  
 
 

Advanced Import 
 
To import information into existing orders you only need to include the Order ID and the required information (e.g. Delivery 
Instructions). You can not include an order's item details (e.g. product codes), but you can include all other order details 
(including Custom Entered values). An example of a CSV is shown below. This can be edited in Microsoft Excel and exported 
as a CSV file. 
 
Order ID,Delivery Instructions,Custom:Entered val. 1 

426-8234341-9441161,Leave with neighbour if out,JJ98324928 

283-61188984-5408319,Leave with neighbour if out,TY342334 

402-48239431-2828328,Leave with neighbour if out,KL123123 

129-11112346-3745908,Leave with neighbour if out,DS823748 

277-8758482-2751516,Leave with neighbour if out,RB819283 
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CubeCart v4 
 
1 Make sure that you have installed the additional software required on your CubeCart website. For more information see further 
in this section. 
 
2 Login into your CubeCart website and click on the OSOP Order Export link at the bottom on the left hand side (shown below): 
 

 

3 Select the range of orders to retrieve details for, the Order Status and click on the Export To CSV button (shown above): 
 
4 Select Save (shown below) and save the file to C:\Downloads. 

 
You are now ready to import the orders into One Stop Order Processing. 

Additional Import Options 
 
If you click on the Options button you can set additional information specific to this import type. 
 

 
 
Tax handling based on location 
If your CubeCart orders do not have the tax amount split out from the main cost you can tick the Adjust orders to split VAT out 
option on the main Import Orders dialog. This will split the VAT out for all orders. If you use this option you can conditionally split 
out the VAT. This can be very useful if you ship items to the Channel Islands or other Tax zones. 
 
By default, if you tick Split out VAT for the following countries will only split out the VAT for EU countries. 
By default, if you tick Don't split out VAT for the following locations will not split out VAT for the main Channel Islands. 
 
 

Installing the One Stop Order Processing software onto your CubeCart website 

1 Copy (upload) the files in the C:\OSOP\Main\CubeCart\admin folder to the CubeCart administration folder on your 

web server (by default called admin). The store root folder is the one that contains files named admin, cache, classes, docs, 

images, includes, ioncube, js, language, modules and skins. The files will not overwrite any existing files on the server (store), it 
will only add new files. 
 
For example, 
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C:\OSOP\Main\CubeCart\admin\sources\orders\osopexport\calendar.js  

 
will be copied to  
 
/admin/sources/orders/osopexport/calendar.js 

 
on your web server. 

2 Amend the navigation.inc.php file on your server (by default in admin/includes/navigation.inc.php). Find the line (around line 
92) that has the following text: 
 
<li><a <?php if(permission("orders","read")==true){ ?>href="<?php echo $glob['adminFile']; 

?>?_g=orders/index" class="txtLink"<?php } else { echo $link401; } ?>><?php echo 

$lang['admin_common']['nav_orders'];?></a></li> 
 
Add the following text after this line. 
 
<li><a <?php if(permission("orders","read")==true){ ?>href="<?php echo $glob['adminFile']; 

?>?_g=orders/osopexport/index" class="txtLink"<?php } else { echo $link401; } ?>>OSOP Order 

Export</a></li> 

 
 
Save the changes and upload this file to your server (if not being amended on it).  
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Actinic Desktop 
 
You can import orders from Actinic V4, V5, V6, V7, V7 Multi user, V8, V9, V10 and V11 as well as Actinic Enterprise (V8, V9, 
V10 and V11). You can import orders from up to 15 different Actinic sites into a single One Stop Order Processing Site. Each 
Actinic site can be from any Actinic version (e.g. you can process orders from an Actinic V7 site alongside orders from an Actinic 
V9 site). 
 
When you click on the order Edit button on the Import Orders dialog you are shown the following dialog: 
 

 
 
NOTE: Once the orders are imported into One Stop Order Processing any changes made will not be reflected in Actinic 
 
 
Version  
When you select the Actinic Version the default site folder is shown in the Folder. If this is incorrect you can adjust this. This can 
include mounted remotes drives (for multi-user Actinic). UNC paths are also support. E.g. \\server\Actinic. If you select an 
Actinic Enterprise version you must select the relevant SQL Server and database. 
 
Actinic V11  
If you are importing orders from Actinic V11 the tracking details are imported into the Custom Entered 11 and 13 fields. These 
can be used in online tracking, order export, emails and invoices (or packing lists).  
 
Folder 
You can change the value folder to look for Actnic sites in. If this is an Actinic Enterprise site then the server details are 
displayed. 
 
Site 
This lists all of the sites (folders) available under the specified folder. Select the required site to import orders from. 
 
If you wish to import orders from all of your Actinic sites you should select the various in each of the available site slots (up to 
20). When the Import orders button is pressed the relevant orders are imported from all the selected sites. 

Orders to Import 
You can import orders based upon their order date. You can import the following orders: 
 
Today 
YesterDay 
This Week 
Last Week 
Last 7 Days 
Last 10 Days 
This Month 
Last 30 Days 
Last Month 
This Year 
Last Year 
All 
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Use Actinic Report Description as Product ID 
If you use more than 1 product ID for an Actinic product (and use the Report Description field to store the additional item ID) 
then tick this option. 
 
Import PSP Pending Orders 
If you want to import PSP Pending orders (orders where the customer failed to complete the checkout process using a payment 
provider, e.g. SagePay or Paypal) tick this option. If this option is unticked the PSP pending orders are not imported.  
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Interspire 
 
1 Login into your website in the my_admin folder (e.g. www.mywebsite123.com/admin)  
 
2 You can Export all orders or specific orders.  
 
Export all orders 
 
Click on the Export Orders under the Orders menu, shown below: 
 

 
 
 
Export selected orders 
 
Click on View Orders under the Orders menu, shown below: 
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Then tick the required orders and select the Export These Orders action and click on the Go button. 
 

 
 
 
 
3 Select the Default Export Template and the Export to Microsoft Excel (CSV) option, shown below. Then click on the Continue 
button. 
 

 

4 Select Save and save the file to C:\Downloads. 

 
You are now ready to import the orders into One Stop Order Processing.  

Additional Import Options 
 
If you click on the Options button you can set additional information specific to this import type. 
 

 
 
Tax handling based on location 
If your Interspire orders do not have the tax amount split out from the main cost you can tick the Adjust orders to split VAT out 
option on the main Import Orders dialog. This will split the VAT out for all orders. If you use this option you can conditionally split 
out the VAT. This can be very useful if you ship items to the Channel Islands or other Tax zones. 
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By default, if you tick Split out VAT for the following countries will only split out the VAT for EU countries. 
By default, if you tick Don't split out VAT for the following locations will not split out VAT for the main Channel Islands. 
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XCart 
 
1 Login into your website in the admin folder (e.g. www.mywebsite123.com/admin)  
 
2 Click on Orders under the Management section, shown below: 
 

 
 
 
 
3 In the Export/Delete orders section select the 4.0.x compatible: CSV (with comma delimiter) File format for export and click 
on the Export all button, shown below: 
 

 
 
 
 
4 The orders are exported, shown below: 
 

 
 
5 Select Save and save the file to C:\Downloads. 
 
You are now ready to import the orders into One Stop Order Processing.  
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Additional Import Options 
 
If you click on the Options button you can set additional information specific to this import type. 
 

 
 
Sites to import Orders From 
If you import orders from different XCart sites and want each order to have a different order number prefix (to easily identify the 
order's source and to use in filters) tick this box. You will need to save each site's orders into a different filename. When 
importing the filename used is compared with those stored. If that filename isn't found you are shown the options so that you 
can choose the mapping. 
 
Use order details field as shipping instructions 
If you use the XCart details field as the shipping instructions tick this box.  
 
Import Gift Details into Custom Values starting from: 
If you have updated your XCart site to have 2 extra fields on the end and are using those for Gift details tick this box. You can 
then choose which custom fields to put the details into. For each order line the first gift details are stored in the first listed custom 
field, the 2nd details in the next custom field and so on. For example, using a starting value of 10, if you have a gift wrap price of 
£6.20 and a message of "Happy Birthday Zoe" for the first order line and a gift wrap price of £3.45 with a message of "From 
Bob" these will be stored in the custom values as shown below: 

Custom Value 10  6.20 

Custom Vlaue 11  Happy Birthday Zoe  

Custom Value 12  3.45 

Custom Value 13  From Bob  

 
 
To use these values in emails, invoices etc.. you should use the macros [%CUSTOM_ENTERED10%] , 
[%CUSTOM_ENTERED11%] , [%CUSTOM_ENTERED12%] and [%CUSTOM_ENTERED3%] . 
 
NOTE: If you don't tick this option the 2 extra fields are put onto the Orderline's Item number and product Cost Price.  
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Magento 
  
To import your orders from Magento into One Stop Order Processing use the following procedure: 
 
To import orders from Magento you will need to install the following Magento extension: 
 

http://www.magentocommerce.com/extension/1350/simple-order-export 
 
You now import your orders into One Stop Order Processing using the OSOP Import format. 
 
Select the OSOP import format and select the Magento format, shown below.  
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ekmPowershop 
  
To import your orders from ekmPowershop into One Stop Order Processing use the following procedure: 
 
1 Login into your website in the admin folder 
 
2 Select the Import/Export screen, then select the File export, shown below.  
 

 
 
 
3 Select the range of orders needed, shown below.  

 
 
 
4 Leave all fields selected and click on Next.  
 

 
 
 
5 Select Single Line export and click on Next.  
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6 Select CSV File and click on export.  
 

 
 
 
7 You are now ready to import the orders into One Stop Order Processing using the OSOP Import format. 
 
8 Select the OSOP import format and select the ekmPowershop format, shown below.  
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Pinnacle Cart 
 
To import your orders from Pinnacle Cart into One Stop Order Processing use the following procedure: 

1 Login into your website in the admin folder 
 
2 Select the Users & Orders->Browse Orders menu option , shown below.  
 

 
 
 
 
3 Select the orders to export or tick check all. Click on the Export to CSV button, shown below.  
 

 
 
 
 
4 Select the Save button and save the file to a folder.  
 

 
 
 
5 You are now ready to import the orders into One Stop Order Processing using the OSOP Import format. 
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6 Select the OSOP import format and select the Pinnacle Cart format, shown below.  
 

 
 
7 In the main Import dialog if you untick Split VAT out if you have included tax information on your website. 

NOTE: One Stop Order Processing can import orders with up to 30 order lines. If more than 30 order lines are found on a single 
order a warning is given. 
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Actinic Online/Oxatis  
 
1 Login into your website in the admin folder 
 
2 If you have already installed the Actinic Online/Oxatis order download tool, called a DataPlug, go to item 7. 
 
3 To install the order download tool (DataPlug), select the Oxatis DataPlug menu option under the help menu, shown below. 
 

 
 
 
 
4 Once you are happy with the DataPlug terms and conditions tick I have read and accept the Oxatis DataPlug terms of use and 
click on the Download button, shown below.  
 

 
 
 
5 You are shown a download link, click on the link. This is shown below.  
 
NOTE: You may need to hold down the control key when clicking on the link if a download box does not appear.  
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6 You can now Run the installation for the Dataplug, shown below.  
 

 
 
 
7 When you run the DataPlug you will be asked for your Actinic Online/Oxatis username and password. You will only need to 
enter these details once. When the main screen is shown click on the Download button.  
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8 Select the date range, which defaults to the last 24 hours. You must tick Use payment status and select the orders to 
download and click on Next.  
 

 
 
 
9 Once the orders have been downloaded you will need to export the orders. On the main screen click on the Export button. On 
the Exporting Orders to Excel or CSV File screen click on the Browse button. The Save as dialog is shown. Change the format 
type to CSV and select a filename to store the orders into and click Open.  
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10 Once the filename has been selected select the date range for the orders. If you only want to include orders not downloaded 
before don't tick Orders already exported. i.e. If you want to include all orders tick Orders already exported. Click on Next.  
 

 
 
 
11 Click on Next. 
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12 If no warnings or errors are shown click on Finish.  
 

 
 
 
13 You are now ready to import the orders into One Stop Order Processing using the OSOP Import format. 
 
 
14 Select the OSOP import format and select the Actinic/Online Oxatis format, shown below.  
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Paypal 
 
To import your orders from Paypal into One Stop Order Processing use the following procedure: 
 
1 Login into Paypal.  
 
2 Select the History menu then Download History menu option, shown below. 
 

 
 
 
 
3 Select the range of orders needed and click on the Download History button, shown below.  
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4 When the report is generated click on the Recently Downloaded logs, shown below:  
 

 
 
5 You are now ready to import the orders into One Stop Order Processing using the OSOP Import format. 
 
6 Select the OSOP import format and select the Paypal format, shown below.  
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Additional information 
 
After importing the orders, if all the required details are not shown you will need to amend the download the Paypal options. This 
is described below: 
 
1 In the Download History screen (shown above in step 4), click on the Customise Download Fields. This is shown below. 
 

 
 
2 For example, if the address is not included make sure that Multi-Column Postal Address is ticked. This is shown below:  
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Import options 

 
Overwrite orders with same order number 
If you want to overwrite any changes that you have made in One Order Processing (for example, the order details have been 
updated in Ebay) you should tick this option. If you want to do most of the order processing in One Stop Order Processing and 
want to import a single orders file that could contain previous orders (or example, if you always create an Amazon orders report 
to include the last 30 days orders) you should untick the option. 
 
If you use the are importing One Stop (OSOP) orders there is an additional Update information in existing orders option. If you 
tick this option you can import information into existing orders. This can be useful for adding order tracking or other information 
from external systems. This feature can be used with all orders type, not just OSOP orders (This feature can used for importing 
tracking details for Amazon orders). See the Advanced Import section for more details.  
 
Backup existing orders before importing to 
You can take a backup of the current orders file before any new orders are imported. This can be used as a backup to restore 
the orders to a previous day's state. The backed up orders filename is given the name Backup{sitename}{Date and 

time}.zip. Where {sitename} is the name of the current site being imported into and {Date and time} is the current 

date and time. 
 
Only include orders where payments have been received 
With some websites (for example, Playtrade) orders can be included where they are cancelled or haven't been paid for. You 
should tick this box if you only to handle orders that have been paid for. However, you can use the filtering options to only show 
(and process) paid orders. 
 
Adjust orders to split TAX out 
Using the default information provided by websites you can't normally issue a TAX receipt. You can list orders on some 
websites (e.g. Ebay) that can (for some orders) split the TAX out for you. Some other sites (e.g. Playtrade) don't provide this 
facility. If you tick this option any orders that don't already have their TAX taken out of the retail price have the TAX split out from 
the order. This means that you can send out TAX invoices. You can also choose to not split the TAX for shipping (if required).  
 
Rounding 
When TAX is calculated there maybe very small rounding errors. To keep the order's totals in balance a small amount may need 
to be added to one component of the order. You can choose to add this to the Order total (the items ordered) or the Tax (VAT). 
By default, the additional amounts are added to the Order total. You can change this to adjust the TAX amount owed if required.  

Default currency 
If the currency can not be determined from the orders imported or you are creating manual orders this is the currency used. 
 
Use sequential invoice numbers 
This can be used to have a consistent invoicing system across all of your selling areas. This includes manually entered orders. 
This may also be a requirement of the invoicing system required by your company's accounting. You can set the starting invoice 
number and format. Each time an order is added the number is increased by a fixed value. The default value is 1. 
 
Products 
Update Stock Levels 
If you have imported your products into One Stop Order Processing and have turned on Stock Control this will update the stock 
level when importing the relevant order.  
 
Automatically add new Products to: 
If you decide to automatically add products you can assign them all to a group. This can be used to filter or categorise your 
products. 
 
Overwrite if same SKU 
Tick this option if you want to overwrite the product details each time an order is imported, if it already exists. This is a useful 
feature if the product details that you want imported change in the source site. For example, if you update the cost price in 
Actinic and want to keep the One Stop Order Processing version up to date with this product tick this option.  
 
Note: If you use this option any changes made to the product in One Stop Order Processing will be lost (including stock levels).  
 
 
Automatically add SKUs (if blank). Starting with: 
If the products that you are importing does not have a SKU (e.g. Ebay orders) you can assign a code to it. When the same 
product is downloaded later it will be assigned the same SKU. 
 
When importing products you can overwrite information. This can be very useful if the product definitions change (or are 
maintained in an external system).  
 
NOTE: If you are using Actinic (version 9 onwards) the product Cost price is imported when a product is automatically created.  
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Other information 
The names shown for the import types can be changed. For example, if you OSOP orders to be shown as MyOrders. To do this 
you will need to amend the file IL_Types.ini with a text editor. In this file under each type (e.g. Type1) is a field called Import. 
The text after the = can be changed. 
 
NOTE: If you use this option previous orders of this type will NOT be changed to the new text.  
 
When you import the order information you can show additional information (tick the Verbose information option) and copy any 
information to the clipboard by clicking on the Copy processing information to clipboard. 
 
 
Order Processing Tasks (to perform on newly imported orders) 
After you have imported orders you can perform various tasks on the orders. You need to click Select Orders then Click on the 
Close and Process Orders. This will perform the tasks, if ticked, shown below. 
Format Addresses 
Ship Orders 
Unship Orders  
Mark as Paid 
Print Picking List 
Print Packing List 
Print Invoices 
Set colour of unpaid orders. By default, this is set to Ignore. This means that orders will have their colours changed if they are 

unpaid. If you need to amend or add a new colour if you click on the button next to the Highlight Colour filter on the main 
screen.  

NOTE: When you have clicked on the Close and Process Orders button all the imported orders will be selected. The orders 
shown will be in addition to the current filter. For example, if you are only showing orders from the last 7 days and you import 
orders from 30 days ago these orders from the last 30 days will also be selected and shown.This allows you to make sure that 
you always process all the orders imported. When you Refresh the orders (or use the F5 key) the order filter will be used again. 
In the example used, only the last 7 days orders will be shown once the Refresh has been used.  
 
Advanced Import 
To import information into existing orders you only need to include the Order ID and the required information (e.g. Delivery 
Instructions). You can not include an order's item details (e.g. product codes), but you can include all other order details 
(including Custom Entered values). An example of a CSV is shown below. This can be edited in Microsoft Excel and exported 
as a CSV file. 
 
Order ID,Delivery Instructions,Custom:Entered val. 1 

426-8234341-9441161,Leave with neighbour if out,JJ98324928 

283-61188984-5408319,Leave with neighbour if out,TY342334 

402-48239431-2828328,Leave with neighbour if out,KL123123 

129-11112346-3745908,Leave with neighbour if out,DS823748 

277-8758482-2751516,Leave with neighbour if out,RB819283  
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Creating and amending orders 

If you accept telephone orders, mail orders or want to enter manual orders click on the New Order button ( ). This will 
display the customer details dialog. You can also amend existing or imported orders. You can use any of the customer or 
product details created when importing orders. 

You can display the current order details in any of the following ways. 

Double clicking the mouse on an order.  
Select an order and right click (on the mouse) and select the Show Order Details option.  
 
NOTE: Only 1 person can edit an order at a time. While an order is being edited it can still be viewed by other users. You are 
prevented from editing an order if someone else is editing the order. If you have the ‘Allow locked orders to be changed’ option 
enabled (in the Setup Available Features dialog) you can override the other person editing an order. However, this will then 
prevent the other user from saving their changes. In practice, if this situation arises you should either talk to the person or send 
them a message (using the logged on users dialog from the main dialog). 

Each order is made up of the following pages: 

Order Customer Details Page  
 

 

The customer details for the invoice and delivery address are shown for the order. When adding an order you can use existing 
customers’ details by typing in their Company name, Buyer ID or Name. If more than match is found you can choose which 
customer to use. You can use the same and delivery address.  
 
If you want to copy the Invoice details or Delivery details to another application use the Copy address to clipboard option. These 
can then be pasted into any other application. To edit the order details press the Edit order details button. When you are adding 
an order the Edit order details button does not appear. 

When an order has been created you can send an email to their invoice or delivery address, using one of the pre-defined email 
templates (in the Options). 
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Order Items Ordered Page 
 

 

The key order information is displayed. This can be used to quickly check the status of the order. To edit the details, click on the 
Edit order details button. 
 
Invoice Number 
This is the invoice number that appears on the invoice. If you have the Use sequential invoice numbers option ticked on the 
Import Orders dialog this is the number allocated when importing. If this option isn't ticked then the websites value is allocated 
(e.g the Amazon order number). If you want to change the format or number allocated you should change this in the Import 
Orders dialog. However, if you are creating a manual order you can change the format (and value) in this dialog and the next 
invoice number created will use the new format. This includes when you import orders. 
 
Shipping method 
You can amend the shipping method. This will then become the default shipping type for the next manually created order. 
 
Shipping Instructions 
You can add or amend the shipping details (that would normally appear on the packing label, packing slip). 
 
Payment method 
This is the payment method used. This will then become the default shipping type for the next manually created order. 

PO Num 
If the customer has their own order number this can be used here. 

Date Ordered 
This is the date the order was placed on the website or entered on the order when manually created. You can amend this if 
required. 

Date Shipped 
You can click on the Ship button to ship the order. This also creates a shipped date. Once the order has been shipped you can 
change the date. 

Highlight Colour 
You can add or change the colour shown for the order. 

Currency 
The currency for the order is picked up from the products added or the invoice created. If you want to change the currency of the 
whole order you can enter the currency code here (e.g. $). 
 
Insurance 
If you want to amend the insurance taken (for Ebay) or manually add insurance then you can do so here. 
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Shipping/Handling 
This will be automatically created when you add, remove or amend the items in the order. However, if you want to change the 
total shipping you can use this field. The individual items will then have their own postage and packing amounts adjusted by a 
proportional amount of their original value. 

Outstanding Balance 
The amount that needs to be paid for the order is shown. If there is an outstanding balance this is shown in red. This can be 
very useful if someone has paid for the order and then needs to add on additional items. The additional amount that needs to be 
paid is then shown in red. Once paid you can click on the Pay Outstanding Balance button. 

 If you are adding an order you do not have to click on Edit order details. If you want to add a lot of items at once, using their 
SKU (product code) click on the Add items in Bulk, shown below. 
 

Adding Items in Bulk 

 

 

You can add up to 10 items quickly and easily. After entering the SKU you can then adjust the quantity and amend the price as 
required. 

You can amend or add an individual items, described below. 
 
Items ordered 
You can add, amend or delete items from the order. For each item in the order you can amend the details retrieved from the 
relevant website or add additional details (e.g. weight). 
 
When you add or amend an order the following dialog is shown: 
 

 

If you are adding an item to the order and know all or part of the SKU (Product code) type its value in and click on the Find... 
button. You are then shown the matching products and can choose the relevant one. 
 
You can enter or amend the main product details. In addition to this you can adjust the item's prices, shipping and weight. If you 
increase the quantity the tax and Total costs are adjusted. After the Tax has been calculated (based upon the item's VAT rate) 
you can then manually adjust the tax amount. 

If you amend an item and no weight is specified it is defaulted to 1 Kilogram. 
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When you enter a different product weight or postage and packing the total order's weight and postage and packing are 
automatically adjusted to incorporate the adjustment.  
 
You can also choose to show the costs including VAT. 
 
If you want to add (or amend) this product, in the main Products, click on the Add more Product Details button. 
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Order Details Memo Page 
  

 

Any information entered can be shown. To amend or add notes to the order press the Edit order details button. Information can 
automatically be added into the memo details when sending customer emails or tracking information sent to your website. 
 
If you tick the Add Computer and Time and Date to comments box the computer being used and current time and date is added 
to the start of the line when text is typed. 
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Order Custom Values Page  
 

 

If you are using custom values you can enter any relevant values here.  

The page contains values that can be changed for each order. However, they can also have default values. These are used if a 
value has not been defined. For example, using Citylink you can have a default Service of D. This means that if a value is not 
entered D will be used. If you want to override this, for a specific order, enter a different value. In the example, Z is used. 

If you only want to show custom values that are being used tick the Hide unused custom fields box. This will hide any Custom 
values that have not had their name changed. 

You can change the name of the field by clicking on their name. You can then change the name used. To change the default 
values you will have to add the field to a view and amend the view (see Selecting Displayed Fields). 
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Order selection 
  
You can select which orders to show based upon a variety of ways, for example, when the order was placed. 
 
Status 
This can be set to show orders only certain orders: 
. Not shipped 
. Paid and shipped 
. Shipped 
. Not paid or not shipped 
. All orders. 
 
 
Highlight Colour 
You can assign colours to specific orders. You can then choose to only show orders with a certain colour assigned to it. Each 
colour can be assigned a specific task (or order state) to fit in with how you run a shop. For example, if 3 different people 
process orders, each order handled by that person can be assigned their colour. Each user, on a different system can choose to 
only display their orders. You may also choose to use the colour red to signify an order from an important customer or to 
validate the customer’s delivery address (if a PO Box has been entered as the delivery address). 

NOTE: You can create up to 26 different colours, each having their own name. To do this press the  button to the right of 
the Highlight Colour Filter.  
 
Date 
You can use a master date filter to only show orders within a certain date range. The date range here can be used in addition to 
the main filtering. This selection is also independent of which view you are using. This can be very useful for when you have a 
large number of orders. You can set this to show only the last 30 (or 60 or 90) days orders. You can also change the available 

date periods to show orders from by pressing the  button to the right of the Date area. This displays the following dialog: 
 

 

You can also choose which date to use for the master filtering. 

Checkout date 
The date that the customer placed the order 

Payment date 
The date that the order paid for 

Dispatch date 
The date that the order was shipped 

Import/creation date 
The date and time that the order was imported into One Stop Order Processing. This is also the creation date of the order if it 
was manually entered. 
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Shop Type 
You can show orders from all of your shops (e.g. Ebay and Playtrade) or a specific shop type. This allows you to manage all of 
your orders from different shops in a single website. 
 
Once the list of orders has been displayed you select the orders to process by checking (ticking) the order to the left of the 
order. 
You can only use filters on the Custom values that allow values to be entered. Filtering will be done on the values entered for 
that particular field (not including the default value). 
 
Advanced Filtering 
A filter is based upon one of the currently shown columns. To create a filter do the following: 

1. Choose a Field type, for example, Checkout date. 
2. Select the Criteria, for example Between. 
3. Enter values for the chosen criteria, for example 9am on the 10th July 2007 and 5pm on the 30th July 2007. 

4. Press the Refresh button ( ). 

NOTE: You can also refresh orders by pressing the F5 button. 

 
More filtering options 
There are several useful filtering features that can make searching for groups of items very easy. You can use 1 of 2 methods: 

1. When searching for text items (e.g. Customer), you can select the Criteria Is one of. You can then type in a list of name 
separated by a comma (e.g. Brown,Smith,Jones). This will then produce a list of all the named people (in this case Brown, 
Smith and Jones). 

2. Get the filtering values from a file. If you type in !! followed by a filename (for example, !!C:\temp\filtervals.txt) the filter uses 
the value in the file. This can either be a single word, number etc. or it can use a list of values (as described in method 1). If you 
are using multiple items they can appear as a comma separated list or have a new item to search for on a separate line of the 
file. 
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Finding Orders 
 
You can easily find orders that contain certain text. If you enter text into the Search for orders with (F3) button all fields of all the 
currently displayed orders are searched. This can be very useful if someone telephones you and says their name or company 
but you don’t know which field they entered the values into. Every time you search for text it searches from the currently 
selected line. If the end of the orders list is passed the start of the orders list is searched. If no orders are found that contain the 
text a message is displayed. When an order is found that matches your text is automatically checked (ticked). 

NOTE: After entering your text you can also press F3 to find the text. If you always want to search from the first order displayed 
use F4. 

More searching options 
You can get the value to find from a file. If you type in !! followed by a filename (for example, !!C:\temp\findval.txt) the filter uses 
the value in the file. This can either be a single word, number etc.. 



www.1stoporders.co.uk                                                    One Stop Order Processing   

Page 62 of 180 DocVer 1.20                                 Copyright Mole End Ltd 2002 - 2012 

Views 
A view is a group of fields to display the order information by. There are several pre-defined views, each displaying the 
appropriate fields for a given task. You can modify these views or create additional ones by pressing the Customize current view 

button ( ). 

 

Views 
You can define up to 200 views, each having your own choice of fields. You can quickly and easily move between views. 
Several pre-defined views are created during the installation. These can be amended or new views created from them. 
 
You can also share views with other users by exporting your own.  

When you change views the current filter settings are saved. This means that each filter can have their own pre-configured 
filters. If you don’t want this feature untick the Store this view’s filter settings option. This will mean that when you change views 
the current filter will be applied to the orders within the new view (unless that field is not available in the new view). 

New 
You can create a new view. You can choose which view to copy the fields from. 

Delete 
Any view can be deleted. You must always have at least 1 view defined. 

Rename 
The name of any view can be changed. 

Import 
You can import views exported from other PCs. 

NOTE: When you import view information this will overwrite any individual definitions for custom values that you have defined. 
Your individual views will not be affected. 

Export 
This will prompt you for a filename to save the information to. If you want to share information with other users save the view 
onto a main server and then import to the other computer(s). 

Adding fields to a view 
 
You can add various fields to each view. These additional fields can be used when you export data or can be used in 
calculations. 

Selected and Available fields 
The right hand pane shows the current fields that are displayed in the order browser. To change the order of fields use the Up 
and Down buttons. If you want to remove any fields from the Selected list press the < button (or double click the item). To 
remove all items press the <All button. 

To add fields to the Selected list select the required field in the Available list and press the > button (or double click the item to 
add). To add all the fields press the All> button. The fields shown in the Available list are those not already selected from the 
current field Type. 
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Amend field details (and field calculations) 

You can also change the displayed name of any field. This is the name that is displayed for the column heading and the field to 
filter by. Click on the Amend field details button to display the dialog. 

 
 
If you are using a non custom field you can apply the text in the Field value to the end of the displayed field by putting !!! at the 

start of the text. This can be used to use any of the functions and macros (described below) on any displayed value. For 
example, entering a value of !!![U] will make the displayed text UPPERCASE. 

 
The details about the existing field are displayed: 

ID This is the unique ID for this field 

Field name The name to display for the column heading. If you want to use the original name click on the Use Original 
name button. The name used is also the name used for the column heading in any exported file (if a 
header is chosen to be included). 

Field value This contains the default value to use for the field if it is blank. The default value can refer to any field. For 
example, delivery instructions of Leave with neighbour of out. 

Include in 
Exported Information   

If you are going to export information you may not want to include all the information displayed. This may 
be because the information is used for data filtering. 
 
Example 1: Checkout date is used as part of the calculation for other fields 
Example 2: The export format must only show 80% of the order cost. 
The Grand total is displayed, but Include in Exported information is not ticked for it. The warehouse cost is 
calculated as 80% of the displayed order cost and Include in Exported information is ticked. 

Include field totals in 
export  

When this field is exported you can include the total of the column data in the information exported. You 
must also tick the Include column totals after data option when exporting the data 

 
Using default values 
Using default values in fields allows you to create your own analysis of your data and also extend the information displayed (or 
exported). 

There are two main uses for defaulting a value. You can use a default value if a field is blank. This applies to any built-in field, or 
custom field. 
 
The more common use of default values is when using custom fields (described in more detail later in this section). There are 
two types: the same value for all orders or a different value for each order. 

You can default a value from 1 (or more) of the other fields displayed in your view. You can only use the fields displayed in your 
view. 
 
You can also perform calculations or use conditional values on items in the default value. You can use the following operators. 

[+] The two values either side are added up 

[-] The value to the right is taken away from the value on the left. 

[/] The value on the left is divided by the value on the right. 

[*]  The two values are multiplied together. 

[<] Compares the value and if it is less than the value given value show the first value otherwise show the second value. 

For example, to show Parcel Force for orders less than £100 and CityLink for 

orders over and including £100 use: 

[%Total Cost%] [<] 100 [Parcel Force] [CityLink] 
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[>] Compares the value and if it is greater than the value given value show the first value otherwise show the second value. 

For example, to alert someone (by adding text into a certain field) to check all orders over £200 use: 

[%Total Cost%] [>] 200 [Check Order] 

[=] Compares the value and if it equals value given value show the first value otherwise show the second value. This can include 
text aswell as numeric values. 

For example, to change the drop shipper depending upon a certain product use: 

[%Product Ref%] [=] IL42 [SmartShipper][We Ship] 

[U] Make the field UPPERCASE. You should put the opertaor after the field value. 

This can be useful for making certain fields more visible. 

For example, to make the Delivery company name UPPERCASE use: 

[%Delivery Company%] [U] 

[l] Make the field lowercase. You should put the opertaor after the field value.This can be useful for making certain fields more 
readable when joined with other fields. 

For example, to make the built up sentence (which is itself made up from other fields) more readable use: 

[%Text Words%][l] 

[$]  Display a portion of a field. The 2 values following the operator are the position to start in the text followed by the number of 
characters to use. This can be useful when values have to be a fixed length for certain export functions or using certain 
characters in a value as a code to another system. 

For example, to use the first 3 characters of a product code as a warehouse location (or dropshipper) use the following. You 
can then base other fields on tests on this field. 

[%Product Ref%][$][1][3] 
 
If you put a ! before the second value you can take the portion of the string before the text given. For example, to include all 
the text before a space in the item title use the following: 
 
[%Item title%][$][1][! ] 
 
You can also search for certain words, not just single characters.  

[.] Take the absolute value of the number. For example, 19.21 would be shown as 19. This is very useful for any Inland 
Revenue figures where only the £ (GBP) number is required. 
 
For example: 
[%Grand total%][.]  

[#] Replace a letter or word with another word. This can be useful if you wish to replace certain words (for branding) or to 
remove unwanted.  
 
To replace the word Free with Additional use: 
[%Item title%][#][Free][Additional] 
 
To remove all commas from an address line: 
[%Invoice Address line 1%][#][,][] 

[D] Display the date (if a date field) in the format YYYY-MM-DD. This is useful when some export formats need the date in a 
different format. The formats supported are: 
 
1 - yyyy-mm-dd 
2 - dd/mm/yyyy 
3 - dd/mm/yy 
4 - mm/dd/yy 
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If you use nothing or 1 after the [D] it will use the format YYYY-MM-DD. 
 
For example, to display the date as day/month/year use. 
 
[%Invoice Date%][D]2 

[?] Find a word within a field. If the text is found show the first value otherwise the second value. For example, to look for the 
word Fast in the shipping instructions use the following: 
 
[%Delivery Instructions%][?]Fast[UPS][DHL] 
 
This will display UPS if the word fast is used in the shipping instructions or DHL if it is not. This can be used to display order 
processing information based upon the order's choices.  

[I] Display the ISO country code. If you use the default value for the fields as 
 
!!![I] 
 
the country will be shown as the country ISO code. For example, United Kingdom will be displayed as UK. 

 

<!> You can access the underlying data using SQL directly. You will need to know information about the underlying data. You 
can use the following values in the SQL to reference the current order being displayed: 

{{ORD_ID}} The current order's ID  

{{ORD_ITEM_ID}}  The current order line's ID  

 
 
For example, to show the total tax for all order lines on the main product reference only using the following SQL  
 
<!>Select sum({Tax 1}) from OrderDetail where (OrderSequenceNumber={{ORD_ID}} AND ProductReference='[%Product 
Ref%]') 
 
You can use the other fields in the view as normal (in this example, [%Product Ref%]). You don't have to include the fields 
referenced in the SQL in the view if you are using their database names,  

 
You can also use numbers in calculations. For example, 4 or 512.6 or £3.1415926. 

The example shown above is [%Grand total%] [*] 0.05. This shows all values in the Warehouse cost field as 5% of the 

Total order cost. When you use calculations if either of the numbers uses your currency symbol (e.g. £) this will be used in the 
value displayed. 

You can also perform calculations on fields which have other calculations performed on them. For example, another field, 
Warehouse VAT, maybe defined as [%Warehouse cost%] [*] 0.175. This will perform the calculation for the Warehouse 

cost before the WareHouse VAT. It does not matter the order that they appear in the view. 

If you want the users of One Stop Order Processing to be able to enter a different value for each order use a Custom Value: 
Entered for each order. They will enter the value in the Custom order details page. 
 

Other Macros 
{{TODAY}} 

Today's date  
 
{{TOMORROW}} 

Tomorrow's date.  

<ML> 

If you put this value at the start of a default value this will make the current line also appear in product and order detail line item 
lines when exported. This is useful if you want to include additional information for exported product order lines where the field 
being exported is a custom value. For example, using a default value of <ML>[%Temp2LineNumber%] for a Custom Fixed field 

will also export this field for the product lines (where other fields of this type are exported).  
 
XMLOPEN 

When you are exporting the order details as XML you can specify new nodes (folders) by using the default value of XMLOPEN. 
This will create a new Node with a name of the field. To specify the end of the node's scope you should create a field with a 
default value of XMLCLOSE. Using this approach you can create a hierarchy within an XML file. You should use a Custom 
Fixed field for this entry.  



www.1stoporders.co.uk                                                    One Stop Order Processing   

Page 66 of 180 DocVer 1.20                                 Copyright Mole End Ltd 2002 - 2012 

 
XMLCLOSE 

You MUST create a Custom Fixed field with a default value of XMLCLOSE when you want to close the XML node specified in 
the XMLOPEN field. The name of the field must be the same as the field name used in the XMLOPEN field. You MUST also 
close the last opened field given in the XMLOPEN field.  
 
 

Advanced field values 
 
You can also use nested conditions and operations  
 
An example is shown below: 

[%Sales source%][=]Ebay[[%Grand total%][<]13[RoyalMail][UkMail]][[%Sales 

source%][=]Amazon-SC[DHL][ParcelForce]] 

This will send all Ebay orders that are less than £13 with RoyalMail, All Ebay orders more than £13 with UKMail, all Amazon 
orders with DHL and all others with ParceLforce. 

This is explained below in the following pseudo code 

if [%Sales source%] [=] Ebay 

{ 

  
if [%Grand total%] [<] 13] 

{ 

    [RoyalMail] 

  

} 

else 

{ 

  

    [UkMail]  

  }   

}     

else 

{ 
    

  
if [ [%Sales source%] [=] Amazon-SC] 

{ 

    [DHL] 

  

} 

else 

{ 

  

    [ParcelForce]  

  }   

}     

 
 

More ways to use fields 
If you want users to be able to enter different calculations for each order set the default value to include [+] 0.  This tells One 

Stop Order Processing that any value entered may include calculations. If values aren’t entered the default value will be 0. You 
can set the default value to any number as long as it includes a sum (using [+], [-], [/] or [*]).  

If you want the user to be able to enter other fields (from the view), for each order set the default value as a field. For example, 
[%Grand total%]. If you are using this approach note that no validation is carried out and if the wrong field is entered a blank 

value is used. 

If you are exporting to a 3rd party system and you require the exported file to have a number of empty fields set the default value 
for a custom value to contain the required number of empty items. For example, if the exported format requires a 255 values per 
line Comma Separated Value (CSV) file where the fields only occupy the first 120 values; create a default value for one of the 
custom values to be ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,. When exported the commas (,,,,,,,,,, …) will be put onto the end of the existing 
output values. 
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Field Types 
The field Types are the main groups that the information is taken from. When you select the Type the list of Available fields 
changes in the Available pane. 

If you want to show the details of each order line you should select entries from the Order Line/Item Status. This will then show 
1 line in the display for each line of the order. For example, an order has 5 items there are 5 lines shown for that item. When you 
come to perform an action on that order (e.g. Print an Invoice), however many items within the particular order are selected it 
will only print (or whatever action) that order once. 

There are 2 additional field types: 

Custom Value: Fixed 
This allows you to enter up to 225 additional columns to your views all having the same value. This value can be based upon 
another field (or fields) and can include calculations. (Refer to the Amend field details for more information on for more 
information on setting up these values.). This field can be very useful for adding in required values for an export file, where One 
Stop Order Processing does not provide the relevant information.  

Custom Value: Entered for each order 
This type of field allows you to have a default value (described in the previous Amend field details section) that can be 
overridden, if required. You can create up to 50 of these values. You can amend the custom values on the Custom values tab 
on an order. 

Field details 
When you select a field on either the Available or Selected lists the field’s details are shown. This information is used to quickly 
identify the characteristics of a particular field. The following information provided is shown below. 

Name The actual name used and its default name. 

Type  The group the field comes from (e.g. Order information). 

Default Value The default value applied to the field. 

ID  The unique ID for the item. 

Export Will this be included in the exported information? 

 
  
Several views can be installed. These include Courier views (that allow your order details to easily be imported into external 
Courier systems). 

Change View Display Order 
 
If you want to change the order that the views are displayed select the View->Change Display Order menu option.  
 

 
 
To change the order of the views select the View to move (e.g. Default View) and click n the Move up or Move down buttons.  
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Refunds 
This feature is available in Standard, Premium and Enterprise versions of One Stop Order Processing 
 
When a customer has returned an item or cancelled part of an order before shipping you can create a refund for the order. You 
can create a refund (or credit note) for an order by select the Edit->Issue Refund menu option or right clicking on an order, right 
click the order and selecting the Issue Refund menu option. 
  

 

This shows the basic order details. You can select the full or partial amount to refund. When the refund is created all refunded 
values are shown as negative values. This means that when you show or use totals for multiple orders the actual amount is 
shown correctly (e.g. for VAT).  
 
If you want to make sure that you do not ship the refund you should tick the Copy shipping details to refund. This will copy over 
the shipping status and shipping date from the original order (that is being refunded). 
 
When you refund the order if the entire order is being refunded you can tick the Add items back into Stock. This will put all the 
items fro the order back into stock. If you are doing a partial refund you have to amend the original order to update the stock 
levels (and any changes made to the original order will update the stock levels).  
 
You can change how the refund details are shown: 
 
Text to use for refund 
When a refund is created an item is created for the refund. This value is the name given to the item. 
 
SKU/Item ID to use: 
This is the item ID given to the refund item. 

Prefix to use for order ID: 
The order number, invoice number and transaction ID for a refund is the same as the related order but has this text before the 
value. This makes it easier to find the related order. 

Text to show when printing: 
When a refund is printed a standard invoice is printed with the word Invoice replaced with this text. If you want credit note to 
appear on the print out change this text to Credit Note. 
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Products 
This feature is available in Standard, Premium and Enterprise versions of One Stop Order Processing 
 
One Stop Order Processing allows you to manage your products and stock across multiple selling platforms. You can amend, 
import and export product information. To see your current products select the Products->Manage menu option or click on the 

Products button ( ). Each product can have up to 3 different suppliers. 
 
 

 
 
You can find a specific product by typing in the Find text area and clicking on the Find button. This will look in all fields for the 
products. You can also filter products on all of the main product details. This can be useful if your products are all listed by 
Suppler, Bin.Location or another common field (to your orders). 
 
Products can be created in a number of ways: 
 
1 New button. You are then shown the Product Details dialog. 
2 Copy button. This copies the selected product and you shown the Product Details dialog.  
3 Automatically create products from imported orders. This is defined when you import products. 
4 Import products from a CSV file. You can update existing products with only the few required fields (e.g. to update the EANs 
or ASINS in all of your products). 
5 Use the Products->Import->From Selected Orders menu option. If you already have products in your system you can create 
the products from the selected orders. 

You can use the Export button to take the products out of One Stop Order Processing into a CSV file. You can then manipulate 
your products in Excel before importing back in again (or importing to a 3rd party system). 

You can also use this facility to import product details from other systems. The format of the CSV file is: 
 

Import file format 

 
The import file is a standard CSV (Comma Separated Value) file. The first line contains the field names separated by a comma 
(,). Each subsequent line contains values for those fields, each value being separated by a comma (,). Microsoft Excel can 
export information as a CSV file. You can create a template (example CSV file) by using the Export button and exporting an 
existing product. 
 
The product import file can contain any of the fields described below, in any order. If you do not know any of the information for 
a field don't include the field in the file to import. This is described below.  
 
You can use this approach to import stock levels based upon the item's SKU, and only include 2 fields in your product import 
file, SKU and CurrentStock). If you have a delivery of stock and simply want to add the current stock to the existing stock levels 
put a + before the number of items entered in the CurrentStock field and this amount will be added to the current stock. 
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Minimum requirements for an import file 
 
You must have at least 1 of the red fields in your import file to create a valid One Stop Order Processing product.  

Field Name 
This should appear in the 
first line of the file  

Description 

SKU Your product code , e.g. IL507. If you are using the import for different platforms (e.g. Ebay and 
Amazon) you must use the SKU field to identify the product. 

EAN European Article Number, normally used as the 13 digit barcode, e.g, 7352648596042 

Title Name of the product, e.g. 1922 Dodge Car Model RT5  

Description Brief description of the product, more details about the product. 

Price Price to sell the product to the customer, e.g. 12.92  

ShipCost The shipping cost of this product (to the customer), e.g. 1.99 

VATRate VAT rate of product, e.g. 15 

Weight The weight of the product in Kilos, e.g. 8.1 

Currency The currency to be used for this product, e.g. £  

Type The type of the product. This is used to filter the product on when viewing and amending, e.g. 
shoes 

CostPrice The cost price of the product. This is used to calculate the profit on sales, e.g. 9.82 

ShipCostPrice The actual shipping cost of the product, e.g. 1  

BinLocation The location to find the product in the warehouse. This is used when producing the picking list, e.g. 
AISLE 3 

UseStockControl Use stock control on this product? When orders are imported the stock levels are adjusted, e.g. 1, 
means use Stock Control. 0 means don't. 

CurrentStock Current stock of the product, e.g. 92. When importing if you put a + before the amount this increase 
the current stock level by the amount given. For example, if the current stock level is 10 and you 
import a value of +3 the stock will now be 13. You can also use a - to decrement stock aswell. For 
example, if you sold stock outside of One Stop Order Processing and want to update the stock 
levels. 

SiteStock Stock allocated to a particular selling platform (and being sold), e.g. 6. Means 6 are currently 
available on Ebay as a buy it now. 

ReorderStockLvl At what stock level do you want to be notified about? After orders have been imported any product 
levels that reach this level will be displayed and you can reorder stock for that product. e.g. 3  

OutOfStockLvl At what level do your products become out of stock? This is used when listing products on 
Amazon, Ebay etc..You may want more than 0 as an out of stock level, so you still have a product 
to use for samples, demos. 

Supplier Who is the supplier of this product. This is used for producing supplier reorder documents and 
other supplier related activities. e.g. AMZ 

Notes Your own notes on the product. 

SellingPlatform The platoform that this product is being sold on. This can be one of the following values: 
0 - All platforms 
1 - Ebay 
2 - Amazon 
3 - PlayTtrade 
4 - Actinic 
5 - OSOP (One Stop Order Processing, for telephone and adhoc orders). 
6 - Googlebase (Google Shopping) 
7 - Edirectory 
8 - Shopzilla 
9 - Interspire 
10 - Edirectory 
11 - XCart  
 
Each selling platform can have different values for the following information: 
 
Title, Description, Price, ShipCost, VATRate, Currency, SellingPlatform, Brand, Manufacturer, 
ProductType, Condition, Image1, Image2, Image3, Image4, Image5, SearchTerms, WebPage, 
Category, SellingFormat, Duration, Availability, OriginalPrice, ShippingDest, ASIN, CustVal1, 
CustVal2, CustVal3, CustVal4, CustVal5, CustVal6, CustVal7, CustVal8, CustVal9, CustVal10, 
CustVal11, CustVal12, CustVal13, CustVal14, CustVal15, CustVal16, CustVal17, CustVal18, 
CustVal19, CustVal20, SiteStock 

Brand The Brand of the product, e.g. Tillers 
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Manufacturer The manufacturer of the product, e.g. Wilkers 

ProductType The type of product, e.g. Shoe 

Condition Is the product New, Second Hand or Refurbished 

Image1 The web address (or local for TurboLister) for an image of the product. e.g. 
http://www.567carn.co.uk/images/pic1.jpg 

Image2 A 2nd image of the product 

Image3 A 3rd image of the product 

Image4 A 4th image of the product 

Image5 A 5th image of the product 

SearchTerms Search terms used to find product. e.g. trainer,shoe,fashion  

WebPage The webpage where this product can be bought. This is specific to products like Actinic, 
osCommerce. e.g. http://www.567carn.co.uk/products.php?812 

Category The selling platforms selling section. e.g. Computers 

SellingFormat The type of sale for the product, e.g. Fixed Price 

Duration How long the sale of the item is for. e.g. 7 

Availability How soon can the product be sent, e.g. 1, meaning 1 day. 

OriginalPrice The original price of the item. This is used for sales and price reductions on sites like Amazon. e.g. 
19.99 

ShippingDest Where the item will ship to, e.g. UK. 

ASIN The Amazon product code, e.g. B020TFXHIC 

CustVal1 Custom values specifically related to this site type. This allows you to add up to 20 different product 
details related to your business 

CustVal2  

CustVal3  

CustVal4  

CustVal5  

CustVal6  

CustVal7  

CustVal8  

CustVal9  

CustVal10  

CustVal11  

CustVal12  

CustVal13  

CustVal14  

CustVal15  

CustVal16  

CustVal17  

CustVal18  

CustVal19  

CustVal20  

sActinic The SKU code for the product if sold on Actinic. This is used to list and adjust stock for Actinic 
sales. 

sAmazon_mp The SKU code for the product if sold on Amazon Marketplace. This is used to list and adjust stock 
for Amazon Marketplace sales. 

sAmazon_sc The SKU code for the product if sold on Amazon SellerCentral. This is used to list and adjust stock 
for Amazon SellerCentral sales. 

sCube_cart The SKU code for the product if sold on Cube Cart. This is used to list and adjust stock for Cube 
Cart sales. 

sEbay The SKU code for the product if sold on Ebay. This is used to list and adjust stock for Ebay sales. 

sEbid The SKU code for the product if sold on eBid. This is used to list and adjust stock for eBid sales. 

sOne_stop The SKU code for the product if sold on One Stop Order Processing. This is used to list and adjust 
stock for One Stop Order Processing sales. 
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sOscommerce The SKU code for the product if sold on osCommerce. This is used to list and adjust stock for 
osCommerce sales. 

sPlaytrade The SKU code for the product if sold on Playtrade. This is used to list and adjust stock for Playtrade 
sales. 

sRoman_cart The SKU code for the product if sold on RomanCart. This is used to list and adjust stock for 
RomanCart sales. 

sEdirectory The SKU code for the product if sold on Edirectory. This is used to list and adjust stock for 
Edirectory sales. 

sInterspire The SKU code for the product if sold on Interspire. This is used to list and adjust stock for Interspire 
sales. 

sXCart The SKU code for the product if sold on XCart. This is used to list and adjust stock for XCart sales. 

sSupplier2 Who is the 2nd supplier of this product. This is used for producing supplier reorder documents and 
other supplier related activities. e.g. MAQ 

sSupplier2 Who is the 3rd supplier of this product. This is used for producing supplier reorder documents and 
other supplier related activities. e.g. EE2 

  

Update Stock details in bulk 
You can update the stock details for all the ticked products by clicking on the Update Stock button. This shows the Update 
Existing Stock details dialog. This is described later in this section. 
 
Update VAT 
You can update the VAT information for all the ticked products by clicking on the Update VAT button. This shows the Update 
Products VAT Details dialog. This is described later in this section. 
 
Add Stock 
If you want to update the stock levels of products click on the Add Stock button. You need to enter either the SKU or EAN of a 
product. This shows the Add Stock dialog. This is described later in this section. 
 
Advanced Import 
 
To import information into existing products you only need to include the SKU, EAN, Title or Description and the required 
information (e.g. CurrentStock). You must use the SKU if you are importing a field that is used for a platform. These fields are: 
 
Title, Description, Price, ShipCost, VATRate, Currency, SellingPlatform, Brand, Manufacturer, 

ProductType, Condition, Image1, Image2, Image3, Image4, Image5, SearchTerms, WebPage, 

Category, SellingFormat, Duration, Availability, OriginalPrice, ShippingDest, ASIN, CustVal1, 

CustVal2, CustVal3, CustVal4, CustVal5, CustVal6, CustVal7, CustVal8, CustVal9, CustVal10, 

CustVal11, CustVal12, CustVal13, CustVal14, CustVal15, CustVal16, CustVal17, CustVal18, 

CustVal19, CustVal20, SiteStock  

 
that An example of a CSV is shown below. This can be edited in Microsoft Excel and exported as a CSV file. 
 
SKU,CurrentStock 

IL513,100 

IL611,10 

AB551,12  

 
Adding new stock 
If you have had a delivery of existing products and you want to import the stock into One Stop Order Processing. When 
importing if you put a + before the amount this increase the current stock level by the amount given. For example, if the current 
stock level is 10 and you import a value of +3 the stock will now be 13. You can also use a - to decrement stock as well. For 
example, if you sold stock outside of One Stop Order Processing and want to update the stock levels. 
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Product Details 
  
If you display more details of a product you can amend or input additional information which will aid a variety of tasks, including: 
 
1 Stock location (using the bin/location field) 
2 Couriers total order weight. If the related product for each order has its weight entered then the total order is calculated. This 
can then be displayed (and exported, if required) using the Order Total weight field (from Customize View dialog). 
3 You can produce a Suppliers report, to easily reorder products (for your stock) 
4 Work out the profit you are making on each order (and the total) 
 
 
Main Details 
 

 
 
Most of the fields will be filled in if the product has been created from an order. You can enter any additional information, which 
is used in other areas of One Stop Order Processing. You can display your prices with or without VAT included. 
 
 
 
Order Type SKUs 
 

 
 
Each product can have a different SKU for each selling platform. If you don't define any specific platform SKU the main 
SKU/Code is used. For example, on Ebay the Custom field could be EB24, on Amazon your own product ID could be 
B00QFG88904. For Actinic the main product code is used (not defined on this page), of KLIO50. 

When any orders are imported the relevant product is found using the Order Type SKU and that order is updated with the 
relevant main SKU and the stock levels adjusted, if required. 
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Stock 
 

 
 
You can enter the actual cost price of the item (to work out profit) and the actual shipping costs, aswell as the sourcing 
information for the product. 
 
Pack Size 
The number of items the person actually gets when they buy 1 product. For example, if you sell 1 case of drink and want to 
deduct 12 items from stock enter a value of 12. For normal order processing you can use the default value of 1. If you sell the 
same product as single items or in groups (still as a single item) and want to maintain a single stock control item for the product 
you can use the following approach: 
 
1 Create a different product for each quantity type. 
2 Enter the same main SKU for the product on the Main Details tab.  
3 Enter the actual SKU on the Order Type SKUs tab. 
4 On one of the products tick Use Stock Control and enter the relevant values. 
5 In the Options, on the Other tab, the Sharing Stock Over Multiple Products box, tick Use Product with Stock Control Enabled. 

When you enter the Bin/Warehouse Location of the product you can use a textual location or numeric value. This can be useful 
when printing the picking list (which can be printed in Bin order). 
 
Suppliers 
You can select up to 3 suppliers for a product. You can type in a name or enter part of their ID and click on the Find button. This 
will then display the Supplier browser.  
 
Stock Control  
Using Stock Control you would typically have a reorder level and an out of stock level. You should set the reorder based upon 
the lead time required to obtain new supplies of the product. You may want the out of stock level to be higher than 0 so that you 
always at least of the product in stock (e.g. to allow photos to be taken of the product or for new supplier comparison). 
 
Current Stock 
The number of the product that you have available. 
 
Reorder Level 
When your stock gets at or below this level you need to order some more stock. This can be shown on the Reorder Stock 
Report. You can automatically calculate this value so that you never run out of stock. 
 
NOTE: If you want to calculate reorder levels to the nearest Pack Reorder Size, in Options, on the Other tab in the Products 
box, tick Calculate stock reordering to nearest Pack Reorder Size. 
 
Min. Reorder Stock Level 
The lowest amount to use for the Reorder Stock. This is used for slow selling items that don't have sales in the defined number 
of days of sales (where the figure would be 0) for automatic calculation.  
 
Out of Stock Level 
This is the number of items that means that you have no stock left. This is normally 0, but you may always want to have at least 
1 of these available. 

Reorder Lead Time 
The time for the product to be in stock (built or from a supplier). This needs to be taken into account when reordering.  
 
Pack Reorder Size  
The number of units that you have to update/buy the stock, e.g. in packs of 12. 
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Automatically calculate Reorder Level 
 
If you want to predict the stock reorder level based upon previous sales tick this option. The reorder levels are calculated 
whenever you import orders or use the Products->Stock Control->Recalculate Stock Reorder Levels.  
 
NOTE: Each product can have a different automatic stock reorder level. Whenever orders are imported (or created) the stock 
reorder levels are calculated and you are shown products requiring reordering. 
 
Number of Days of Stock to Hold 
Based upon the previous days sales this is the number of days of stock that you need to hold. 
 
Calculation method for finding Reorder Level 
There are 3 different ways to work out how much stock to hold. 
 
1. Calculate using Number of Days of Stock to Hold Value  
This is the same value used to calculate orders from. For example, to provide the next 7 days of orders based upon the last 7 
days sales.  
 
You can choose to include the stock lead time to work out the value. 
 
2. Calculate using Average Over previous n Days 
For example, based upon the last 180 days you can work out the next 7 days requirements. 
 
3. Calculate to have minimum stock (uses Lead Time)  
This uses the lead time for the product to make sure that you don't hold unnecessary stock (e.g. for expensive items). 
 
There are 3 ways to calculate the reorder levels 
 
1. By clicking on the Calculate Now button. 
2. After orders are imported the new reorder levels are calculated. 
3. You can select the Products->Recalculate Stock Reorder Levels menu option. 
 
You can also set up defaults for new product stock details aswell as set stock details for all products by selecting the Products-
>Stock Control->Update Product Stock Details menu option.  
 
Notes 
 

 
 
You can add your own information for the product, ordering notes etc.. 
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Custom Values 
 

 
 
If you want to add your own values to a product enter them into this field. You can add up to 20 additional pieces of information 
to each product. Click on the name of the field to change the name of the field. 
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Updating all Product Stock Details 

 
You can update all the product stock details and also set the default values for new products. To do this select the Products-
>Stock Control->Update Product Stock Details menu option.  
 

 

Set default values for new products  
To set the default values for new products enter the required default values and click on Close. When you manually create a 
product the stock details will use these values. 
 
Updating all product stock details  
To set the values for all products enter the values to use and tick the appropriate value to use in the right hand column. Only the 
values ticked will be updated in all the products. For example, If you wish to just turn on Stock Control in all products tick Use 
Stock Control and the tick box to the right and click on Update Products. 
 
The values that can be set are described below:  
 
Stock Control  
Using Stock Control you would typically have a reorder level and an out of stock level. You should set the reorder based upon 
the lead time required to obtain new supplies of the product. You may want the out of stock level to be higher than 0 so that you 
always at least of the product in stock (e.g. to allow photos to be taken of the product or for new supplier comparison). 
 
Automatically calculate Reoder Level 
To use the automatic stock reorder level calculation tick this box. 
 
Reorder Level 
When your stock gets at or below this level you need to order some more stock. This can be shown on the Reorder Stock 
Report. You can automatically calculate this value so that you should never run out of stock. 
 
Min. Reorder Stock Level 
The lowest amount to use for the Reorder Stock. This is used for slow selling items that don't have sales in the defined number 
of days of sales (where the figure would be 0) for automatic calculation.  
 
Out of Stock Level 
The number of items that means that you have no stock left. This is normally 0, but you may always want to have at least 1 of 
these available. 

Reorder Lead Time 
The time for the product to be in stock (built of from a supplier). This needs to be taken into account when reordering.  
 
Pack Size  
The number of units that you have to update/buy the stock, e.g. in packs of 12. 
 
Number of Days of Stock to Hold 
Based upon the previous days sales this is the number of days of stock that you need to hold. 
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Calculation method for finding Reorder Level 
There are 3 different ways to work out how much stock to hold. 
 
1. Calculate using Number of Days of Stock to Hold Value  
This is the same value used to calculate orders from. For example, to provide the next 7 days of orders based upon the last 7 
days sales.  
 
You can choose to include the stock lead time to work out the value. 
 
2. Calculate using Average Over previous n Days 
For example, based upon the last 180 days you can work out the next 7 days requirements. 
 
3. Calculate to have minimum stock (uses Lead Time)  
This uses the lead time for the product to make sure that you don't hold unnecessary stock (e.g. for expensive items). 
 
There are 3 ways to calculate the reorder levels 
 
1. By clicking on the Calculate Now button. 
2. After orders are imported the new reorder levels are calculated. 
3. You can select the Products->Recalculate Stock Reorder Levels menu option. 
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Adding Stock 

 
You can add new stock by using this dialog. Click on the Add Stock button in the Product Management dialog. 
 

 

Identifier for Product  
Select how you identify your products, either SKU or EAN (barcode)  
 
Product Identifier 
Enter in the code for product. If you don't know the code type in part of the code and click on the Find button. 
 
Show Current Stock 
If you want to see the existing stock tick this box. 
 
Stock To Add 
Type in the amount of stock to add. If you want to decrease the stock use a negative value (e.g. -10). 
 
Click on the Add Stock button. The input is moved to the Product Identifier field to enter the next product to add stock for. 
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Updating all Products’ VAT (Tax) Details 
 
You can update all the product VAT for the ticked orders. This is useful when the VAT rate changes and all your products need 
to be changed. 
 

 

Change VAT Exclusive Prices  
If you want to change the VAT rate on all your products enter the new rate and click on the Update VAT Rate button. This will 
change the Retail (VAT inclusive prices), but keep the product price the same. For example, if a product costs £100 with a VAT 
rate of 17.5% the retail price is £117.50. If you change the VAT rate to 20% the retail price will be changed to £120.  
 
Change VAT Inclusive Prices (this will keep Retail Prices the same)  
If you want to keep the retail prices the same when the VAT rate changes use this option. Enter the current VAT rate and the 
new VAT Rate. Click on the Calculate Price Adjustment button . This will calculate the amount to increase or decrease prices by 
in the box below. To update all the selected products click on the Update Prices and VAT Rate button. For example, if a product 
costs £100 with an old VAT rate of 17.5% the retail price is £117.50. After using a new VAT rate of 20% the Retail price is still 
£117.50, but the product price (not including VAT) is now £97.92. 
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Advanced Product Settings 

 
Changing the Product fields shown 
  
There is a file in the One Stop Order Processing installation folder called IL_1StopOrderProductFields.ini. This contains 

a list of all the product fields that can be displayed in the Product Manager. Any of the 74 fields can be displayed or filtered on 
and can be sorted by. The fields can be shown in any order. 
 
There is another file called IL_1StopOrderProductUsrFields.ini. This contains the fields to display. This file contains 

headings titled [Fieldn], where n is the field to display at position n (e.g. [Field1] will define the first field to display. Under 

each [Fieldn] section is a line ID=n. Where n is the field to show at this position. The number, n, is the value taken from the 

product field definition file (IL_1StopOrderProductFields.ini). The value n to use is the number of the field defined in the 

definition file (by its heading, [Fieldn]).  

 
For example, to include the Bin Location, decide where it should appear, for example, position 5 and then find its field number in 
the definitions file. Then add this ID to the view file. 
i.e. The definition of the Bin Location is defined as the following, in the definitions file:  
 
[Field13] 

Name=Bin/Location 

SortType=1 

Width=100 

FieldSQL=sBinLocation 

 
to add this to position 5 on the screen define the following in the view file: 
 
[Field5] 

ID=13 

 
NOTE: Your view file must start with [Field1] up to the maximum number of fields that you want to display. You must not 

leave any gaps in your numbering. For example, defining [Field1], Field[2], Field[4] will only load in the first 2 fields. 

This should be [Field1], Field[2], Field[4], this will display all 3 fields. 
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Customers 

You can view all of the customers by clicking on the Customers button ( ). You can also use the Contacts->Customers-
>Manage menu option. The customer browser is also shown when you use create orders (and use the Find button).  
 

 
 
You can find a specific customer by typing in the Find text area and clicking on the Find button. This will look in all fields for the 
customers. You can also filter customers on all of the main customer details.  
 
You can use the Export button to take the customers out of One Stop Order Processing into a CSV file. You can then 
manipulate your customers in Excel before importing back in again (or importing to a 3rd party system). See the advanced 
section for more information on the format of the CSV file. 

Customer Details 
  
If you display the details of a customer you can amend the details. 
 

 
 
ID 
A unique identifier for the customer. This is used to Find or filter customer details. 

Name 
The contact name for the customer. 

Company 
The company name 

Address line 1 
Address line 2 
Address line 3 
Address line 4 
County 
Post code 
Country 
Address details 
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Phone 
Telephone number 

Fax 
Fax number 

Email 
Email address 

VAT No 
VAT number 

Code 
Your unique code for the customer. 

Notes 
Any notes that you may have for the customer. 

You can also use this facility to import customer details from other systems. 
 

Advanced Information 
 
Import file format 
The import file is a standard CSV (Comma Separated Value) file. The first line contains the field names separated by a comma 
(,). Each subsequent line contains values for those fields, each value being separated by a comma (,). Microsoft Excel can 
export information as a CSV file. You can create a template (example CSV file) by using the Export button and exporting an 
existing customer or supplier. 
 
The customer import file can contain any of the fields described below, in any order. If you do not know any of the information 
for a field don't include the field in the file to import. This is described below.  
 
Minimum requirements for an import file 
You must have at least 1 of the red fields in your import file to create a valid One Stop Order Processing customer.  

Field Name 
This should appear in the first 
line of the file  

Description 

ID Unique identifier for the customer. You can use any format that you like (e.g. 12345 or 
ROBERTSONS). 

Name Name of the customer. This is normally a person's name, e.g. John Smythe. 

Company Company name used, e.g. Saysuid Ltd 

Address1 First line of customer's address 

Address2 Second line of customer's address  

Address3 Third line of customer's address  

Address4 Fourth line of customer's address 

County Customer's county  

Postcode Postcode of customer 

Country Country  

VATNumber VAT number of company 

Fax Fax number 

Tel Telephone number  

Email Email address  

Type Type of details. 0 = Invoice customer, 1 = Delivery customer, 2 = Supplier 

Code Code used for customer. This is your internal name used for the customer 

Notes Notes entered for the customer. 
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Suppliers 
This feature is available in Standard, Premium and Enterprise versions of One Stop Order Processing 
  
Products can be assigned up to 3 suppliers. This can be used to either dropship orders or produce purchase orders for 
reordering stock. To view, amend or create Suppliers select the Contacts->Suppliers->Manage menu option. Using supplier 
purchase orders you can create separate purchase orders for each supplier. You can also send separate emails to suppliers for 
customer's orders related to them. For example, if an order is placed that has 4 products, 2 from one supplier and the other 2 
from other suppliers, 3 separate emails are sent (or 3 separate purchase orders printed).  
 

Generate Suppliers from SKUs 

If you currently use the supplier details as part of the SKU you can automatically create suppliers from the SKUs. 

If you want to use the suppliers feature of One Stop Order Processing and you have already setup your SKUs to contain 
supplier details you can create suppliers from the SKUs. Select the Contacts->Suppliers->Generate Suppliers from SKUs menu 
option. 

 

You can choose to create the suppliers from the SKUs using following approaches: 
 
Use first n characters 
You use the first few characters of the SKU. For example, BAKC9019 with a value of 4 would create a supplier called BAKC. 
 
Use all characters before 
You can select the supplier by all the characters up to a certain character (or word). For example, BAKC##9019 and a value of 
## would create a supplier called BAKC. 

Once you have chosen how suppliers will be found you can preview what suppliers will be found by clicking on the Preview 
Generated Suppliers. Once the suppliers found look valid select the related products should be handled. 
 
Update products with generated supplier details 
When the supplier has been found you can update the product that uses the supplier with the new supplier details. This is 
needed to use the supplier features of One Stop Order Processing (e.g. to send individual supplier emails).  
 
Do not overwrite product supplier (if already setup) 
When the product is updated you can decide to not overwrite a supplier of it has already been setup. This can be very useful if 
want to adjust any previously setup products' suppliers and also import any new ones for newly added products.  
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Exporting Order Details 
This feature is available in Standard, Premium and Enterprise versions of One Stop Order Processing 

One Stop Order Processing allows any view’s orders to be exported. To allow easy data conversion to the target system you 
can also define your own values. These can either contain a single value for all orders, or a different value for each order. These 
values can be defaulted from any other field and can include calculations based on other fields. For more information see 
Selecting Display Fields. 

To export all the orders (or selected orders) select the Export Orders menu option (under File->Import and Export) or click on 

Export Orders button (  ). If you select Current View it will show the export dialog. You can select a predefined view from 
the list. 

 

You can define how you want to export the information displayed on the screen. Only the fields (columns of data) that are 
marked for export are exported. The columns shown in the Export order details dialog are those that will be exported. 

Orders to include 
You can either export all the orders displayed shown in the main window or those that you have ticked. 

Include header line 
If you require information at the start of the file add any text here. 

Include footer line 
If you require information at the end of the file add any text here. 

The header, footer lines and filename can include the following macros. These are replaced when the information is exported. 

[%TIME%]   The current date and time. 

[%FILENAME%]  The filename exported to. 

[%NUM_EXPORTED%]  Number of orders exported 

[%NEW_LINE%]   Start a new line. This can be used to put several blank lines (with or without data in) at the start 
or end of the export file. You can also use the value %NEW_LINE% in a column's definition to 
export a newline (useful for some export formats). 

[%TAB%] Use a tab character. 
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Include column headers before data 
Some 3rd party products want the names of the fields that the information relates to. You can change the names of the columns 
in the Select fields dialog. 

Include column totals after data 
You can include the totals of any columns defined in the view as totals required. 

Include all fields 
When exporting orders ignore any column specific information about not exporting the column. This is useful when you want to 
export all the order data from the OSOPExport view. This will also include the original column names, rather than any new 
names that have been entered. 

Quote field information 
If you are using the separator in your main text you may want to use quoted fields. For example, some applications (e.g. 
Microsoft Excel) allow the comma separator to be used as field text as long as all the fields are quoted. You can use any 
character(s) to put around the export field information. 

Field separator, to use a tab enter \t 
This is the character (or characters) to use between each value. If you need a Tab Separated file (tsv) type in \t. 
 
Include order, order details and products on same exported line 
If you want to export order details and the orders have more than 1 item per order you can tick this option to include all the order 
details on the same line. This feature is useful when using fulfillment houses (drop shipping). 
 
If you tick this option any details that relate to the items ordered or product details are added onto the end of the order. For 
example, if you add the field Item ID and Item title on the end of the fields to export, additional fields will be exported onto the 
end of the main order for these items. 
 
Group orders by first column. 
You can export the orders in groups. For example, a day's orders or all orders of a certain type. When exporting the first field 
included is looked at and when its value changes a new group is started. If you tick the 'Include field total in export' option on the 
field details (in the Customize view dialog) then when this field is exported all values in that group are added up. For example, if 
the Grand Total column has this option ticked (the 'Include field total in export') the line exported for the group will contain the 
total for all orders in the group. 

Assign unique value to each exported order line (using %INV_NUM%) 
If you want to have a value exported for each line that is a sequential value tick this option. This is useful when you are 
exporting to accounting packages where a sequential order number is very useful. You can use the automatically created 
invoice number (created when orders are imported). However, if you don't export all these orders or you are using the Group 
Orders by first column option there will be gaps in the invoice numbers. Even if you use the %INV_NUM% multiple times on the 
same exported line its value will only increased after that line has been exported. If a certain line does not contain the 
%INV_NUM% macro the value will not be increased. 

Only include columns where column name is in: 
If you want to display a lot of fields, but only export some of them tick this option. This is very useful if you want to find orders 
based on location, name or amount but don't want to export this information. You should include the name of the column to 
export in the field with a # around the column name. This is used incase some column names are part of other names (e.g. 
Detail and More Detail). 
 
For example, if you want to export the columns Order Number, Date Ordered and Invoice Company (but display more fields) 
enter a value of #Order Number#Date Ordered#Invoice Company#. 

 
File to export to 
The file that will be used to save the information to. This file will be overwritten each time an export is done. 



www.1stoporders.co.uk                                                    One Stop Order Processing   

Page 87 of 180 DocVer 1.20                                 Copyright Mole End Ltd 2002 - 2012 

File format 

You can export the orders into a CSV, XLS (Excel spreadsheet format) or XML (Extensible Markup Language) 
 
XML files  
For XML files, by default, a single level (group) is created (called Orders). To change the group name, amend the value in the 
Header and Footer text. If your XML format needs additional elements (folders) you can add these by using Custom Fixed fields 
with a default value of XMLOPEN and another field with a default value of XMLCLOSE to close the element (group). Using this 
approach you can create XML files with multi-level element hierarchies. To open another element within an existing element 
create another Custom Fixed field with a value of XMLOPEN. You MUST create a Custom Fixed field with a value of 
XMLCLOSE for the same element before creating an XMLCLOSE field for the parent field.  
 
There is an example view XML view, called XMLSample.mev,  which you can import to see how to create a multi-level 

hierarchical file. 
 
There are various file formats. For normal CSV files select Standard. For specific formats, they are listed in the box on the right, 
for example, RoyalMail Despatch Express.  
 
Add comment to order memo when exported 
You can add text to the order's memo/notes when the order is exported. This can be useful to see if an order has been 
exported. 
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Exporting order details to 3rd Party systems 
 
Several export formats are included with One Stop Order Processing. These are designed for many of the common systems 
that can provide additional services for your orders (including parcel couriers and website order updating). 
 
You can amend the supplied export views and create your own export views. These export view definitions can be saved and 
given to other users of One Stop Order Processing. 
 
One Stop Order Processing can export information in a CSV, TSV, XLS, IIF or XML format. 

This section explains how to use the existing supplied export views.  
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Amazon Shipping Confirmations 
 
1 Select the AmazonShippingConfirmation view (if this doesn't appear in your list you can import this by selecting View-
>Customize Current View and clicking on Import. Then select the C:\OSOP\Main\AmazonShippingConfirmation.mev 

file). 
 
2 Amend any default information for all orders or individual orders (e.g. Shipping method). You can define a value for all orders 
using the Default value when you amend the Selected fields (when you Customize Current View). If you want a specific value 
for each order you can amend this in the Custom Values tab on each order. 
 
3 Select (tick) the orders to export shipping information for. 
 

4 Press the Export Orders button ( ) and select AmazonShippingConfirmation. This will create a file to import into Amazon. 
 

 
 
 
5 Logon to Amazon Seller Central and select the Upload Order Related Files on the Orders menu. 
 

 
 
6 Select you file created by One Stop Order Processing and click on Upload Now. 
 

 
 



www.1stoporders.co.uk                                                    One Stop Order Processing   

Page 90 of 180 DocVer 1.20                                 Copyright Mole End Ltd 2002 - 2012 

Ebay Shipping Confirmations 
 
You can update all of your Ebay orders' statuses using One Stop Order Processing (up to 10000 at a time). To do this you will 
need to subscribe to Ebay's Selling Manager Pro (current cost £4.99 per month). This is described below:  
 
1 Once you have processed and shipped your Ebay orders in One Stop Order Processing (e.g. marked them as shipped, 
printed invoices and adding tracking information),  If you have already setup your EbayShippingConfirmation view go to step 3. 
 
If the EbayShippingConfirmation doesn't appear in your list you import this by selecting View->Customize Current View and 
clicking on Import. Then select the C:\OSOP\Main\EbayShippingConfirmation.mev file. 

 
2 Amend any default information for all orders or individual orders (e.g. Shipping method). You can define a value for all orders 
using the Default value when you amend the Selected fields (when you Customize Current View). If you want a specific value 
for each order you can amend this in the Custom Values tab on each order. 
 
3 Select (tick) the orders to export shipping information for. 
 

4 Press the Export Orders button ( ) and select EbayShippingConfirmation. 
 
5 Logon to Ebay and click on the File Management Centre, shown below. 
 

 
 
6 Click on the Upload Inventory option, shown below. If you do have any entries in the Uploads section you have not subscribed 
to Selling Manager Pro. To use this facility you will need to subscribe to Selling Manager Pro.  
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7 Enter your Ebay email address and select the shipping file produced from One Stop Order Processing, shown below. Click on 
the Upload button. You can check the status of the upload by clicking on the View Upload Results option on the left hand side. 
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RoyalMail SmartStamp 

  
If you use RoyalMail SmartStamp for your envelopes or labels you can use One Stop Order Processing to export all of your 
names and addresses. To do this use the following procedure: 
 
Using One Stop Order Processing 
 
1 Make sure the SmartStamp View is installed.  
 

 

2 Select the orders to print labels/envelopes for. You can either export all the displayed orders or all the selected orders. 

3 Press the Export Orders button ( ) and select SmartStamp.  
 
4 These can now be used in the mailmerge in SmartStamp. If required, you can change the file name by selecting the 
SmartStamp View and selecting the View->Change Export Options menu option or click on the button to the right of the View 

selection field ( ).  
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Setting up SmartStamp  

1 After installing and running the SmartStamp application select the type of envelope/paper/label to use. If yours is not available 
create your own type using the Define... option.  
 

 
 
 
2 Click on Address & Postage button on the left hand side. 
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3 Select Mail Merge and click in the OK button. 

.  
 
 
4 Enter the location of the address file which is normally C:\SmartStampAddresses.csv. 
 

 
 
 
5 Make sure that First row contains column headings is ticked and click OK. 
 

 
 
 
6 Make sure that all the required fields are included in the address (by ticking the required fields) as shown below. If you don't 
want the country to appear untick this field. 
 
Then press OK. 
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7 You now need to define the how the fields will appear. Click on the Configuration button.  
 

 
 
8 Add in the extra fields being used. By default only the first 5 are shown. The right hand pane shows how they should look. Any 
fields that you don't want displayed should not be added (or removed). When you are happy press OK. 
 

 
 
9 You can now select the correct postage and print your envelopes. 
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RoyalMail Despatch Express  

 
If you use Royal Mail's Despatch Express Software system you can use One Stop Order Processing to print all of the selected 
orders' labels. You can also import the tracking details (created by Despatch Express) back into One Stop Order Processing, 
which can then be included in customer emails (or printed on invoices etc.). 
 
To do this use the following procedure: 
 
Using One Stop Order Processing 
 
1 Select the Despatch Express view. If this is not available this is installed into the installation directory (e.g. C:\OSOP\Main). 

The view displays more columns that will be exported to Despatch Express (for example, Items Shipped). These are used to 
find order information (or for filtering). These columns are not exported. 
 

 
 

2 Amend the view (using the View->Customize current view menu option or the button). 

3 You should amend the value of the Account Number field. If you have an account number enter this value here. You can leave 
this field blank if you only have 1 account number. To change other values see the Advanced settings section. 
 
4 Select the orders to print labels for. You can either export all the displayed orders or all the selected orders. 

5 Press the Export Orders button ( ) and select RoyalMail - Despatch Express (Batch). 
 
6 The orders will be exported, by default, to C:\DespatchExpress.dat. You can change the filename by selecting the View-

>Change Export Options menu option or click on the button to the right of the View selection field 

( ).  

Using Despatch Express 
 
7 Once the file has been created you should start Despatch Express. Select the Despatch / Batch Import menu option. 
 
8 Select the file exported by One Stop Order Processing and click on Import. 
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Importing the RoyalMail Tracking details into One Stop Order Processing 
 
1 Once you have created your RoyalMail labels, using Despatch Express, export the details to a file (for example 
C:\DespatchExpressDetails.csv) 

 

2 Using One Stop Order Processing select the Import orders button ( ). 
 
3 Select the One Stop Order type and tick Update information in existing orders. This is shown below. 
 

 
 
4 Click on the Options button. This displays the following dialog. 
 

 
 
5 Tick the Use OSOP compatible header for order import file and enter a value of  
 
Custom:Entered val. 

1,C1,C2,C3,C4,C5,C6,C7,C8,C9,C10,C11,C12,C13,C14,C15,C16,C17,C18,C18,C19,C20,Ord

er ID,C21,C22,C23,C24,C25,C26,C27,C28,C29,C30,C31,C32,C33,C34,C35 

 
NOTE: The above maybe shown over 2 lines but include all the text starting with Custom and ending with C35 (on a single 

line). 
 
This will map the relevant fields from the Despatch Express export to the One Stop Order Processing fields. 
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6 Click on OK. 
 
7 When you import the order details (by clicking on Import One Stop orders) the Custom field value will be updated with the 
tracking ID. 
 
8 You can see the tracking value by viewing an order and looking at the Custom values tab. It will be in the top right hand corner 
value of the Custom values dialog. To use this value in an email or invoice use the following macro: 
 
[%CUSTOM_ENTERED1%] 

 
9 If you want to import the tracking details into a different order field use the relevant field name from the Order Tracking section. 
 
 
and in the above header line (in 5) change Custom:Entered val. 1 for the new field name. 

 
10 You can also include this value in emails or invoices etc.. 
 
For example, to import the tracking ID into the order's Shipping instructions field use the values Delivery Instructions (in 5) and 
[%DELIVERY_INSTRUCTIONS%] in emails etc.. 
 
 
Advanced settings 
The default settings are for the number of labels to be printed as 1 using a 1st Class Packet Post service.  
 
You can amend any of the default values by amending either the default view settings, or if it is per order in the custom values 
on the required order. 
 
DE-ServiceID 
The following values can be used in the used as the default value or entered on each order 

Code to 
enter 

Meaning 

SD101 Special Delivery Next Day £500 

SD201 Special Delivery Next Day £1000 

SD301  Special Delivery Next Day £2500 

SD401 Special Delivery 9am £50 

SD501 Special Delivery 9am £1000 

SD601  Special Delivery 9am £2500 

TP201 Royal Mail Tracked 

STL01 Standard Tariff Letters 1st & 2nd 

CRL01 Packet Post Daily Rate 1st Class 

CRL02 Packet Post Daily Rate 2nd Class 

FS101 Packetsort 8 1st Class Flat Rate Large Letter 

FS201 Packetsort 8 2nd Class Flat Rate Large Letter 

PK101 Packetsort 8 1st Class Flat Rate Packets 

PK201 Packetsort 8 2nd Class Flat Rate Packets 

PK301 Packetsort 8 1st Class Daily Rate 

PK401 Packetsort 8 2nd Class Daily Rate 

PPF01 Packetpost Flat Rate 1st Class 

PPF02 Packetpost Flat Rate 2nd Class 

OLA01 Overseas Letters Airmail 

OLS01  Overseas Letters Surface 

MP101 International Contract Airsure 

OF101 International Format Sort Priority 

OF301 International Format Sort Economy 

OZ101 International Zone Sort Priority 

OZ301 International Zone Sort Economy 

 
You can also use calculations based upon the order values to use different values for fields. For example, setting the default 
value of DE-ServiceID to the following 
 
[%Total P&P%][<]3.5[CRL01][CRL02] 

means use CRL01 (Packet Post 1st Class) if p&p is£ < 3.5 otherwise use CRL02 2nd class. 
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If you have 3 or more shipping conditions you use the following approach. Using an example defined in the following table: 

Shipping Method Despatch Express Code 

Royal Mail 1st Class Post STL01 

Next Day UK Delivery, Mon – Sat SD101 

Airmail OLA01 

 
You need to define a column for each value. Using Custom Fixed Values. In this example, values 18, 19 and 20. You should 
untick Include in Exported information for each of these fields. 

Define the values as in the following table. 

Custom Value Default field value 

[%Custom:Fixed val. 18%] [%Shipping method%][=]Royal Mail 1st Class 

Post[STL01] 

[%Custom:Fixed val. 19%] [%Shipping method%][=]RNext Day UK Delivery, 

Mon - Sat [SD101] 

[%Custom:Fixed val. 20%] [%Shipping method%][=]Airmail[OLA01] 

 
You then need to put the value into the column to export (i.e. tick Include in Exported information). 
 
Use another Custom value. In this example, [%Custom:Fixed val. 21%]. 
 
define its Default field value as 
 

[%Custom:Fixed val. 18%][%Custom:Fixed val. 19%][%Custom:Fixed val. 20%] 

 
This will put in whichever value has been defined into a single field. 
 
NOTE: You should untick Include in Exported information on the [%Shipping method%] field as this is not required. 

More complex shipping models 
If you ship using different methods based upon order value you can use the following approach as shown in the following 
example: 
 
Packages should be sent as described in the following table.  

Order Value How to send Despatch Express method 

Less than £5  2nd Class Service STL01 , Class 2  

£5 to £9.99 2nd Class Recorded Service STL01 , Class 2 , Service Enhancement 11 

£10 to £19.99 1st Class Recorded Service STL01 , Class 1 , Service Enhancement 11 

£20 and above Royal Mail Tracked Service TP201 

 
To do this you should add the Grand Total to the view and untick Include in Exported Information. 
 
DE-ServiceID  
Change the value to 
 

[%Grand total%][<]20[STL01][TP201] 

 
Service Enhancement 
Change the field value to 
 
[%Grand total%][>]4.99[~[%Tracking Code%]][~]  

 
Class 
Change the field value to 
 
[%Grand total%][<]10[2][1]  

Tracking Code 
Change the field value to 
 
[%Grand total%][<]20[11] 
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Also untick Include in Exported information 

 
 
Package weights 
You can enter weights for some Despatch Express services. If you need to do this amend the value of DE-Additional1 field and 
remove the first ~ from the default value. Then add a field before the DE-Additional1 field to will contain the weight. This can be 
a fixed weight or use the calculated weight. If required you can display this is grammes (rather than kilos) by changing the Field 
value to: 
 
!!![*]1000 

this will display the value multiplied by 1000 (i.e. in grammes). 

NOTE: You may need to include some fields used in calculations in views. If you untick Include in Exported information this field 
will not be exported. 
 
For more information about Despatch Express you can see Royal Mail's guide at: 
 

ftp://ftp.royalmail.com/Downloads/public/ctf/rm/Despatch_Express_Interfacing_System.pdf 
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UKMail Consignor 
 
If you use the UKMail Consignor Software system you can use One Stop Order Processing to automatically print all of the 
selected orders' labels. To do this use the following procedure: 
 
Setting up Consignor 

1 Start Consignor Server by right clicking on the icon in the bottom right of your main screen and selecting the Details menu 
option. 

 
 
 
2 Click on the Gateway Manager button 

 
 
 
3 Make sure that Start Consignments Gateway When Consignor Server Is Started is ticked. 
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4 Click on the Consignments tab and select Post, with Labels. 

 
 
 
5 Click on the Consignments Schema tab. You should download and save the schema to the 
\\SHOP\bpdata\consignor\GatewayTest directory. Where SHOP is the name of your PC. 
You should then download and save the sample file to the \\SHOP\bpdata\consignor\GatewayTest directory. Tick the Delimited 
ImportType and enter ~ as the character.  

 
 
6 Click on F2 Save to save the changes. 
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Using One Stop Order Processing 
 
1 Make sure the UKMail Export Format is installed.  

2 Select the orders to print labels for. 

3 Press the Export Orders button ( ) and select UKMail. This will export the orders to 
\\SHOP\bpdata\Consignor\GatewayIn\bpdata.txt. If this is not the Consignor folder select the UKMail View and select 

the View->Change Export Options menu option or click on the button to the right of the View selection field 

( ). You can enter the correct output filename in the File to export to field. Where SHOP is name 
of your PC where Consignor is installed. When you install Consignor your main data area is shared with the share name bpdata. 
 
4 You can then send the customer an email that allows them to track their order using a link directly to their order. To do this use 
the UKMail Email template. 

 

Advanced settings 
 
The default settings are for the number of labels to be printed to match the number of items shipped using the UKMail Next Day 
service. Also UKMail also requires the weight of the item to be given. The default value is to weigh each parcel as 2 Kilos. If you 
don't enter this value or it is too low UKMail should update it with their weighed amount. 

Use the following information to change the details on all orders or on each order. 

1 If your default service level is not 1 (Next Day) enter a new value. To do this click on the Customize current view ( ) 
button, click on the BP Service field and click on the Amend field details. In the field details dialog change the Default field value 
to match your service level. You can change this on a per order basis by using a Custom Entered for each order variable and 
amending the order details in the Custom values page when viewing order details (click the Edit order details button first). 

2 The number of labels to print is defaulted from the items shipped. If these match then you can leave the value. However, if a 
particular order has a different value amend the order details as described in 1 (above). If you always have a fixed number of 
items amend the default value of the column to that number (using the approach described in 1 (above). If the number of labels 
is relative to the number of items shipped (e.g. plus 1 label or 2 times the number of labels) amend the default value by using a 
calculation. 
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Quickbooks 

 
You can export to Quickbooks 2004 to 2012. The different options are split into 2 formats, Quickbooks 2004 to 2007 and 2008 
onwards. 
 
The following instructions explain how to set this up. 
 
1 Install the QuickBooks view  
 
There are 5 choices of views to import: 

QuickBooks2008-

CustomerInvoices.mev 
QuickBooks versions from 2008 where all orders customers, products and 
orders are imported as separate invoices.  

QuickBooks2008-

SingleInvoices.mev 
QuickBooks versions from 2008 where all orders are imported as individual 
invoices  

QuickBooks2008-

GroupedByDayInvoices.mev 
QuickBooks versions from 2008 where each day's orders are imported as a 
single invoice.  

QuickBooksUpTo2007-

SingleInvoices.mev 
QuickBooks versions up to 2007 where all orders are imported as individual 
invoices. 

QuickBooksUpTo2007-

GroupedByDayInvoices.mev 
QuickBooks versions up to 2007 where each day's orders are imported as a 
single invoice.  

 
The grouped invoices are useful if you have a lot of orders (e.g. from Ebay). They are imported into Quickbooks as a single 
invoice with the day's total order values (and VAT). Each invoice will have a unique sequential order number. As the views are 
configurable you can group the orders by any field.  
 

2 Click on the Export Orders button ( ) and select the Quickbooks link. This will create the file C:\QuickBooks.iif. If this is 
the correct file location go to step 3. 
 
If you want to change the filename or other setup select the QuickBooks view and select the View->Change Export Options 
Menu.  
 
This will display the Export orders details dialog, shown below. 
 

 
 
Click on the OK button. 
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3 Start Quickbooks. 
 
4 Below is a description of where the order information is imported into. You either need to make sure that the accounts (And 
items) exist in QuickBooks or amend the default values, shown below, to match your setup.  
 
Fields used for QuickBooks versions up to 2007 (using the imported QuickBooksUpTo2007-SingleInvoices.mev or 

QuickBooksUpTo2007-GroupedByDayInvoices.mev views) 

Field Description Default Value  

SPL-ACCNT1 Income Account to attribute sales from  Sales 

 

Fields used for QuickBooks versions 2008 onwards (using the imported QuickBooks2008-SingleInvoices.mev, 

QuickBooks2008-GroupedByDayInvoices.mev or QuickBooks2008-CustomerInvoices.mev views). Fields in red 

are not required for the QuickBooks2008-CustomerInvoices.mev view. 

Field Description Default Value  

SPL-ACCNT1 Income Account to attribute sales from  Sales 

SPL-ACCNT2 VAT Liability account VAT Liability 

TRNS-ACCNT Account used to process all income from sales Accounts Receivable 

TRNS-NAME Customer used to allocate all sales to InternetOrders 

SPL-NAME2 VAT Supplier (who is setup as the VAT Agency) HMRC VAT 

INVITEM1 Item all sales are for Goods 

 
If you need to change any of the values (or add in your own rules or macros) you should customize the current view and change 
the default values assigned to the Fields shown above  

5 select the File->Utilities->Import->IIF Files Import menu option. 
 
6 Select the C:\Quickbooks.iif file. 
 
7 The should then be imported  
 
 
Additional Information  
 
If you are using Quickbooks 2008 or later and have upgraded your Company file(s) from a previous version of Quickbooks (e.g. 
2004) you may not be able to import the VAT into your existing account. New QuickBooks company accounts should not have 
this problem. If you get an error "cannot associate an item with VAT liability" you should allocate the VAT to a different (new) 
VAT Liability account. You should then consult your accountant to see if it is better to move all VAT transactions over to use this 
new VAT Liability account (change the value of the SPL-ACCNT2 Field) or create a General Ledger entry to move the VAT 
between the old VAT account and new VAT account. This will enable the VAT 100 (return) to show the correct figures.  
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Sage  
 
All versions of Sage are supported except Startup. 
 
All invoices are imported as a single customer (Sales) for a single product (Goods). The total invoice cost and VAT is split into 
the relevant accounts. 
 
The following instructions explain how to set this up. 
 
1 If the Sage view isn't available you can Import the view from the installation directory (e.g. C:\OSOP\Main). 

 
There are 2 choices of views to import: 

Sage.mev Where all orders are imported as individual invoices  

Sage-GroupedByDayInvoices.mev Where each day's orders are imported as a single invoice.  
 
The grouped invoices are useful if you have a lot of orders (e.g. from Ebay). They are imported into Sage as a single invoice 
with the day's total order values (and VAT). Each invoice will have a unique sequential order number. As the views are 
configurable you can group the orders by any field.  
 

2 Click on the Export Orders button ( ) and select Sage.  
 
This will create an CSV file in the root of drive C. If required, you can change the name by selecting the Sage View and selecting 

the View->Change Export Options menu option or click on the button to the right of the View selection field 

( ). 

3 Start Sage. 
 
4 Below is a description of where the order information is imported into. You either need to make sure that the accounts (and 
items) exist in Sage or amend the default values, shown below, to match your setup.  

Field Description Default Value  

Account Reference The customer account who the order is assigned to  WEB 
Details The income account the sales are assign to  Internet Sales 

 

If you need to change any of the values (or add in your own rules or macros) you should customize the current view and change 
the default values assigned to the Fields shown above.  

5 select the File->Import menu option. 
 
6 Select Audit Trail Transactions and click on Run. 
 
7 Select the C:\Sage.csv file. 

 
8 The orders should then be imported. 
 

 



www.1stoporders.co.uk                                                    One Stop Order Processing   

Page 107 of 180 DocVer 1.20                                 Copyright Mole End Ltd 2002 - 2012 

Printing a Proof of Posting Sheet 
  
If you are using taking letters and parcels to the Post Office (or have a collection) you can print out a report that can be signed 
by a Royal Mail member of staff to confirm that the items have been posted. To do this following the following procedure: 
 
1 Select the PO Proof of Posting View.  
 
2 Select the orders that are being posted. 
 
3 Select the Print->Print Order View menu option.  
 
4 When printing you may have to select A4 Landscape to fit the details onto a single sheet. You can also adjust the column 
widths on the screen before printing. 
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Royal Mail Despatch Manager Online (DMO) 
  
This guide will explain how to setup One Stop Order Processing and Royal Mail Despatch Manager Online (DMO). You will 
need to signup to Royal Mail's service. More information at:  
 
http://dmo.royalmail.com. 

 
1 Make sure the RoyalMail DMO (Despatch Manager Online) is installed. If it is go to item 2.  
 
If the view isn't available you should import the view. It is installed into the installation folder (by default 
C:\OSOP\Main\RoyalMailDespatchManager.mev). You can import the view by clicking on the Customize Current View 

button ( ). To import the new view click on the Import button in the displayed window, shown below: 
 

 
 
2 Tick the orders to export (using filters based on any fields shown, for example, unshipped orders). 
 

3 Click on the Export Orders button ( ) and select the RoyalMail DMO (Despatch Manager Online) to create the CSV file to 
import into Royal Mail Despatch Manager Online (DMO). 
 
 
4 This will create a CSV in C:\ called DMO.csv. If required, you can change the name by selecting the RoyalMail DMO 

(Despatch Manager Online) view and selecting the View->Change Export Options menu option or click on the button to the right 

of the View selection field ( ). You can enter the correct output filename in the File to export to 
field. You can also add a comment to the order to show that this order has already been exported (and if required use this text 
as a filter to see which orders have not been exported to Royal Mail Despatch Manager Online (DMO).  
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Setting up Royal Mail Despatch Online (DMO) 
 
1 Go to the Royal Mail Despatch Manager Online website at 
 
https://www.rmdmo.co.uk/login.epl 

 
and login using details provided by Royal Mail.  
 

 
 
 
 
2 Under the Shipping Services menu option select Import Shipments, shown below: 
 

 
 
 
3 If the 1StopOrders format is available go to item 10. If not follow the next steps to set the 1StopOrders format. On the Import 
Shipments screen select the New button, shown below:  
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4 Select the import format as Delimiter-separated values and click on Next, shown below:  
 

 
 
 
5 In the Separated Values File Specification make sure the Separator is set to a comma (,) and Delimiter of a double quote ("). 
 
You then need to click on the fields to use in the exact order that will appear in the file. If you click on the fields in the Field area 
in the order shown below: 
 
Service Reference 

Service 

Recipient Contact Name 

Recipient 

Recipient Address line 1 

Recipient Address line 2 

Recipient Address line 3 

Recipient Post Town 

Recipient Postcode 

Recipient Country Code 

Reference # 

Items 

Weight (kgs) 

Safe Place 

Signature 

Service Enhancement 

Service Format 

Service Class 

 
This will product the following in the Representation of File Layout area: 
 
"Service Reference","Service","Recipient Contact Name","Recipient","Recipient Address line 

1","Recipient Address line 2", 

"Recipient Address line 3","Recipient Post Town","Recipient Postcode","Recipient Country 

Code","Reference #","Items", 

"Weight (kgs)","Safe Place","Signature","Service Enhancement","Service Format","Service Class" 
 
This is shown below. When the information looks correct click on Next.  
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6 Ignore the Date Format as this field is not used. Change the Weight Format to the same format that you use for your product 
weights. For example, if you use kilogrammes select the 12.00 kg option. Click on Next. This is shown below:  

 

 
7 You can now setup the mappings to your Royal Mail Services. You can use the exact text that they use (or their default 
mappings). The mappings provided in the guide have been used to make it easier to use Macros in One Stop Order Processing 
where different service enhancements and services are needed for different orders. 
 
To add the different mappings 
 
a Click on Service, Service Reference, Service Class, Service Enhancement or Service Format on the left hand side of the 
window 
 
b For each mapping table add each of the mappings shown below (if available). To add a mapping type in the code in the Your 
code box and select the value in the Transform to box and click on Add. 
 
Each of the mappings for the relevant fields is shown below in a table with how the windows should look after adding the 
mappings. If you make a mistake you can click on the Remove button and reenter the mapping (or click on an item to amend it).  
 
Country Code 
 
The country codes do not need to be mapped as One Stop Order Processing produces the correct codes. 
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Service 

Your Code Map To 

1STACCOUNT  First Class + 1ST AND 2ND CLASS ACCOUNT MAIL 

1STDAILY First Class + PACKETPOST DAILY RATE  

2NDACCOUNT Second Class + 1ST AND 2ND CLASS ACCOUNT MAIL 

2NDDAILY  Second Class + PACKETPOST DAILY RATE  

SPECIAL  Special Delivery + SPECIAL DEL 1PM £500 COMP 

 

 
 

 
 
Service Reference 

Your Code Map To 

Ref1  Service Reference 1 

Ref2 Service Reference 2 
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Service Class 

Your Code Map To 

1  First Class (1) 

2 Second Class (2) 

D Special Delivery (D) 

 

 

Service Enhancement 

Your Code Map To 

1  Consequential Loss £1000 (1) 

2 Consequential Loss £2500 (2) 

3 Consequential Loss £5000 (3) 

4 Consequential Loss £7500 (4) 

5 Consequential Loss £10000 (5) 

EML EMAIL (EML) 

REC Recorded (REC) 

SMS SMS (SMS) 

SNE Email & SMS (SNE) 
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Service Format 

Your Code Map To 

F Inland Large Letter (F) 

L Inland Letter (L) 

M Inland Auto Large Letter (M) 

N Inland Format Not Applicable (N) 

P Inland Packet (P) 

 

 
 
 
8 When the mappings have been added click on the Next button. 
 
 



www.1stoporders.co.uk                                                    One Stop Order Processing   

Page 115 of 180 DocVer 1.20                                 Copyright Mole End Ltd 2002 - 2012 

9 The following definition is shown below. In the Layout Name enter the name for the layout, 1StopOrders and click on Save.  
 
This is shown below: 
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10 To import the delivery details for the orders: 
 
1. Select a file format 
Select the 1StopOrders format 
 
2. Select file to import 
Type in C:\DMO.csv 
 
3. Import File 
Tick Use the postcodes in the batch file to determine the post town. 
 
Click on the Import button. 
 
This is shown below.  
 

 
 
 
Setting up different delivery options in One Stop Order Processing  
 
By default the view has options for 

Service Reference  REF1 

Service 1STDAILY 

Service Format You will need to select P (Packet), L (Large Letter), 

M (Auto Large Letter) 

 
Using the same value for all shipments 

1 Amend the view (click on the Customize current view button ( )). 
2 Select the field to change Selected: box on the right hand side. 
3 Click on the Amend field details button. 
4 In the Amend field details window type the required value in the Default field value box and click on OK. 
 
 
Using different values for shipments 
 
You can amend on an individual order by amending the order and changing the value on the Custom Values tab.  
 
If you want to automate this process you can use the following approach: 
 

1 Amend the view (click on the Customize current view button ( )). 
2 Select the field to change Selected: box on the right hand side. 
3 Click on the Amend field details button. 
4 In the Amend field details window type the required macro in the Default field value box. 
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Example macro to use: 
 
To use fields in the macros they must be added to the view. For example, you may want to check the total postage paid. To 
check this add this to the view. This can then be checked in a macro.  
 
Use 1st Class post for orders that have paid £3.50 or more for shipping  
 
[%Total P&P%][<]3.5[1STACCOUNT][2NDACCOUNT] 
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Metapack 
 
For more information in Metapack go to www.metapack.co.uk 
 
1 If you already setup the Metapack view go to step 8. 

If you don't have the Metapack view available (in the list of Views) click on Customize Current View button ( ). 
 
2 Click on the Import button. 
 
3 Select the MetaPack.mev file. By default, this will be installed into C:\OSOP\Main\MetaPack.mev. 

4 Click on the Import View button. 
 
5 In the Sender Code you should enter your Metapack senders code (given to you when you sign up). 

6 The view has now been setup. You will only need to do this once. 

7 The Total Weight is calculated using your product inventory. You can manually setup your product inventory, import from a 
CSV file or automatically create products when orders are imported. If required you can add or adjust each products weight.  
 
8 Select (tick) the orders to export. 

9 Click on the Export Orders button ( ) and select MetaPack.  

10 This will export the orders to C:\MetaPackData.csv. You can change the filename by selecting the View->Change Export 

Options menu option or click on the button to the right of the View selection field ( ).  

11 You may want to tick the Add comment to order memo when exported field (in the Export order details dialog) to keep track 
which orders have been dispatched. For example, you can add a value of EXPORTED in the field and then use a filter to only 
show orders that don't have the word EXPORTED. 
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Order Tracking 
This feature is available in Standard, Premium and Enterprise versions of One Stop Order Processing 
 
Once order tracking has been setup (see the Track Online options for more information) you can select any of your orders and 
upload their tracking information to your website. Customers can be sent an email which will automatically include a link to their 
order tracking information (on your website) and/or they can use an order tracking box on your website, where they type in their 
order number. You can then update (and upload) their tracking details to notify your customers of the order process. 

You can change the information to display in the online tracking form. You can include details about the order and include up to 
50 additional custom values specific to your business. This can include fields for you to add in comments or batch numbers or 
courier tracking, who packed by etc.. You can also configure the tracking options. 
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Additional order handling 
If you right click (with the mouse) while on an order an additional menu is displayed. This provides the following features: 

Auto totaling 
If the field contains a numeric value (e.g. order total) all of the currently displayed orders’ values will be added up and displayed. 
If there are any checked (ticked) orders these are also added up. This can be useful if you want to find the total of certain order 
values from all of those displayed. 

Copying information to the clipboard 
If you want to easily export information to another application (e.g. Microsoft Word) you can right click (on the mouse) on an 
order and either copy the current item or the entire line to the clipboard. This can then be pasted into any other application. 
NOTE: This option is only available if a single order has been selected 

Checking and Unchecking selected orders 
If you select more than 1 order you can choose to check or uncheck all of the selected orders. 
 
Assigning colours to orders 
You can assign one of the defined colours to the selected orders. This colour can be used for filtering the orders. 

 
 



www.1stoporders.co.uk                                                    One Stop Order Processing   

Page 121 of 180 DocVer 1.20                                 Copyright Mole End Ltd 2002 - 2012 

Logged on Users 
You can see which other computers (users) are current using One Stop Order Processing. You can also send messages to 
them when any order issues arise. To do this click the Logged on Users button. 
  

 

 

The current number of users logged onto the main computer is shown. If you want to see which computers are logged select the 
Tools->Logged on Users menu option. You can also send a message to any other user currently logged onto the same PC. This 
can be used to pass on information to someone who has an order locked that you need to work on. 
 
If there are problems with your license being used by another PC on the network you can clear the existing information by 
clicking on the Reset Logged on Users button.  
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Printing order details as a customised report 
If you want to print the current orders as they are shown select the Print Order View menu option (under File->Print menu 
option). If you have specific orders selected you will be prompted to see if you only want those orders printed or all the orders 
matching the current filter.  

When you print the current orders, the current column widths and columns selected are used to print the report. If you want a 
report to contain certain information you should add that column to the current view (or create a specific view to print the order 
details). 

If the orders printed are too large to fit onto a single page they are split over more than 1 page. When the report is printed the 
page number and its location in the report is printed on each page. For example, if a report is too wide for a single page and fits 
onto 2 pages and there are 2 pages of orders, the page details are printed as: 

. Page 1 (Row 1 Column 1) 

. Page 2 (Row 1 Column 2) 

. Page 3 (Row 2 Column 1) 

. Page 4 (Row 2 Column 2) 

Using this information you can assemble the report as a single page. 

When you print a report of the current orders any fields that contain numbers or prices will be automatically added up and a total 
printed at the end of the report. You can configure which columns are totaled by amending their details in the Customise View 

dialog (press the Customize view button ( ). 
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Processing orders 
For each selected order you can print, preview, email the Invoice, Packing List or Purchase Order. All the selected orders can 
also be marked as shipped, have their addresses formatted or the order tracking details published to a website for order 
tracking. If you want to individually ship each item for an order (for example, if an order has 3 items and you only want to ship 
one of them), tick the 'Only include ticked order lines' option on the Display options. If you are using this approach the order will 
only be marked as shipped, and be given a shipping date when all the order lines are shipped.  

You can communicate with your customers by sending them emails to tell them what stage their order is at. Several default 
templates are supplied. You can amend these or create your own. Emails can be sent as HTML or plain text. 

NOTE: HTML emails can not be sent if you are using a MAPI client (e.g. Outlook). You should use an SMTP server for this. See 
the Setup Email for more information on how to do this. 
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Options 

To show the options select the Options menu choice (under the Tools menu) or by clicking on the Options button (  ). The 
information that can be configured from the options is described in this section.  

Order Display Options 
 

You can choose how to display orders. 
 
Display all orders 
All orders, including deleted orders are displayed. 

Don't Displayed Deleted Orders 
Only display live, not deleted orders. This is useful if you want to process orders and once complete you delete them. Once 
deleted they aren't shown. 

Only Display Deleted Orders 
This can be useful if you want to archive (move) deleted orders into another site.  
 
By default, deleted orders are not displayed.  

Show Refunds 
If you want to show refunded orders tick this box. When refunds are shown they can be used to show correct sales (or VAT) 
figures. 
 
By default, refunded orders are displayed.  
 
Automatically refresh orders when an order has changed 
If you want to redisplay all the orders whenever any changes have been made tick Automatically refresh orders when an order 
has changed. You should un-tick this option if you have a large number of orders and want a faster screen update. 
 
Font 
You can choose the font and size to use when displaying the order, customer and product details.  
 
Clicking on order line ticks order 
To process orders you need to select (tick) all of the orders. You can do this by clicking the box on the left of the order. You can 
tick the Clicking on order line ticks order option to automatically tick the order when you click anywhere on the order's line. 
 
Show order lines on packing or picking list with a shipped quantity of zero (0) 
If you want to produce packing lists only for items untick this box. If it is ticked (by default) all items on the order will be shown.  
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Only include ticked order lines 
If you only want to print a packing list for certain products tick this option. This can be used to mask certain items ordered. If you 
want to individually ship each item for an order (for example, if an order has 3 items and you only want to ship one of them), tick 
this option. If you are using this approach the order will only be marked as shipped, and be given a shipping date when all the 
order lines are shipped. 
 
Order selection colour 
If you want to change the colour of the hilighted line click on the colour button and select the required colour. You should choose 
a dark colour as the text is shown in white.  
 
Clicking on columns uses cases insensitive sorting 
When you sort items, by default, uppercase and lowercase words will be sorted differently. If you want all words to be sorted 
and the case of the words ignored tick this option. 
 
Only show first n orders 
You can limit the number of orders shown. This will show the first n orders. By default, if ticked,  it will show the top 1000 orders. 
When you click on a column heading it sorts the order information by that field. If you have limited the number of orders shown 
the orders will be retrieved again. This may mean that the order previously selected orders won’t be available. 
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Other Options 
 

 

 

Orders 
 
Update stock levels when orders are deleted 
If you are using Stock Control and want to return any items to those available when an order is deleted tick this option. If you 
then undelete the deleted order the stock will be removed again. 

Only update stock when order is paid 
If you only want to adjust the stock levels when orders are paid tick this option. When you mark the orders as paid it will then 
adjust the stock. 
 
NOTE: If you tick this option and you are using automatic stock levels you should select the Products->Stock->Recalculate 
Stock Reorder Levels. You will also need to manually select the Out of Stock Report.  
 
Automatically purge orders when deleted 
When you delete orders they are not removed (by default). They are not shown and are not included in operations. However, 
the orders can be undeleted. If you want to always remove orders whenever they are deleted tick this option.  
 

Products 
 
Automatically purge orders when deleted 
When you delete products they are not removed (by default). They are not shown and are not included in operations. However, 
the products can be undeleted. If you want to always remove products whenever they are deleted tick this option.  
 
Calculate stock reordering to nearest Pack Reorder Size 
When you let One Stop Order Processing automatically calculate the stock reorder levels tick this box if want this value to be to 
the nearest Pack Reorder Size (setup on the Product's Stock tab). If you want this calculation to show the exact amount to 
reorder untick this option. When you produce the stock reorder report this will always show the amount to reorder to the nearest 
pack size.  
 
Sharing Stock Over Multiple Products (that have the same SKU) 
When you want to use different SKUs for products and want to share the stock over the different SKUs you need to define 
multiple products that all have the same main SKU but different Order Type SKUs. You need to assign a single product to 
manage the stock. You identify this product by either using the first product created or by ticking the Use Stock Control option on 
one of the products.  
 
 

Customers 
 
Create same customer accounts for all customer names at same address  
When orders are created an account for that customer is created. By default, all customers (names and company names) at the 
same address are grouped together. If you want to have a separate account for all customer and companies even at the same 
address untick this option.  
 
When finding orders untick all current order 
When you look for orders using the Find button (or F3) by default it leaves all the other orders currently ticked. Also when an 
order is found it ticks that order. If you only want the order that you are looking for ticked tick this option. 
 
NOTE: You can also use F4 to search for orders. This will always look for orders from the first order listed rather than the last 
order found. 
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Use Retail Invoice, Packing Slips and Purchase Orders (show tax inclusive values) 
By default, prices don't show the VAT in the item prices. If you want to show the tax included in the items tick this option. This is 
mainly for Retail invoices.  
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Invoice, Packing List and Purchase Order Options 
 
Purchase Orders are available in Standard, Premium and Enterprise versions of One Stop Order Processing 
 

 

There are certain options related to each report type (Invoice, Packing List and Purchase order). These are: 
 
Printer to send requests to: 
Select a printer to use. You can print the Invoice and Packing List on different printers. The Invoice and Packing List are printed 
using Internet Explorer. If you tick Auto close print dialog you can print by using a single click.  
 
You can also print orders in batches. If you are printing a lot of orders you may want to send them to the printer in groups, of say 
10 orders. For some printers they work in a slightly better way if they receive information in smaller batches. To use this feature 
tick the box, Output to printer every option. You can then type in the number of pages to print each time. 
 
Print page configuration 
After you select the type of stationery to use you can use the default template or change it by using the Change page layout 
button.  

Standard layout A normal sheet of A4 

Document enclosed wallets After printing fold the paper 3 times to get the address in the correct location to place into a 
document wallet 

Integrated labels Print onto an A4 sheet with a single peel off label to place onto the package (paper available from 
www.integratedlabels.co.uk) 

Other Additional invoices and packing lists are supplied. These contain special features, for example, 
printing 2 orders per packing list. 
 
The definitions of these additional files are stored in the IL_1StopTemplates.ini files. You can add 
your own formats, packing lists and invoices by using this file. 

 
If you want to use less ink on the printed Invoice, Packing Lists or Purchase Order tick Ink/Toner Saver mode. This removes 
some of the solid black and colour areas in the Invoices and Packing Lists. 
 
You can also have products on orders hilighted if more than 1 has been ordered. By default it displays the order quantity in 
larger text in red. You can click on the ... button to change the html used if required. 
 
NOTE: If you are using Purchase Orders and want to use supplier information you should tick Use Supplier details (and select 
the supplier number to use for each order). 

Printing configuration values 
The invoice and packing list are designed for a standard printer. If you have any problems with the page text printing too large 
increase the Page width value. If you have alignment problems with labels adjust the Page message height and Page header 
height. 
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Other printing tips 
 
The printing is done using Microsoft Internet Explorer. You can configure Microsoft Internet Explorer in the following ways to 
improve the print layout. 
 
You can remove the text displayed at the top and bottom of the invoice and packing list by removing the text in the Headers and 
Footers options in the Page Setup page (under the File menu). 
 

 
 
If the images and shaded areas are not shown when printed you should make sure that the Print background colors and images 
is turned on (ticked). The Printing options are in the Advanced tab in the Internet Options (under the Tools menu). 
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Advanced options 
 
When amending the existing Invoice and Packing List layouts you can use the macros, defined in the Macros to use in Emails, 
Printing and Order Tracking section. 

Printing more than 1 order details on a single page 
You can put up to 64 orders onto the same sheet of paper. This can be used for sheets of labels or more efficient packing lists 
or reports. 
 
To use this feature you must be the macro #NX#n# somewhere on the page. Where n is the number of orders to put onto this 

page. For example, #NX#8# will put 8 orders on a single page. 

 
If you are using HTML layers you must put the macro #PT# at the end of the page. This will stop more than 1 page being printed 

onto the same page. The supplied Avery labels use this technique. 
 
When you have put one (or both) of these macros on the page you can use the following macros with the order number required 
to print onto the page. This will make sure that different orders are displayed on the same page. 
 
 For example to display the customers name use [%INV_CUST_NAME#1#%], [%INV_CUST_NAME#2#%], 

[%INV_CUST_NAME#3#%] etc.. 

 
[%INV_ADD#n#%] 

[%DEL_ADD#n#%] 

[%ORD_NUM#n#%] 

[%ORD_DATE#n#%] 

[%INV_CUST_NAME#n#%] 

[%INV_COMPANY#n#%] 

[%DEL_CUST_NAME#n#%] 

[%DEL_COMPANY#n#%] 

[%INV_CUST_NAME#n#%] 

[%INV_COMPANY#n#%] 

[%INV_TEL_NUM#n#%] 

[%INV_FAX_NUM#n#%] 

[%INV_EMAIL#n#%] 

[%INV_ADD_LINE1#n#%] 

[%INV_ADD_LINE2#n#%] 

[%INV_ADD_LINE3#n#%] 

[%INV_ADD_LINE4#n#%] 

[%INV_COUNTY#n#%] 

[%INV_POSTCODE#n#%] 

[%INV_COUNTRY#n#%] 

[%INV_BUYER_ID#n#%] 

[%DEL_CUST_NAME#n#%] 

[%DEL_COMPANY#n#%] 

[%DEL_TEL_NUM#n#%] 

[%DEL_FAX_NUM#n#%] 

[%DEL_EMAIL#n#%] 

[%DEL_ADD_LINE1#n#%] 

[%DEL_ADD_LINE2#n#%] 

[%DEL_ADD_LINE3#n#%] 

[%DEL_ADD_LINE4#n#%] 

[%DEL_COUNTY#n#%] 

[%DEL_POSTCODE#n#%] 

[%DEL_COUNTRY#n#%] 

[%DEL_BUYER_ID#n#%] 

[%SALES_SOURCE#n#%] 

[%ORD_NUM#n#%] 

[%ORD_TRANS_ID#n#%] 

[%ORDER_ID#n#%] 

[%INVOICE_NUM#n#%] 

[%CHECKOUT_DATE#n#%] 

[%ORD_DATE#n#%] 

[%INV_DATE#n#%] 

[%PAY_DATE#n#%] 

[%DISPATCH_DATE#n#%] 

[%LISTED_ON#n#%] 
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[%PAYMENT_METHOD#n#%] 

[%POSTAL_SERVICE#n#%] 

[%PAYPAL_ID#n#%] 

[%VAT_NUMBER#n#%] 

[%CURRENCY#n#%] 

[%PO_NUMBER#n#%] 

[%TOTAL_WEIGHT#n#%] 

[%DELIVERY_INSTRUCTIONS#n#%] 

[%FEEDBACK_LEFT#n#%] 

[%FEEDBACK_RECEIVED#n#%] 

[%NOTES#n#%] 

[%ORD_SUB_TOTAL#n#%] 

[%ORD_SUB_TOTAL_TAX#n#%] 

[%ORD_PNP#n#%] 

[%ORD_PNP_TAX#n#%] 

[%ORD_INSURANCE#n#%] 

[%ORD_INSURANCE_TAX#n#%] 

[%ORD_TOTAL_TAX#n#%] 

[%ORD_GRAND_TOTAL#n#%] 

For order lines you use the order line followed by the order number. For example, the first line (item) of an order for order 3 

would be [%ITEM_ID1#3#%]. An example of this is used in the PackingListIntLab2Orders.html packing list (2 

orders per packing list using 2 labels). 

[%ITEM_IDN#n#%] 

[%ITEM_TITLEN#n#%] 

[%ITEM_SKUN#n#%] 

[%ITEM_QTYN#n#%] 

[%ITEM_PRICEN#n#%] 

[%ITEM_VAT_RATEN#n#%] 

[%ITEM_TAXN#n#%] 

[%ITEM_TOTALN#n#%] 

[%ITEM_WEIGHTN#n#%] 

[%ITEM_SHIPPED_QTYN#n#%] 

[%ITEM_PRICEN#n#%] 
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Printing Fields Options 
 
When you print invoices, packing lists or purchase orders you can pickup the standard order information using the macros 
defined in the Macros to use in Emails, Printing and Order Tracking section 
 
In addition to these macros you can define others. These are replaced with the values just before printing. A macro can contain 
company information defined in the Company Details options. You can also display different values for different field values. 
This can be used to display a different PPI (1st or 2nd class) based upon the shipping choice. This is explained at the end of 
this section. 

Several default Macros are defined. These provide information to be put into the default invoice and packing list templates. You 
can also change the order that macros are processed. This allows you to change the values based upon certain criteria. For 
example, you may want to show a certain image if the Listed On is Ebay, but if the address is in France change the image to 
something else. 

 
 
 
Including Country on address details 
When you use an address macro ([%INV_ADD%], [%DEL_ADD%] or [%%SUPPLIER_ADDn-n%%] you can choose to include 
the country name for the UK. Use either the Always include, Do not include or Only include if not UK option.  
 
Width of Addresses 
When either the ([%INV_ADD%], [%DEL_ADD%] or [%%SUPPLIER_ADDn-n%%] macros are used you can set the maximum 
width of a line in the address. If the address line is greater than the width given it is moved onto the next line of the address.  

You can edit or delete the existing macros. You can also add your own macros. If you add or edit a macro you are shown the 
following screen. 

 
 
 



www.1stoporders.co.uk                                                    One Stop Order Processing   

Page 133 of 180 DocVer 1.20                                 Copyright Mole End Ltd 2002 - 2012 

Macro to use: 
The text that appears in the Invoice or Packing List. If this appears the Value is replaced. You can enter your own macro names 
if required (you will need to add the values to the Invoices etc.).. 
 
NOTE: These macros can also be used in Emails and Online Tracking. 
 
If you are using the Macro [%LABEL_PPI%] you can create a PPI image by clicking on the Create PPI button.  

 

 
 
Select 1st or 2nd class and type in the code given to you by the RoyalMail. When you click on Create PPI the image will be 
created anda asigned to the Macro. 
 
Description: 
The description of the macro. Default macros are created. You can also add your own. Use text that is meaningful to the person 
entering values. 
 
Value: 
The value that will be used when replacing the Macro. This can be text or a text, html or image file. 
 
Text 
The Macro is replaced by the text. 
 
NOTE: The Value can contain other Macros. For example, Ebay Info:[%FEEDBACK_LEFT%], [%FEEDBACK_RECEIVED%].  

 
Local Filename 
If the filename is an image file the file is displayed. If the file ends with .txt, .html or .htm the file is copied into the Invoice or 
Packing List. This can be useful for standard information, for example, your terms and conditions. 

When you are using images from files and are using a networked version of One Stop Order Processing you should make sure 
that the files are available on your network. A good way to do this is to put your files into your C:\OSOP\Main directory (folder) 

and reference the files using the network path. An example of how to do this is described below: 

1 Install the software into the default location on the main PC, C:\OSOP. In this example the main PC is 

called SERVER. Replace the name SERVER with your main PC's name. 

2 Share the main directory C:\OSOP as OSOP (see Change Site for more details on how to do this) 

3 Put all of your images to use in invoices etc. into C:\OSOP\Main (e.g. put logo.jpg into 

C:\OSOP\Main). 

4 When using any files as Macros (e.g. logo.jpg) use \\SERVER\OSOP\Main\logo.jpg. 

 
Internet Filename (weblink) 
This is an image on a website (.gif, .jpg, .jpeg, .png). For example, your company logo. It is a good idea to use an image from a 
website if you are using this for sending emails as the image will not be attached to an email, but a website link will be 
displayed. 

Only use this Macro if: 
If you only want to use this macro value under certain conditions you can use this option. You can test a particular value of the 
order being printed. You can also use other conditions (e.g. Grand Total is more than a certain amount, or country is not France) 
you can also use <, >, =, # before the value to check. These meanings are described below. 

> 
Use this macro if the value is greater than (or equal to) that given. For example, >12.52 means include these details if the 
value is greater than or equal to £12.52 (the currency is not needed). 

< 
Use this macro if the value is less than (or equal to) that specified. For example, <1 means only display the text (or image) for 
values of 1 or less. 

= Use this macro for exact values. For example, =100 means only display for values of 100. 

# 
Use this macro when you want to include the text or image for values that are not equal to that given. For example, #5 means 
show the text or image for all values except 5. #France means is not France. 

 
NOTE: If you do not specify a condition (=,#,< or >) equals (=) is used. 
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You can use single values, listed below or 2 conditions at once (i.e. AND). The conditions listed below with an AND should have 
the 2 values to be checked together separated by an AND. 
 
For example, if you wanted to use a certain PPI for the UK and 1st Class you would select Postal Service AND Delivery 

Country and have a value of First Class AND United Kingdom. 

 
NOTE: Rather than using AND you can also use &&, + or || to separate the 2 values. 

 
The values to check are: 
 
Postal Service 

Delivery Country 

Invoice Country 

Payment Method 

Shipping Instructions 

Postal Service AND Delivery Country 

Postal Service AND Listed On  

Invoice Name 

Invoice Company 

Invoice Telephone No. 

Invoice Fax 

Invoice Email 

Invoice Address Line1 

Invoice Address Line2 

Invoice Address Line3 

Invoice Address Line4 

Invoice County 

Invoice Postcode 

Invoice Buyer ID 

Delivery Name 

Delivery Company 

Delivery Telephone No. 

Delivery Fax 

Delivery Email 

Delivery Address Line1 

Delivery Address Line2 

Delivery Address Line3 

Delivery Address Line4 

Delivery County 

Delivery PostCode 

Delivery Buyer ID 

Sales Source 

Sales Num 

SubTotal 

Total Tax 

Total PnP 

Total PnP Tax 

Insurance 

Insurance Tax 

All Total Tax 

Grand Total 

Order Date 

Checkout Date 

Payment Date 

Dispatch Date 

Invoice Date 

Invoice Number 

Feedback Left 

Feedback Received 

Notes 

Listed On 

Transaction ID 

Order ID 

Currency 

VAT Number 

Paypal ID 

Purchase OrderNum 

Weight 

Custom Value 1 

Custom Value 2 

Custom Value 3 

Custom Value 4 

Custom Value 5 
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Custom Value 6 

Custom Value 7 

Custom Value 8 

Custom Value 9 

Custom Value 10 

Custom Value 11 

Custom Value 12 

Custom Value 13 

Custom Value 14 

Custom Value 15 

Custom Value 16 

Custom Value 17 

Custom Value 18 

Custom Value 19 

Custom Value 20 

Custom Value 21 

Custom Value 22 

Custom Value 23 

Custom Value 24 

Custom Value 25 

Custom Value 26 

Custom Value 27 

Custom Value 28 

Custom Value 29 

Custom Value 30 

Custom Value 31 

Custom Value 32 

Custom Value 33 

Custom Value 34 

Custom Value 35 

Custom Value 36 

Custom Value 37 

Custom Value 38 

Custom Value 39 

Custom Value 40 

Custom Value 41 

Custom Value 42 

Custom Value 43 

Custom Value 44 

Custom Value 45 

Custom Value 46 

Custom Value 47 

Custom Value 48 

Custom Value 49 

Custom Value 50  

If you wish to use your own order processing procedures you can use the custom order values 

 
Example 1, how to use a different PPI for orders. 
If you define the 3 following macros, you can display a different PPI for 1st Class, 2nd Class and nothing for international orders. 

Macro Name Value Only use this Macro if... equals 

[%LABEL_PPI%] RoyalMail1stPPI.jpg Postal Service 1st Class 

[%LABEL_PPI%] RoyalMail2ndPPI.jpg Postal Service 2nd Class 

[%LABEL_PPI%]       

 
Example 2, how to display additional text on the packing list or invoice for certain orders 
If you define the following macro, you can display a Please send Special Delivery (in bold) on the packing list for orders that 
have a value more than £10. You will also need to add the text [%EXTRA_SHIPPING_TEXT%] to the Packing List (or Invoice). 

Macro Name Value Only use this Macro if... equals 

[%EXTRA_SHIPPING_TEXT%] <B>Please send Special Delivery</B> Grand Total >10 

 
 
Default new printing field details to last printing field details 
If you are creating a Printing Fields with slightly different details you can tick this option to default all values from the last Printing 
Fields amended.  
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Emailing Customers Options 
 
 

You can send information to your customers based upon the selected orders. There are several templates supplied with One 
Stop Order Processing. These can inform your customers that the order has been received, payment has been received, order 
has been shipped and order has been delayed. These can be amended or new ones created.  
 

 

Email Templates 
When each template is selected the email text is shown in the Email Text area. It can be amended by pressing the Edit button. 
You can delete a template by pressing the Delete button. To create a new blank template press the New button. 

To configure how the email will be sent click on the Setup Email button. For more information refer to the Setup Email section. 

Once you are happy with your template you can send a test email to a specific email address. This would normally be your 
email address. The order details are filled in with example data.  

By default, you are asked before every email is sent. If you want to turn this feature off you should un-tick Ask before sending 
every email.  

NOTE: You should make sure that you have selected the right customers and correct template before sending any 
email. If you are unsure tick Ask before sending every email. 

Sending emails in batches 
If you have any problems with your email server (or ISP) when you send a large number of emails at once, you can limit the 
amount of emails sent at once. Tick the Send emails in batches option and select the number of emails to send at once and how 
long to wait between sending that number of emails. Normally a 5 second delay is sufficient to resolve any sending issues. 

Creating and Amending Customer Email Templates 
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Name 
The template name is your own name that is used to identify the template to use to send emails. This name is not sent as part of 
the email. 

Subject 
The subject that is displayed in the email. You can use order specific information by using certain words. These are explained in 
the Message section (below). 

NOTE: If you want to edit the email subject before sending put the text [%EDIT%] at the start of the email subject. When you 

send an email you are then shown the email subject and can make any changes required. For example, to allow the subject 
entitled Order [%ORD_NUM%] has been shipped to be edited before sending change the title to be [%EDIT%]Order 

[%ORD_NUM%] has been shipped. 

Who to send email to 
When you send a customer email you can choose who to send it to: 

Send to customer email address 
The customer invoice address from the order is used. 

Prompt for email address 
A dialog is displayed before the email is sent prompting you for an email address. 

Use CC email address 
The email address entered into the CC field is used. 

Send to Product supplier's email address 
If you are using suppliers and want each supplier to receive an email for the product's that they sell (to despatch to your 
customer) use this option. You will need to use the relevant macros for suppliers (described in the Macros section further down). 
You can also use the Suppliers template.  

CC 
You can also send the email to a 3rd party. This can be used to notify other areas of your company of the order. If you want to 
send the email to more than 1 email address you can separate the emails with a semi-colon (;). For example, 
WareHouse@Email.com; Accounts@Email.com.  

Message 
The message to send in the email. When you enter a new name to store the email text (in the Store message as control) and 
press the Change button you are asked if you want a default HTML or plain text email. This is created with all available order 
specific words available. The ones not required can be removed. These are described below. When you amend your email text 
you can choose the editor to use. Notepad is generally satisfactory for plain text emails. If you are creating html emails you can 
use your desired editor (e.g. Dreamweaver or Microsoft Word). 

When the email is sent they are replaced with the information specific to the order. If you want to send more detailed information 
to the customer you can attach their Invoice or Packing List. 
 
The macros that can be used are shown in the Macros to use in Emails, Printing and Order Tracking section.  
 
Attachments 
You can also attach other information to the email. These can be sent as they are or in a zip file. You can either select the 
customer’s invoice or packing list (as an HTML file) or another report. 
You can also attach other files. These can be used to include other information specific to your company (e.g. Terms and 
Conditions). If you want to send more than 1 additional file you simply separate the files to send by a semi-colon (;). For 
example, C:\Admin\TAndC.txt; Offers.html. You can send up to 19 attachments in this way. 

Edit email before sending 
If you want to verify or edit an email before sending the email select either Edit or Edit using external editor. If you are using an 
HTML template this will always use the external editor.  

Add comment to order memo when sent 
When the email is sent the comment is added to the memo field in the order. This can be viewed from the order details memo 
page. The time and date when sent are also added. You can use any fields used in the message. The comment defaults to the 
email subject. 
 
Add email to order memo when sent 
You can keep a history of all the emails sent to your customers by ticking this option. It places the emails in the memo tab of the 
order. You can have up to 20,000 characters in the order's memo tab.  
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Only send email if not already sent 
If you want to make sure that you only send an email for an order once, tick the Check flag. You can then select which flag this 
template uses to check if an email has been sent. Normally the Order shipped and Feedback emails are used for each order. 
There are 2 additional flags that can be used for other associated emails. 
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Track Orders Online Option 

 
This feature is available in Standard, Premium and Enterprise versions of One Stop Order Processing 

Once set-up you can easily upload the selected orders’ tracking details to your website. The information given can be used for 
customers to track their own orders from your website and also for you to include a link in you despatch emails. 

 

Server to upload Order Tracking Details to (FTP details): 
Normally you would host the tracking details on your server. However, you can put them onto any server as there are no links to 
any specific locations. 
 
The Server is your FTP server name (normally supplied by your hosting company). The Directory field is used to specify the 
location once logged into your server. You would normally enter the tracking directory so would enter track. However, if your 
server is used to host multiple sites you may have additional folders to enter, for example, mysite/track. The Username and 
Password are the FTP details supplied by your host. 

Website address for Order tracing Details 
This will normally be very similar to your FTP details. You must put http:// in front of your website details and include the 
directory where the files will be uploaded to. 
 
HTML Tracking templates 
You need to select an HTML template to show with the order information and another when the entered order number is invalid 
(used when customers use your website’s tracking page). The default templates can be used to show basic tracking information. 

The Show Order details default template shows the order number, order date, shipment date and a custom field. You can add 
the following fields in to the order details.  

NOTE: It is not recommended to give any more information than is necessary in the template as it possible that anyone 
who can guess an order number can view the information. 

You can change the template to use any of the following values shown in the Macros to use in Emails, Printing and Order 
Tracking section. 

The Invalid order template is simply an HTML page that is displayed when the order can not be found on your website. The 
default page can be amended if you want to include additional information, for example, your telephone number. 
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Show HTML to use to allow your customers to track their own orders on your website 

If you click on the link a page will be displayed with the HTML that can be copied directly into one of your existing pages or your 
website pages. An example of the produced HTML shown below: 

<script type="text/javascript"> 

function ME_Track() 

{ 

       var xmlHttp; 

       try 

       { 

              xmlHttp=new XMLHttpRequest(); 

       } 

       catch (e) 

       { 

              try 

              { 

                     xmlHttp=new ActiveXObject("Msxml2.XMLHTTP"); 

              } 

              catch (e) 

              { 

                     try 

                     { 

                           xmlHttp=new ActiveXObject("Microsoft.XMLHTTP"); 

                     } 

                     catch (e) 

                     { 

                           alert("Please update your browser to a newer version"); 

                           return false; 

                     } 

              } 

       } 

       sAdd = 

"http://www.farnwo82.biz/track/"+"_ME_"+document.getElementById("ME_OrdNum").value+".html"; 

       xmlHttp.open("HEAD", sAdd, true); 

       xmlHttp.onreadystatechange=function() 

       { 

              if(xmlHttp.readyState == 4) 

              { 

                     var value; 

                     if (xmlHttp.status != 200) 

                     { 

                           sAdd = "http://www.farnwo82.biz/track/OrderTrackingFailed.html"; 

                     } 

                     var 

WinTest=open(sAdd,"","width=600,height=400,toolbar=yes,menubar=no,scrollbars=yes"); 

                     if (! WinTest){alert("A popup blocker was detected. Please\ndisable popup 

blocker to open window.");}; 

              } 

       } 

       xmlHttp.send(null); 

} 

</script> 

<p>Enter your order number:<br> 

  <input id="ME_OrdNum" type="text" size="20" name="text"/> 

  <br> 

  <input type="button" value=" Track" onclick="ME_Track()"/> 

</p> 

If required you can amend this template to suit your specific needs. 

Ask before creating tracking details for each order 
When you first use this feature you may want to confirm each order that is having tracking details uploaded. 

Purge all Order Tracking links 
To clear down any order details that have been uploaded to your website click on this button. 
 
NOTE: This option will remove all files that are in the filter: _ME_*.html (in the specified Directory). 

Add comment to order memo when tracked. 
You can add a line to the order’s memo field when the details are uploaded. This can be used to provide confirmation that the 
information has been uploaded. 

Additionally if you do not want this feature being used you can disable it in the Available Features. 
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Format Address 
  
You can choose to format the customer delivery and invoice addresses from any orders that have been received. You can 
choose to use the following formatting methods on each of the 10 (optional) lines that the user can enter for his address on the 
website. 

Capitalize 
The first character at the start of each word is turned into uppercase. For example, if someone enters melrose road, this would 
be changed to Melrose Road. 

UPPERCASE 
All the text in the line is changed to uppercase. For example, if the postcode is entered as sw19 2tt, this would be changed to 
SW19 2TT. 

To have no formatting on an address line untick both boxes. 

 

If you would like to change the formatting on specific names or words press the Exceptions button. 

 

The top box lists all the possible starting letters for names which have multiple capitalizations. The default words entered handle 
the surnames MacDonald, McDonald and O’Leary or any surname starting with Mac or Mc or O’. 

The lower box can be used to add words that do not require any formatting on them. The default is the word UK. 
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When copying customer address include email and telephone number(s) 
 
When you view a customer's order details you can copy the details to the clipboard. If you do not want to include the email and 
telephone details untick this option.  
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Company Details 
  
Your Company Details can be shown on Invoices, Packing Lists and Purchase Orders. You can also include these details on 
your Emails and Online Tracking information. The entered Company Details are replaced in the Invoice, Packing List, Purchase 
Orders, Emails and Online Tracking by using macros.  
 
The Company Details are associated with each site. Using this approach you can use the same templates for more than 1 site 
each having different Company Details. 

 

The macro shown after each field is the text to type into a template to use this value. For example, the footer text for the invoice 
can be  
 
[%COMPANY_NAME%] [%COMPANY_ADD1%] [%COMPANY_ADD2%] [%COMPANY_ADD3%] [%COMPANY_ADD4%] 

[%COMPANY_POST_CODE%] Tel:[%COMPANY_TEL%] | Email:[%COMPANY_EMAIL%]|VAT No:[%COMPANY_VAT%]|Reg 

No:[%COMPANY_REG%] 

 
which shows all the relevant company details using the entered values in the Company Details Options. 

The Company Details macros are: 

Macro Description 
[%COMPANY_ID%] Company ID. This is normally your username ro shop name on the relevant websites 

[%COMPANY_CONTACT%] Person or job title of person to contact for any order issues 

[%COMPANY_NAME%] Trading name of your company 

[%COMPANY_TEL%] Customer services telephone contact number 

[%COMPANY_FAX%] Customer services fax number 

[%COMPANY_EMAIL%] Customer sales email address 

[%COMPANY_WEBSITE%] Your main company website 

[%COMPANY_VAT%] Your VAT number (if you have one) 

[%COMPANY_REG%] Your Company registration number 

[%COMPANY_ADD1%] First line of your address 

[%COMPANY_ADD2%] Second line of your address 

[%COMPANY_ADD3%] Third line of your address 

[%COMPANY_ADD4%] Fourth line of your address 

[%COMPANY_COUNTY%] Your address county 

[%COMPANY_POST_CODE%] Your address postcode 

[%COMPANY_COUNTRY%] Your address country 
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Report Options 

 
Stock and Profit Reports are available in Standard, Premium and Enterprise versions of One Stop Order Processing 

 

You can define certain options for reports. This section explains how to configure each report. 
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Picking List 
 
You can produce a report of all the products that need be packed for groups of orders. This will make it easier for you to pack 
groups of orders. 
 
Show Orders 
If you tick this option you can show the orders that the product is included in. Once you have collected all the orders you can the 
use this information for distributing them to the order packages. There is a comment field in the report that can be used to 
indicate that the item has been packed. 
 
Show Time in Order Details 
When the order details are shown you can also include the time of the order. For most order processing tasks just the date is 
sufficient. 
 
Sort by: 
You can display the items to be picked in different ways, by product and Bin/Location. If you use numeric bin numbers you 
should select Bin/Location (as number). This will display the items using the bin/location sorted in numerical order. You can also 
sort by Customer or Order Number.  
 
Printer to send Picking List to: 
You can have a dedicated printer to send the Picking List to. This can be useful if you want to send the Picking List to a printer 
in a different location (e.g. in the warehouse). 
 
Auto close print dialog 
When you print you can choose to automatically print the Picking List by ticking this option. 
 
 
Advanced options 
You can change the Picking List to change the information shown. It is a series of HTML documents. You can change them 
using a standard HTML editor. Each file is described below. The files are located in the Templates folder under the main 
installation folder (e.g. C:\OSOP\Main\Templates). 

Filename Description 

PickingListHeader.html Contains title of report 

PickingListProduct.html 
Table header and details for product. This is used when when the order details are also 
required. 

PickingListProductHeader.html Table header for product. This is used when the order details are not shown. 

PickingListProductDetail.html Table details for product. This is used when the order details are not shown. 

PickingListOrderHeader.html Table header for orders. 

PickingListOrderDetail.html Table details for orders. 

PickingListFooter.html Contains footer of report 

 
When the product details are displayed the following macros are used. These are used in the 
PickingListProductDetail.html and PickingListProductDetail.html files. If you don't need this information 

displayed simply remove the macro (and adjust the header). 

Macro to use Description 

[%ITEM_SKU%] Item's SKU, your or supplier's code 

[%ITEM_ID] Item's ID. This is normally the website's sale item code. 

[%ITEM_TITLE%] Item's title or description 

[%ITEM_BIN%] Location of item in your warehouse, stores. This is defined in your product's inventory 

[%ITEM_QTY%] Total quantity of item ordered 

[%ITEM_SHIPPED_QTY%] Total of item already shipped 

[%ITEM_STOCK_NEEDED%] The number of items sold but not in stock. If shown the total number of items that need to be 
ordered from supplier. 

 
You can also change the information shown for each order. The information to display is in the 
PickingListOrderDetail.html file. 

Macro to use Description 

[%ORD_DATE%] Date of order. If the Show Time in Order Details option is ticked the time is also included. 

[%ORD_NUM%] Order number 

[%INVOICE_NUM%] Invoice number. If you are using the OSOP generated invoice numbers this will be displayed using 
this macro. 

[%ITEM_QTY%] Quantity of this product required for this order 
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[%ITEM_SHIPPED_QTY%] Quantity of this product already shipped 

[%DEL_CUST_NAME%] Delivery customer name 

[%DEL_COMPANY%] Delivery customer company 

[%DEL_TEL_NUM%] Delivery telephone number  

[%DEL_FAX_NUM%]  Delivery Fax number  

[%DEL_EMAIL%] Delivery email  

[%DEL_ADD_LINE1%] Delivery line 1  

[%DEL_ADD_LINE2%] Delivery line 2  

[%DEL_ADD_LINE3%] Delivery line 3  

[%DEL_ADD_LINE4%] Delivery line 4  

[%DEL_COUNTY%] Delivery County  

[%DEL_POSTCODE%] Delivery postcode  

[%DEL_COUNTRY%] Delivery Country  

[%DEL_BUYER_ID%] Delivery Buyer ID  
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Sales 

 
You can produce a report of all the sales of your products for the selected orders. This can be used to see how well some or all 
of your products are selling. 
 
Show Orders 
If you tick this option you can show the orders that the product is included in. 
 
Show Time in Order Details 
When the order details are shown you can also include the time of the order. For most order processing tasks just the date is 
sufficient. 
 
Printer to send Sales to: 
You can have a dedicated printer to send the Sales to. This can be useful if you want to send the Sales to a printer in a different 
location (e.g. in accounts). 
 
Auto close print dialog 
When you print you can choose to automatically print the Sales by ticking this option. 
 
Group Sales by: 
You can show all the sales for a particular field. This can be a product field, address location or a custom value that you specify 
(e.g. a sales person field).  
 
 
Advanced options 
 
You can change the Sales to change the information shown. It is a series of HTML documents. You can change them using a 
standard HTML editor. Each file is described below. The files are located in the Templates folder under the main installation 
folder (e.g. C:\OSOP\Main\Templates). 

Filename Description 

SalesHeader.html Contains title of report 

SalesProduct.html Table header and details for product. This is used when when the order details are also required. 

SalesOrderHeader.html Table header for orders. 

SalesOrderDetail.html Table details for orders. 

SalesFooter.html Contains footer of report 

SalesProductTotal.html This contains the totals of the items  

 
When the product details are displayed the following macros are used. These are used in the SalesProduct.html file. If you 

don't need this information displayed simply remove the macro (and adjust the header). 

Macro to use Description 

[%ITEM_SKU%] Item's SKU, your or supplier's code 

[%ITEM_ID] Item's ID. This is normally the website's sale item code. 

[%ITEM_TITLE%] Item's title or description 

[%ITEM_QTY%] Total quantity of item ordered 

[%ITEM_SHIPPED_QTY%] Total of item already shipped 

[%GROUP_BY%] If you are using the Grouped Sales option this macro displays the name of this field to group the 
sales by, e.g. Delivery Country  

[%GROUP_BY_VALUE%] If you are using the Group Sales option this is the value that the following total is for, e.g. Denmark.  

 
You can also change the information shown for each order. The information to display is in the SalesOrderDetail.html file. 

Macro to use Description 

[%ORD_DATE%] Date of order. If the Show Time in Order Details option is ticked the time is also included. 

[%ORD_NUM%] Order number. 

[%ORD_NUM_FORMATTED%] Order number in the form XXXX-XXXX-XXXX. 

[%INVOICE_NUM%] Invoice number. If you are using the OSOP generated invoice numbers this will be displayed 
using this macro. 

[%INVOICE_NUM_FORMATTED%] Invoice number in the form XXXX-XXXX-XXXX. If you are using the OSOP generated invoice 
numbers this will be displayed using this macro. 

[%ITEM_QTY%] Quantity of this product required for this order 

[%ITEM_SHIPPED_QTY%] Quantity of this product already shipped 

[%DEL_CUST_NAME%] Delivery customer name 



www.1stoporders.co.uk                                                    One Stop Order Processing   

Page 148 of 180 DocVer 1.20                                 Copyright Mole End Ltd 2002 - 2012 

[%DEL_COMPANY%] Delivery customer company 

[%DEL_TEL_NUM%] Delivery telephone number  

[%DEL_FAX_NUM%] Delivery Fax number 

[%DEL_EMAIL%] Delivery email  

[%DEL_ADD_LINE1%] Delivery line 1  

[%DEL_ADD_LINE2%] Delivery line 2  

[%DEL_ADD_LINE3%] Delivery line 3  

[%DEL_ADD_LINE4%] Delivery line 4  

[%DEL_COUNTY%] Delivery County  

[%DEL_POSTCODE%] Delivery postcode  

[%DEL_COUNTRY%] Delivery Country  

[%DEL_BUYER_ID%] Delivery Buyer ID  

 
You can also change the information shown for the totals for each product. The information to display is in the 
SalesProductTotal.html file. 

Macro to use Description 

[%SALES_PRODUCT%] Total of product sales (not including VAT) 

[%SALES_PRODUCT_TAX%] Total of all tax (VAT) paid for product 

[%SALES_PRODUCT_SHIPPING%] Total of all shipping (not including VAT) for product 

[%SALES_PRODUCT_SHIPPING_TAX%] Total of all tax (VAT) paid for shipping for this product 

[%SALES_PRODUCT_TOTAL%] Total of amount paid for product (including shipping), but not including tax (VAT) 

[%SALES_PRODUCT_TOTAL_TAX%] Total of tax (VAT) paid for product (including shipping) 

[%SALES_PRODUCT_GRAND_TOTAL%] Total amount paid for product (including VAT and shipping) 

 
You can also change the information shown for the total of all products. The information to display is in the Footer.html file. 

Macro to use Description 

[%TOTAL_SALES_PRODUCT%] Total of all products sales (not including VAT) 

[%TOTAL_SALES_PRODUCT_TAX%] Total of all tax (VAT) paid for all products 

[%TOTAL_SALES_PRODUCT_SHIPPING%] Total of all shipping (not including VAT) for all products 

[%TOTAL_SALES_PRODUCT_SHIPPING_TAX%] Total of all tax (VAT) paid for shipping for all products 

[%TOTAL_SALES_PRODUCT_TOTAL%] 
Total of amount paid for all products (including shipping), but not including tax 
(VAT) 

[%TOTAL_SALES_PRODUCT_TOTAL_TAX%] Total of tax (VAT) paid for all products (including shipping) 

[%TOTAL_SALES_PRODUCT_GRAND_TOTAL%] Total amount paid for all products (including VAT and shipping) 
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Stock 

 
You can produce various reports on stock details. The reports can be used for stock management and valuation. You can order 
the Stock Reports by Item SKU or Supplier.  
 
Auto close print dialog 
When you print you can choose to automatically print the Sales by ticking this option. 
 
 
Advanced options 
You can change the Sales to change the information shown. It is a series of HTML documents. You can change them using a 
standard HTML editor. Each file is described below. The files are located in the Templates folder under the main installation 
folder (e.g. C:\OSOP\Main\Templates). 

Filename Description 

OutOfStockReportHeader.html Out of Stock heading and table definition 

OutOfStockReportProduct.html Out of Stock main details for each product 

OutOfStockReportFooter.html Out of Stock totals and footer information 

ReorderStockReportHeader.html Reorder Stock heading and table definition 

ReorderStockReportProduct.html Reorder Stock main details for each product 

ReorderStockReportFooter.html Reorder Stock totals and footer information 

StockReportHeader.html Stock Listing heading and table definition 

StockReportProduct.html Stock Listing main details for each product 

StockReportFooter.html Stock Listing totals and footer information 

StockValuationReportHeader.html Stock valuation heading and table definition 

StockValuationReportProduct.html Stock valuation main details for each product 

StockValuationReportFooter.html Stock valuation totals and footer information 

 
Within the files the following macros can be used: 

Macro to use Product Details Description 

[%PRODUCT_SKU%] SKU 

[%PRODUCT_EAN%] EAN/ISBN 

[%PRODUCT_TITLE%] Title of product 

[%PRODUCT_DESC%] Main description 

[%PRODUCT_BIN%] Location of product in warehouse 

[%PRODUCT_PRICE%] Selling price 

[%PRODUCT_SHIP_COST%] Shipping cost 

[%PRODUCT_VAT_RATE%] VAT rate for product 

[%PRODUCT_WEIGHT%] Weight for product 

[%PRODUCT_TYPE%] Type of product (a value that you assign as a product group) 

[%PRODUCT_COST_PRICE%] Cost price of product 

[%PRODUCT_STOCK_LEVEL%] Current stock level 

[%PRODUCT_STOCK_REORDER_LEVEL%] What order level has to be reached for you to order some more 

[%PRODUCT_STOCK_OUT_LEVEL%] What stock means out of stock (can be 0, but generally is more)  

[%PRODUCT_STOCK_SUPPLIER%] Who supplies this product 

[%SUPPLIER_NAME1%]  Name of supplier (your name gievn to the supplier)  

[%SUPPLIER_COMPANY1%] Supplier company name  

[%SUPPLIER_TEL_NUM1%] Supplier telephone number  

[%SUPPLIER_FAX_NUM1%] Supplier fax number  

[%SUPPLIER_EMAIL1%] Supplier's email address  

[%SUPPLIER_ADD_LINE11%] Supplier's address line 1  

[%SUPPLIER_ADD_LINE21%] Supplier's address line 2  

[%SUPPLIER_ADD_LINE31%] Supplier's address line 3  

[%SUPPLIER_ADD_LINE41%] Supplier's address line 4  

[%SUPPLIER_COUNTY1%] Supplier's county  

[%SUPPLIER_POSTCODE1%] Supplier's postcode  

[%SUPPLIER_COUNTRY1%] Supplier's country  

[%SUPPLIER_ID1%] Supplier's internal ID.  
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[%SUPPLIER_VAT1%] Supplier's VAT number  

[%SUPPLIER_CODE1%] Supplier's code  

[%SUPPLIER_NOTES1%] Supplier's notes  

[%SUPPLIER_ADD1%] Supplier's address (as a single address block).  

 
NOTE: For supplier information replace the last number with 2 or 3 to use the other supplier’s details setup.  
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Profit 

 
You can show how much profit you have for the selected orders. This is based upon the cost prices that you enter for the 
products. 
 
Auto close print dialog 
When you print you can choose to automatically print the Sales by ticking this option. 
 
 
Advanced options 
You can change the Sales to change the information shown. It is a series of HTML documents. You can change them using a 
standard HTML editor. Each file is described below. The files are located in the Templates folder under the main installation 
folder (e.g. C:\OSOP\Main\Templates). 

Filename Description 

ProfitHeader.html Profit header 

ProfitProductHeader.html Profit table headings 

ProfitProductTotal.html Profit Product details 

ProfitFooter.html Profit totals and footer information 

 

Within the files the following macros can be used: 

Macro to use Product Details Description 

[%SALES_PRODUCT%] Sales of this product 

[%COSTS_PRODUCT%] Costs for this product 

[%PROFITS_PRODUCT%] Profit on this product 

[%QTY_PRODUCTS%] Quantity of this product sold 

[%ITEM_SKU%] SKU of the product 

[%ITEM_TITLE%] Title of the product 

[%TOTAL_SALES_PRODUCT%] Total sales of all products 

[%TOTAL_COSTS_PRODUCT%] Total cost of all products 

[%TOTAL_PROFITS_PRODUCT%] Profit on all products 

[%TOTAL_QTY_PRODUCTS%] Total number of products ordered. 
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Multi-User Access 
 
You can install and use One Stop Order Processing on up to 20 PCs at the same time (depending upon the license being used). 

NOTE: Each different PC used to connect to the same website (database) will need a separate license. 

There are certain requirements (and limitations). These are described below: 

1 All PCs must have the relevant security access to the main PC. If you do not have the required access a message will be 
displayed by One Stop Order Processing when selecting the remote site. You should consult your System Administrator if you 
do not have remote access to the main PCs directory. 
 
2 Ideally you should divide the orders to process across the remote machines. If more than 1 person processes the same order 
changes made by one user may overwrite changes from another. 

Once the remote site has been selected One Stop Order Processing will continue to use the selected site (i.e. you won’t need to 
re-select the site each time that you start One Stop Order Processing). 
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Changing the site to process orders for 
 
You can process orders from more than 1 site by changing the current site being processed. Click on the Change Site button 

( ) 

 

If using a local site you can select the site to view from the available sites. You can also create a new site by clicking on the 
Create New Site button. You can also rename a site. You must be careful that no one else is using the site at the same time as 
you are renaming it. 
 

Creating a New Site 

You can create a new site to use for a certain order type (e.g. Playtrade) or as an archive site. 

To create a new site select the Site option under File -> New. You can also create a new site by using the Create New Site 

button in the Change Site dialog (click on ). 
 

 

Type in the name of the new site and click on Create Site. You can them import orders into the new site or move existing orders 
to it. 

 
If you want to access a site on another computer you should select the Remote Sites option. To be able to do this you must 
have access to a shared drive on the remote computer. To share a drive from the computer you should use explorer, select the 
installation directory (normally C:\OSOP) and select the share option. You will need to give full access to the remote drive. 
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Setting up Remote Access 

 
Below are examples for Windows Vista and Windows 7 and Windows XP. If you are using Windows 2000, NT, Windows ME or 
Windows 98 SE you should follow the Windows XP example. 
 

Windows Vista and Windows 7 example 

 

Main PC 

1 Run Windows explorer (use the Windows key and E). Select the top installation folder, OSOP. 

 
 

2 Click on the right mouse button and select Properties 

 
 

3 Click on the Sharing tab and then click on the Advanced Sharing button. 
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4 Tick the Share this folder and check that the name defaults to OSOP. Click on the Permissions button. 

 
 

5 You should tick Full Control in the Permissions area. 
 

 

NOTE: This will mean that anyone on your network can view your orders. If you want to restrict this to only certain users (or 
PCs) you should click on Add and select the relevant users (or computers) and only give them permission and remove the 
Everyone group. 
 

6 You should now click on OK and then OK on the Advanced Sharing dialog and then Close on the OSOP Properties folder. 
You can now ready to access the order information from another PC.  
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Remote PCs 

7 In the Change Site dialog select Remote Sites and click on the Select Shared OSOP folder button. 
 

 
 

8 Select Network and the relevant PC. Select the main shared folder (OSOP). Click on OK. 

 

 
 

9 The first available site will be selected. If there is more than 1 site select the relevant site and click on OK. 
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Windows XP Example 

 

Main PC 

1 Run Windows explorer (use the Windows key and E). Select the top installation folder, OSOP. 

 

 
 

2 Click on the right mouse button and select Properties 

 

3 Click on the Sharing tab and then tick Share this folder on the network. Make sure the name defaults to OSOP. Also 

make sure that you tick Allow network users to change my files. 
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Remote PCs 

4 In the Change Site dialog select Remote Sites and click on the Select Shared OSOP folder button. 
 

 
 

5 Select My Network Places and the relevant PC. Select the main shared folder (OSOP). Click on OK. 

 

 
 

6 The first available site will be selected. If there is more than 1 site select the relevant site and click on OK. 
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Setting Up Email  
 
You can configure how email is sent. You can choose whether to use your MAPI client, for example, Microsoft Outlook, Outlook 
Express or Eudora, or an SMTP server.  

Using an SMTP server allows faster email sending and gives you the choice of sending HTML or plain text emails 

 

If you choose to use your MAPI email client you don’t need to configure any options as these are set by your email software. If 
you allow your MAPI client to send your emails it may not send them unless the email client is running. 

SMTP settings 
If you choose an SMTP server you need to enter certain information depending upon your host (or ISP). These settings can 
normally be copied from your existing email client. The settings to copy are those specified in your Outgoing mail server 
(SMTP). Some ISPs, for example, Freeserve, only allow you to send email from their SMTP server. Some SMTP servers may 
not use the default port (of 25). Also they may require you to use your given name and password. Below are some examples of 
values to use for different ISPs. One Stop Order Processing should automatically find the correct connection type. This can be 
used by setting the Authentication Type to Automatic. If this does not work correctly or you want to use a specific connection 
type this can be selected from the available list.  

Freeserve - smtp.freeserve.com 
Yahoo - smtp.mail.yahoo.co.uk 
Orange - smtp.orange.net 
BT - mail.btinternet.com 
O2 - smtp.o2.co.uk 
Tiscali - smtp.tiscali.co.uk 
 
Email sender information 
When you send an email you need to identify who the mail is from and a reply address. 

If you want to use a different email address for each site tick the Use different send details for each site. 
 
Logging 
You can choose to log details of all emails sent along with any errors found. You can specify a new log for each day or a single 
combined log with all email information. To view the log click on the View log button. You are given the choice of editor to use 
for viewing the log information. 
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Testing the Email Setup 
  
When you have entered the details you can test the email settings by clicking the Test button. 

 

You can enter an email to send a test message to. If you are using an SMTP server to send email you can choose to send the 
test message as HTML or plain text. The results from the test are displayed. 
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Managing Assistant Messages 
  
To help understand the features in One Stop Order processing information dialogs are shown when using the product. These 
can be dismissed and displayed next time that task is performed or, by ticking a box, not shown again.. 

 

If you want to re-show certain messages, show them all or not show any, use the Manage assistant messages dialog. To open 
this dialog select the Manager Assistant Messages menu option (under the Tools menu). 

 

This shows you all the messages that have currently been available to show. If you want to turn off all assistant messages 
select the Do not show any more assistant messages option. If you want to start again and show all available messages select 
the Continue to display assistant messages option and click on the Show all button. 
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Selecting Available Features  
 
You can restrict the available options for the current user by selecting the features dialog from the menu bar (under the Tools 
option).  

 

This can be used to allow users to perform certain functions. For example, the shipment processing can be restricted to a single 
machine. This can also be used to allow a user to only view orders without changing any order information. 
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Managing Backups 

 

Select Site(s) to Backup  

When you are backing up, by closing One Stop Order Processing or selecting the Backup Now menu option (under 
Housekeeping menu option) you are shown the following dialog: 
 

 
 
You can choose to backup the current site that you are working on or all of the sites that you have. You can choose to not 
backup the sites at the current time by clicking on the Don't Backup Now button.  
 
 

Backup Options  

 
You can choose where and how often to backup the order information. You should ideally backup the orders to a remote PC or 
server). Each time One Stop Order Processing is closed it checks to see a backup should be made. To select the Backup 
Options select the Backup Options menu option (under House Keeping->Backup menu)  
 
 

 
 
 
Shutdown Backup Options: 
You can choose how often to prompt to backup the orders, each time you close One Stop Order Processing, a certain amount 
of days (e.g. weekly) or Never. 
 
Backup to: 
The location to store any backups to. 
 
Additional Options: 
You can choose to only backup if the order information has changed and also to save the order data in a zip (compressed) file. 
 
You can make a backup of your orders at any time by selecting the Backup Now menu option. 

 

Restoring backed up orders 
 
If you need to restore the order information (for example, after a computer hard disk failure) you should use the Restore from 
backup menu option (under House Keeping->Backup). 
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Save and Restore Settings 
  
If you want to save your settings go to the HouseKeeping->Backup->Save Settings menu option. This creates a .mes file. This 
file can be used to restore your settings onto the same or another PC. 

 
 
To restore your setings simply select a previously saved .mes file. If you want to restore the file onto another PC copy the .mes 
file to another PC and select the HouseKeeping->Backup->Restore Settings menu option. 

 

When you restore the settings One Stop Order Processing will be closed. To use the new/retored settings restart One Stop 
Order Processing. 
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Archiving Orders 
 
When you have finished with some of your orders, or need them for a different task (e.g. VAT quarter or monthly reconciliation) 
you can move orders to another site. 
 
You should first create another site (using the Site menu option, under the File->New menu) to move the orders to. You should 
then select the orders to archive (move) and click on Archive Orders or select the Archive Orders menu option (under the House 
Keeping->Archive Orders menu). 
 
You can also automatically archive orders to another site. To setup these options select the Auto Archive Options. 
 

 

You can choose to move all the orders or the selected orders to the selected site in the Website to move orders to:. You can 
also tick the Overwrite orders with the same order number if you have imported the same orders more than once from the import 
file. 
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Auto Archive Orders  
 
When you have finished with some of your orders, or need them for a different task (e.g. VAT quarter or monthly reconciliation) 
you can automatically move orders to another site. You will still be able to access the orders (by selecting the other site), but for 
everyday orders they will be in the current view and will be faster to display and use. 
 
You should first create another site (using the Site menu option, under the File->New menu) to move the orders to. You should 
then select the orders to automatically archive (move). Select the Auto Archive Orders menu option (under the House Keeping-
>Archive Orders menu). 
 

 

You select the number of days between automatically checking for orders to archive. The default is 7 days.  
 
You can archive orders that are older than a certain time. The more orders that are archived the faster the current orders are 
displayed. 

You can also tick the Overwrite orders with the same order number if you have imported the same orders more than once from 
the import file. 
 
By default, you are asked before orders are archived. If you want to automatically archive orders (without being asked) tick Don't 
ask before archiving orders. 
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Compacting and Repairing the Orders database 

 
You can display details about your current database by selecting the Housekeeping->Orders Database Information 

 
You can improve the performance of One Stop Order Processing by compacting the database. 
 
You can also compact and repair your order data by clicking on the Compact and Repair Orders Database button. This will 
make a backup of your existing orders data into a zip file. This file will be in the same folder (directory) as the database, and 
have the current time and date within its name (and have a .zip filename extension). This can be used to restore your orders 
information if you have a problem. 
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Advanced Information on how to change Invoices, Packing Lists 
and Purchase Orders 
 
There are several standard Invoices, Packing Lists and Purchase Order layouts provided with One Stop Order Processing. 
These have been designed to suit standard paper types and uses. If the layout isn't exactly how you would like it you can make 
various changes to one of the existing templates (which can be saved as your own format). This document explains how to 
make changes to the templates.  
 

Adding messages (or other text) adding logos and PPIs 
One Stop Order Processing uses macros that are replaced with text, images or order details when printed. Several macros are 
setup as standard. You can view and amend the Macros in the Printing Fields tab in the Options, shown below. 
 

 

[%INV_LABEL_TEXT%] The text that appears at the bottom of the invoice integrated label. This defaults to your company 
name.  

[%DEL_LABEL_TEXT%] The text that appears at the bottom of the delivery integrated label. This defaults to your company 
name.  

[%MSG_TEXT%] The message to display at the bottom of the form (e.g. Invoice). This defaults to Thank you for 
shopping with us. 

[%FOOT_TEXT%] This is the text that appears at the bottom of the form (e.g. Purchase Order). This defaults to your 
company name, address and company number (and VAT number).  

[%LABEL_LOGO%] If you want to display a logo on your form (e.g. Packing List) select an image. This defaults to no 
image being shown. An ideal size for the logo is 60 by 60 pixels. 
 
If you want to use a larger logo and adjust its size for the invoice add the text 
 
" width="{width}" height="{height} 
 
to the end of the filename. Change the {width} and {height} values to the size required. For example, 
change 
 
http://www.1stoporders.co.uk/1stopmain2.jpg 
 
to 
 
http://www.1stoporders.co.uk/1stopmain2.jpg" width="100" height="200  
 
You should also change the Type to Text 
 
If you need further changes you can amend the HTML template using an HTML editor.  

[%LABEL_PPI%] If you want to display a PPI on your form's label (e.g. Invoice) select a PPI image. This defaults to 
not using a PPI.  
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A macro can contain text, images or html. For example, if you want to include an image and text in your message at the bottom 
of the invoice enter the text and the html to include an image.  
 
For example, to display the following as your message: 

 
Thank you for shopping with us 

 

 
use the text 
 
div align="center"><br />Thank you for shopping with us<br /> <img src="1stoporders32logo.jpg" /> 

</div> 
 
as the Macro Value (of Type Text).  
 
You can also define your own macros. It is important that if you do create your own macros you should also add their values to 
the Invoice, Packing List or Purchase Order used. For more details on how to use different macro values for different orders 
click here. 
 
 

Changing the size of text on delivery labels 

 
You can do this in 2 ways. For individual values (Macros), replace the macro with a new font and type. For example, to change 
the delivery address (on a label) to a larger red font replace the macro value with:  
 
<font color="#FF0000" size="4" face="Verdana, Arial, Helvetica, sans-serif">[%DEL_ADD%]</font> 

 
This is shown below: 
 

 
 
Another approach is to change the printing style of the Invoice, Packng List or Purchase Order. In the main installation directory 
(by default, C:\OSOP\Main) are printing files called 1stopprintIE.css and 1stopprintIE7.css. 

 
These files change the general printing characteristics of the Invoices, Packing Lists and Purchase Orders. 
 
For a delivery address change the size for .is2 from font-size: 14pt; to a higher value (e.g. 16pt); 
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Displaying Barcodes on the Invoice, Packing List or Purchase Order  

You can amend your Invoices, Packing Lists and Purchase Orders to show barcodes (to save re-keying the order number) by 
using the following approach: 
 
1 Download and install a barcode font. There are several free ones available including the following: 
 
http://www.download.com/Free-TrueType-Code-39-Barcode-Font/3000-2190_4-10067143.html 
 
2 Amend the HTML template using your HTML editor (e.g. Dreamweaver). Copy the relevant text that you want as a barcode 
and add a * at either side to indicate the start and stop characters for the barode scanner. (e.g. *[%ORD_NUM%]* ), shown 
below: 

 
 
3 Assign the text the relevant barcode font (e.g. IDAutomationHC39M), shown below: 

 
 
4 When printed it will now show the required details as a barcode, an example is shown below. 

 
 
5 Advanced more detailed setup. 
If you are using html directly (or want to use printing macros to use barcodes) you can use the following HTML to use the 
barcodes. Assuming that you are using the barcode font shown above, add the following text to the HTML header, just before 
the </head> line. 
 
<style type="text/css"> 

<!-- 

.style1 {font-family: IDAutomationHC39M} 

--> 

</style> 

 

Change the font to use for the relevant text using this style, e.g. 

 

To change the text [%ORD_NUM%] into a barcode simply replace with  

 

<div class="style1"> *[%ORD_NUM%]* </div> 
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Stop Orders printing onto 2 pages 
  
If your Invoice, Purchase Order or Packing List prints onto 2 pages you should change the Page Message Height to a lower 
value (to decrease the gap at the bottom of the page). This field is at the bottom of the Invoice, Packing List and Purchase Order 
Option pages, shown below:  
 

 

 
Removing the text at top and bottom of the Invoice, Packing List or Purchase Order 
  
You can remove the text displayed at the top and bottom of the Invoice, Packing List or Purchase Order in Microsoft Internet 
Explorer, by removing the text in the Headers and Footers options in the Page Setup (under the File menu). This is shown 
below: 
 

 
 

Invoices, Packing Lists, Purchase Orders not printing (but can be previewed) 
 
This can happen if you do not have the printer setup or if you are using Internet Explorer's Content Advisor. You should make 
sure that a printer has been setup (in the Options). By default the first printer found is used, which may not be the correct printer. 
You should change (or disable) the Content Advisor if this still fails to print.  
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Invoices, Packing Lists or Purchase Orders don't print a logo and/or colours 

   
You need to turn on the Print background colors and images in the Advanced Options in Microsoft Internet Explorer, shown 
below 

 
 

 

 
 

Using Microsoft Word to amend and print the Invoice Templates 

One Stop Order Processing provides Invoice templates written using HTML (HyperText Markup Language). The templates 
provided by the IL_Invoicing software are wriiten in RTF (Rich Text Format). To print from One Stop Order Processing using the 
RTF templates you need to do the following: 
 
1 Select the View->Customize Current View menu option.  
 
2 Click on the Import button.  
 
3 Select and import the MicrosoftWordInvoices.mev view file  

 
4 Select the orders to print from Microsoft Word. 
 

5 Click on the Export Orders button (  ) and select Microsoft Word Invoices. 
 
6 Open the Microsoft Word template (IL_Invoices.rtf) from the installation folder (C:\OSOP\Main\Templates). 

 
7 Perform the Word Mail Merge as described in the following document, when selecting the orders file select the file 
C:\Orders.csv. 

 
http://www.integratedlabels.co.uk/IntegratedSMProDef.html  

 
Start from point 6, Open the installed Word document. 
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Macros to use in Emails, Printing and Order Tracking 
 
NOTE: means only applies for Amazon Seller Central (and not Amazon Marketplace). OSOP orders are created using One 
Stop Order Processing. 

Macro to use Description Shops used for 
  

  Ebay Amazon Playtrade RomanCart eBid 
osCommerce 
/CRE Loaded 

Actinic CubeCart OSOP Interspire XCart 

[%INV_CUST_NAME%] Invoice customer name 
           

[%INV_COMPANY%] Invoice customer company 
   

 

  

      

[%INV_TEL_NUM%] Invoice customer telephone 
number 

  

 

 

    

     

[%INV_FAX_NUM%] Invoice customer fax number 
            

 

  

   

[%INV_EMAIL%] Invoice email address 
           

[%INV_ADD_LINE1%] Invoice address line 1 
           

[%INV_ADD_LINE2%] Invoice address line 2 
           

[%INV_ADD_LINE3%] Invoice address line 3 
       

  

   

[%INV_ADD_LINE4%] Invoice address line 4 
 

 

         

  

    

[%INV_COUNTY%] Invoice County 
           

[%INV_POSTCODE%] Invoice Postcode 
           

[%INV_COUNTRY%] Invoice Country 
           

[%INV_BUYER_ID%] Invoice Buyer ID 
           

[%DEL_CUST_NAME%] Delivery customer name 
           

[%DEL_COMPANY%] Delivery customer company 
 

 

 

 

  

      

[%DEL_TEL_NUM%] Delivery customer telephone 
number 

  

 

 

    

     

[%DEL_FAX_NUM%] Delivery customer fax number 
            

 

  

   

[%DEL_EMAIL%] Delivery email address 
           

[%DEL_ADD_LINE1%] Delivery address line 1 
           

[%DEL_ADD_LINE2%] Delivery address line 2 
           

[%DEL_ADD_LINE3%] Delivery address line 3 
       

  

   

[%DEL_ADD_LINE4%] Delivery address line 4 
  

     

 

  

  

    

[%DEL_COUNTY%] Delivery County 
  

 

        

[%DEL_POSTCODE%] Delivery Postcode 
           

[%DEL_COUNTRY%] Delivery Country 
           

[%DEL_BUYER_ID%] Delivery Buyer ID 
           

    
                  

[%DEL_ADD%] Complete delivery address. 
Blank lines are removed and 
the country is displayed using 
the country option in the 
Printing fields options. 

           

[%INV_ADD%] Complete invoice address. 
Blank lines are removed and 
the country is displayed using 
the country option in the 
Printing fields options. 

           

    
                  

[%SALES_SOURCE%] Source for the order (e.g. 
Ebay) 

           

[%ORD_NUM%] Sale order number 
           

[%ORD_NUM_FORMATTED%] Sale order number in the form 
XXXX-XXXX-XXXX  

           

[%ORD_TRANS_ID%] Transaction Identifier 
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Macro to use Description Shops used for 
  

  Ebay Amazon Playtrade RomanCart eBid 
osCommerce 
/CRE Loaded 

Actinic CubeCart OSOP Interspire XCart 

[%ORDER_ID%] Order ID (maybe different 
from [%ORD_NUM%]) 

           

[%INVOICE_NUM%] Invoice number 
           

[%INVOICE_NUM_FORMATTED%] Invoice number in the form 
XXXX-XXXX-XXXX  

           

[%CHECKOUT_DATE%] Date when the checkout was 
completed 

           

[%ORD_DATE%] Date when the order was 
processed by the website 
(normally the same as 
[%CHECKOUT_DATE%]) 

           

[%INV_DATE%]  Invoice date 
           

[%PAY_DATE%] Date when payment was 
taken 

           

[%DISPATCH_DATE%] Date when the order was 
shipped (sent) 

           

[%LISTED_ON%] Sub-site item was sold on 
(e.g. Ebay Express) 

           

[%PAYMENT_METHOD%] Payment method used 
           

[%PAYMENT_STATUS%] Payment status 
           

[%ORD_TOTAL_PAID%] Total amount paid 
           

[%PAYPAL_ID%] Paypal ID (if appropriate) 
 

            

 

    

[%VAT_NUMBER%] Order VAT number (mainly 
used for other EC country 
sale not paying VAT) 

         

 

  

 

    

[%INVOICE_VAT_NUMBER%] Invoice Customer VAT 
number (mainly used for other 
EC country sale not paying 
VAT) 

         

 

  

 

    

[%DELIVERY_VAT_NUMBER%] Delivery Customer VAT 
number (mainly used for other 
EC country sale not paying 
VAT) 

         

 

  

 

    

[%CURRENCY%] Currency for the order 
           

[%PO_NUMBER%] Purchase order number 
         

 

  

 

    

[%TOTAL_WEIGHT%] Total weight of order 
             

 

    

[%POSTAL_SERVICE%] Postal service required for 
order 

           

[%DELIVERY_INSTRUCTIONS%] Any special delivery 
instructions 

 

 

       

 

  

 

    

[%FEEDBACK_LEFT%] Feedback left for customer 
 

             

  

[%FEEDBACK_RECEIVED%] Feedback received from 
customer 

 

        

 

   

  

[%NOTES%] Notes for order 
 

        

 

  

 

    

    
                  

[%ORD_SUB_TOTAL%] Total cost of all items ordered 
(not including VAT) 

           

[%ORD_SUB_TOTAL_TAX%] Tax on total cost of items 
           

[%ORD_PNP%] Total Postage and Packing 
(not including VAT) 

           

[%ORD_PNP_TAX%] Tax on Postage and Packing 
           

[%ORD_INSURANCE%] Insurance on order (not 
including VAT) 

 

            

 

    

[%ORD_INSURANCE_TAX%] Tax on Insurance 
 

            

 

    

[%ORD_TOTAL_TAX%] Total tax on order 
           

[%ORD_TOTAL_NO_TAX%] Total of all items, postage and 
insurance 
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Macro to use Description Shops used for 
  

  Ebay Amazon Playtrade RomanCart eBid 
osCommerce 
/CRE Loaded 

Actinic CubeCart OSOP Interspire XCart 

[%ORD_GRAND_TOTAL%] Total of all items, P&P, 
Insurance and Tax 

           

    
                  

[%ITEM_IDn%] Item ID. n can be from 1 to 
20. 

           

[%ITEM_TITLEn%] Item Title. n can be from 1 to 
20. 

           

[%ITEM_SKUn%] Item SKU. This normally your 
own part number (ID). n can 
be from 1 to 20. 

           

[%ITEM_QTYn%] Quantity of item. n can be 
from 1 to 20. 

           

[%ITEM_PRICEn%] Price of item. n can be from 1 
to 20. 

           

[%ITEM_VAT_RATEn%] VAT rate applied to this item. 
n can be from 1 to 20. 

         

    

[%ITEM_TAXn%] Tax (VAT) on the item. n can 
be from 1 to 20. 

         

    

[%ITEM_TOTALn%] Total cost of item (including 
TAX). n can be from 1 to 20. 

           

[%ITEM_WEIGHTn%] Weight of item (normally in 
Kilos). n can be from 1 to 20. 

             

 

    

[%ITEM_SHIPPED_QTYn%] Number of this item shipped.. 
n can be from 1 to 20. 

           

    
                  

[%ITEMS_ORDERED%] All the items ordered 
including Postage and 
Packing, Insurance and Tax. 
Uses Item IDs 

           

[%ITEMS_ORDERED2%] All the items ordered 
including Postage and 
Packing, Insurance and Tax. 
Uses Item SKUs 

           

[%ITEMS_ORDERED3%] All the items ordered 
including Postage and 
Packing, Insurance and Tax. 
Uses Item IDS and SKUs 

           

    
                      

[%ITEMS_PACKING_LIST%] All the items ordered. No 
costs shown. Uses Item IDs 

           

[%ITEMS_PACKING_LIST2%] All the items ordered. No 
costs shown. Uses Item 
SKUs 

           

[%ITEMS_PACKING_LIST3%] All the items ordered. No 
costs shown. Uses Item 
SKUs and IDs  

           

    
                      

    
                  

[%CUSTOM_ENTERED1%] Custom field 1 entered for the 
order 

           

[%CUSTOM_ENTERED2%] Custom field 2 entered for the 
order 

           

[%CUSTOM_ENTERED3%] Custom field 3 entered for the 
order 

           

[%CUSTOM_ENTERED4%] Custom field 4 entered for the 
order 

           

[%CUSTOM_ENTERED5%] Custom field 5 entered for the 
order 

           

[%CUSTOM_ENTERED6%] Custom field 6 entered for the 
order 

           

[%CUSTOM_ENTERED7%] Custom field 7 entered for the 
order 
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Macro to use Description Shops used for 
  

  Ebay Amazon Playtrade RomanCart eBid 
osCommerce 
/CRE Loaded 

Actinic CubeCart OSOP Interspire XCart 

[%CUSTOM_ENTERED8%] Custom field 8 entered for the 
order 

           

[%CUSTOM_ENTERED9%] Custom field 9 entered for the 
order 

           

[%CUSTOM_ENTERED10%] Custom field 10 entered for 
the order 

           

[%CUSTOM_ENTERED11%] Custom field 11 entered for 
the order 

           

[%CUSTOM_ENTERED12%] Custom field 12 entered for 
the order 

           

[%CUSTOM_ENTERED13%] Custom field 13 entered for 
the order 

           

[%CUSTOM_ENTERED14%] Custom field 14 entered for 
the order 

           

[%CUSTOM_ENTERED15%] Custom field 15 entered for 
the order 

           

[%CUSTOM_ENTERED16%] Custom field 16 entered for 
the order 

           

[%CUSTOM_ENTERED17%] Custom field 17 entered for 
the order 

           

[%CUSTOM_ENTERED18%] Custom field 18 entered for 
the order 

           

[%CUSTOM_ENTERED19%] Custom field 19 entered for 
the order 

           

[%CUSTOM_ENTERED20%] Custom field 20entered for 
the order 

           

[%CUSTOM_ENTERED21%] Custom field 21 entered for 
the order 

           

[%CUSTOM_ENTERED22%] Custom field 22 entered for 
the order 

           

[%CUSTOM_ENTERED23%] Custom field 23 entered for 
the order 

           

[%CUSTOM_ENTERED24%] Custom field 24 entered for 
the order 

           

[%CUSTOM_ENTERED25%] Custom field 25 entered for 
the order 

           

[%CUSTOM_ENTERED26%] Custom field 26 entered for 
the order 

           

[%CUSTOM_ENTERED27%] Custom field 27 entered for 
the order 

           

[%CUSTOM_ENTERED28%] Custom field 28 entered for 
the order 

           

[%CUSTOM_ENTERED29%] Custom field 29 entered for 
the order 

           

[%CUSTOM_ENTERED30%] Custom field 30entered for 
the order 

           

[%CUSTOM_ENTERED31%] Custom field 31 entered for 
the order 

           

[%CUSTOM_ENTERED32%] Custom field 32 entered for 
the order 

           

[%CUSTOM_ENTERED33%] Custom field 33 entered for 
the order 

           

[%CUSTOM_ENTERED34%] Custom field 34 entered for 
the order 

           

[%CUSTOM_ENTERED35%] Custom field 35 entered for 
the order 

           

[%CUSTOM_ENTERED36%] Custom field 36 entered for 
the order 

           

[%CUSTOM_ENTERED37%] Custom field 37 entered for 
the order 

           

[%CUSTOM_ENTERED38%] Custom field 38 entered for 
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the order 

[%CUSTOM_ENTERED39%] Custom field 39 entered for 
the order 

           

[%CUSTOM_ENTERED40%] Custom field 40 entered for 
the order 

           

[%CUSTOM_ENTERED41%] Custom field 41 entered for 
the order 

           

[%CUSTOM_ENTERED42%] Custom field 42 entered for 
the order 

           

[%CUSTOM_ENTERED43%] Custom field 43 entered for 
the order 

           

[%CUSTOM_ENTERED44%] Custom field 44 entered for 
the order 

           

[%CUSTOM_ENTERED45%] Custom field 45 entered for 
the order 

           

[%CUSTOM_ENTERED46%] Custom field 46 entered for 
the order 

           

[%CUSTOM_ENTERED47%] Custom field 47 entered for 
the order 

           

[%CUSTOM_ENTERED48%] Custom field 48 entered for 
the order 

           

[%CUSTOM_ENTERED49%] Custom field 49 entered for 
the order 

           

[%CUSTOM_ENTERED50%] Custom field 50entered for 
the order 

           

                          

[%CUSTOM_FIXED1%] up to [%CUSTOM_FIXED50%]. These values are 
defined in the Customize Current View dialog 

           

  

Product Macros. You can display more details for each product on an order line by using the following macros. Where n is the 
orderline to display. n can be from 1 to 100  

[%PRODUCT_SKUn%] Product SKU 
           

[%PRODUCT_EANn%] Product EAN 
           

[%PRODUCT_TITLEn%] Product Title 
           

[%PRODUCT_DESCn%] Product Description 
           

[%PRODUCT_BINn%] Product bin/location in the 
warehouse 

           

[%PRODUCT_PRICEn%] Product price 
           

[%PRODUCT_SHIP_COSTn%] Product shipping cost 
           

[%PRODUCT_VAT_RATEn%] Product VAT rate 
           

[%PRODUCT_WEIGHTn%] Product weight 
           

[%PRODUCT_TYPEn%] Product type. This is the 
group that you have assigned 
the product to (e.g. Tools) 

           

[%PRODUCT_STOCK_LEVELn%] Product current stock level 
           

[%PRODUCT_STOCK_REORDER_LEVELn%] Product stock level to reorder 
at 

           

[%PRODUCT_STOCK_OUT_LEVELn%] Product stock level when is 
out of stock 

           

[%PRODUCT_COST_PRICEn%]  Product cost price 
           

[%PRODUCT_COST_PRICE_SHIPPINGn%] Product cost price of shipping 
           

[%PRODUCT_CURRENCYn%] Product currency 
           

[%PRODUCT_NOTESn%] Product notes (that you enter) 
           

[%PRODUCT_ACTINIC_SKUn%]  Product Actinic SKU 
           

[%PRODUCT_AMAZON_MP_SKUn%] Product Amazon Marketplace 
SKU 
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[%PRODUCT_AMAZON_SC_SKUn%] Product Amazon 
SellerCentral SKU 

           

[%PRODUCT_CUBE_CART_SKUn%] Product CubeCart SKU 
           

[%PRODUCT_EDIRECTORY_SKUn%] Product Edirectory SKU 
           

[%PRODUCT_INTERSPIRE_SKUn%]  Product Interspire SKU 
           

[%PRODUCT_EBAY_SKUn%]  Product Ebay SKU 
           

[%PRODUCT_EBID_SKUn%] Product eBid SKU 
           

[%PRODUCT_ONE_STOP_SKUn%] Product OSOP SKU 
           

[%PRODUCT_OSCOMMERCE_SKUn%] Product osCommerce SKU 
           

[%PRODUCT_PLAYTRADE_SKUn%] Product Playtrade SKU 
           

[%PRODUCT_ROMAN_CART_SKUn%] Product Roman Cart SKU 
           

[%PRODUCT_XCART_SKUn%] Product XCart SKU 
           

 
  

                      

Product Macros used for 
product feeds 

  

                      

[%PRODUCT_ORIGINAL_PRICEn%] Product original price, used 
for sales 

           

[%PRODUCT_AVAILABILITYn%] Product availability, e.g. 3 
days 

           

[%PRODUCT_BRANDn%] Product brand, e.g. Dolce 
Gusto 

           

[%PRODUCT_CATEGORYn%] Product category, e.g. Small 
applicances 

           

[%PRODUCT_CONDITIONn%] Product condition, e.g. new 
           

[%PRODUCT_DURATIONn%] Product duration of sale, e.g. 
7 (for 7 days) 

           

[%PRODUCT_IMAGE1-n%] Product image, e.g. 
image1.jpg 

           

[%PRODUCT_IMAGE2-n%] Product mage 2 
           

[%PRODUCT_IMAGE3-n%] Product image 3 
           

[%PRODUCT_IMAGE4-n%] Product image 4 
           

[%PRODUCT_IMAGE5-n%] Product image 5 
           

[%PRODUCT_MANUFACTURERn%] Product manufacturer, e.g. 
Nescafe 

           

[%PRODUCT_PRODUCT_TYPEn%] Product type, e.g. electrical 
           

[%PRODUCT_SEARCH_TERMSn%] Product search terms, e.g. 
Coffee, kitchen 

           

[%PRODUCT_SELLING_FORMATn%] Product selling format, e.g. 
GTC 

           

[%PRODUCT_SHIPPING_DESTINATIONn%] Product shipping destinations, 
e.g. UK (or 7) 

           

[%PRODUCT_TYPEn%] Product type. This is the type 
for system, e.g. for Amazon 
Toys & Games. 

           

[%PRODUCT_WEBPAGEn%] Product webpage for product. 
Used for websites that (also) 
sell item) 

           

[%PRODUCT_CUSTOM1-n%] Product custom value. This 
can be any value that you 
want to use. You can have up 
to 20 additional values for a 
product. 

           

[%PRODUCT_CUSTOM2-n%] Custom value 2 
           

[%PRODUCT_CUSTOM3-n%] Custom value 3 
           

[%PRODUCT_CUSTOM4-n%] Custom value 4 
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[%PRODUCT_CUSTOM5-n%] Custom value 5 
           

[%PRODUCT_CUSTOM6-n%] Custom value 6 
           

[%PRODUCT_CUSTOM7-n%] Custom value 7 
           

[%PRODUCT_CUSTOM8-n%] Custom value 8 
           

[%PRODUCT_CUSTOM9-n%] Custom value 9 
           

[%PRODUCT_CUSTOM10-n%] Custom value 10 
           

[%PRODUCT_CUSTOM11-n%] Custom value 11 
           

[%PRODUCT_CUSTOM12-n%] Custom value 12 
           

[%PRODUCT_CUSTOM13-n%] Custom value 13 
           

[%PRODUCT_CUSTOM14-n%] Custom value 14 
           

[%PRODUCT_CUSTOM15-n%] Custom value 15 
           

[%PRODUCT_CUSTOM16-n%] Custom value 16 
           

[%PRODUCT_CUSTOM17-n%] Custom value 17 
           

[%PRODUCT_CUSTOM18-n%] Custom value 18 
           

[%PRODUCT_CUSTOM19-n%] Custom value 19 
           

[%PRODUCT_CUSTOM20-n%] Custom value 20 
           

                          

Suppliers Macros. You can display suppliers details for each product on an order line by using the following macros. 

Where N is the supplier number. N can be from 1 to 3. Where n is the orderline to display. n can be from 1 to 100. 

[%SUPPLIER_NAMEN-n%] Supplier contact name 
           

[%SUPPLIER_COMPANYN-n%]  Supplier Company 
           

[%SUPPLIER_TEL_NUMN-n%] Supplier telephone number 
           

[%SUPPLIER_FAX_NUMN-n%] Supplier fax number 
           

[%SUPPLIER_EMAILN-n%]  Supplier email 
           

[%SUPPLIER_ADD_LINE1N-n%] Supplier address line 1 
           

[%SUPPLIER_ADD_LINE2N-n%] Supplier address line 2 
           

[%SUPPLIER_ADD_LINE3N-n%] Supplier address line 3 
           

[%SUPPLIER_ADD_LINE4N-n%] Supplier address line 4 
           

[%SUPPLIER_COUNTYN-n%] Supplier county 
           

[%SUPPLIER_POSTCODEN-n%]  Supplier postcode 
           

[%SUPPLIER_COUNTRYN-n%]  Supplier country 
           

[%SUPPLIER_IDN-n%] Supplier ID 
           

[%SUPPLIER_VATN-n%] Supplier VAT code 
           

[%SUPPLIER_CODEN-n%]  Supplier code (your own 
internal code) 

           

[%SUPPLIER_NOTESN-n%]  Supplier notes 
           

[%SUPPLIER_ADDN-n%] Complete supplier address. 
Blank lines are removed and 
the country is displayed using 
the country option in the 
Printing fields options. 

           

  

 
Custom entered fields can be used to add you own information to each order. These values can be entered on the Custom 
values tab on each order. 
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